MacElastic™

Instructional Finite Element Analysis
for Solving Elasticity Problems
With the Macintoshe

J. R. Cooke
D.C. Davis
E.T. Sobel

© Copyright 1989
Cooke Publications, Ltd. = Ithaca, NY
All Rights Reserved
PDF version, December 1996



Before you begin

Versions: The MacElastic (ME) student version, which is limited to 300 degrees of freedom,
includes an applications disk with one or more demo projects, as well as this manual. The
professional version has the same functional capabilities, but handles larger problems, up to the
limits of RAM. With 1 megabyte of RAM, ME can handle more than 1,000 degrees of freedom,
depending upon the complexity of the geometry involved and the size of your system file.

Updates: Return a copy of the Registration card from the Appendix to have your name placed on
our mailing list for notification of updates and related products.

Hardware: MacElastic should normally be used with a Macintosh Plus, SE or Macintosh Il and
with at least two disk drives. ME works best with generous memory and disk storage. A
Macintosh 512KE includes the 128K ROM and supports MacElastic, although it operates more
slowly. This configuration is satisfactory for instructional problems. If you have only an internal
800K drive and no external drive, you can store a demo problem of modest size on the program
disk if you first remove all non-essential files from your working copy.

The ME code is large; in fact, it is larger than the original MacWrite, MacPaint, and MacDraw
applications combined. This size necessitated an extended testing period. The program is
distributed on an 800K disk.

The MacElastic/68881 version utilizes the Mac I1’s 68881 math coprocessor for a dramatic speed
improvement. Note: Either version (with or without coprocessor support) will run on the Mac
I, but the 68881 version will run only if your computer is equipped with the 68881 coprocessor.
Output can be printed on either the ImageWriter or LaserWriter. (Use the non-coprocessor
version with PowerMacs unless you have the PowerFPU™ emulator installed (John Neil &
Associates, PO Box 2156, Cupertino, CA 95015, (800) 663-2943, info@jna.com).

System Software: MacElastic functions properly with System file 4.2, Finder 6.0, and MultiFinder
1.0 (and later versions) and supports adjustable window sizes for larger screens.

Protecting your investment: Before using your ME distribution disk, set the write-protect tab on
the diskette to the locked position. Then make a working copy and store the original in a safe
place. For your convenience we have NOT copy-protected the disk. You may make an archival
copy using the standard copying process, and you may transfer the program to your hard disk.
Unless explicitly covered by a written contract, ME is licensed as a single-user product. See the
license agreement. We have spent hundreds of hours in the development of ME, so we
appreciate your assistance in protecting our investment!

Only one copy of ME (either the coprocessor or non-coprocessor version of the application)
should be left on the working disk with a current System folder. Remove from the working copy
any files which you do not need, e.g., Laser Prep and LaserWriter drivers if you will not be using
a LaserWriter. Remove the demo projects after you complete this chapter. Typically, you use an
external drive to store your data files. The program disk must not be write-protected during use.



If you have problems: 1) Re-read the documentation. 2) Read the supplements to the
documentation supplied with ME. This is where we document extensions to the software or
manual and provide hints to clarify frequently asked questions. 3) Make a reasonable effort to
resolve the problem. 4) If you need additional assistance, please write or call. Be sure to provide
enough background (equipment, system software, ME version number and serial number as
displayed on the About menu, etc.) for us to respond. Provide sufficient detail for us to replicate
the problem situation. In the case of site licenses for classroom usage, all questions should be

routed through the person who obtained the site license. No support will be provided for stolen
copies!

Getting Started: Proceed only after making your backup and storing the distribution disk.
Although an experienced Macintosh user probably could use many of the program features
without studying this manual, reading this manual should make your learning experience more
enjoyable and productive. You might otherwise overlook some of the nifty features. In addition,
the subject addressed by ME is likely to be more complex than most Macintosh applications.
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Preface

The finite element method (FEM) is rapidly becoming one of the premier computational
techniques of science. Consequently, university curricula in engineering and mathematics
should broaden their offerings to make this powerful and unifying tool accessible to
undergraduates, not just to the traditional graduate student audience.

FEM instruction which relies upon textbook-only presentation is likely to allow computational
details to obscure both the intellectual content and the generality of the method. Because of its
procedural complexity the FEM becomes an attractive computational technique only if used with
a computer. Therefore, interactive, visually oriented, instructional software is needed to
supplement textbooks.

Two major obstacles to widespread use of the FEM in the undergraduate curriculum have been
addressed by MacElastic™. First, there has been little finite element software developed
specifically for the novice user. Commercial FEM code emphasizes generality, rather than ease of
use by the novice. Second, the equipment and support costs associated with high-end
instructional graphics labs have been an obstacle. The popularization of microcomputers with
graphics, however, means that this larger audience can be served more economically now.
“Instructional Software Makes The Finite Element Method Accessible” in the September 1988
issue of Academic Computing (pp 34, 35, 54, 56) offers additional commentary.

MacElastic has evolved over the life of the Macintosh computer. Designing, writing, and testing
more than five hundred pages of Pascal source code and this documentation have required
hundreds of hours. We hope this effort substantially reduces the effort and learning time
required of new users of this important technique.

Several people have helped make MacElastic possible. Professor L.J. Segerlind’s Applied Finite
Element Analysis provided inspiration. The constructive comments of Professor J. F. Booker
(Cornell), Professor S.K. Upadhyaya (UC Davis) and their students provided classroom reality
checks on this and the companion program MacPoisson™. We also thank Dr. Kenneth King for
his encouragement while he was serving as Vice Provost for Computing at Cornell University.

JRC, Ithaca
DCD, Pullman
ETS, Ithaca

March 1989
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Chapter 1
Finite Element Method Overview

Steps in the problem solving process

Finite Element Analysis is a numerical method for solving problems by breaking the physical
space into discrete “elements” for which the approximate solution is known. The composite of
these finite elements is used to form the global solution. Specifically, MacElastic (ME) solves
problems governed by the biharmonic equation in 2 dimensions (planar) and 3 dimensions
(problems having symmetry about an axis).

The method of solution can be broken into three main steps: First, you generate a mesh to
describe the geometry of the problem. This corresponds to the discretization of space mentioned
above. Next, you ascribe constraints to the problem. These constraints include the physical
properties, as well as loads (distributed and line), fixed displacement components, and surface
stresses (normal, tangential and in coordinate directions). Finally, ME solves the problem, which
involves automatically forming and solving a set of simultaneous linear algebraic equations
dictated by the first two steps. Output includes both tabular and graphical displays. ME provides
a visual framework for both input and output.

The steps require a tremendous amount of bookkeeping in order to track the position of the
mesh elements, the relationships between elements, the properties of different elements, and the
boundary conditions at nodes and elements. The power of MacElastic lies in its ability to free
you from these bookkeeping tasks, thus allowing you to concentrate on the problem being
modeled.

The six selections on MacElastic's main menu follow, along with a brief description of the
function of each selection. These steps are illustrated using elementary examples. This chapter
outlines both an axisymmetric and a planar problem. These examples are considered in detail in
Chapters 2 and 3, respectively. Both problems are formulated using two mesh generating
regions.

The treatment in Chapter 1 is intentionally brief in order to not obscure the “big picture”. We
suggest that you read this chapter first to develop an overview. Chapter 2 presents brief step-by-
step instructions as a guided tour. Chapter 3 is organized as a detailed reference for the
commands. These problems are included on the distribution disk.



A. Column on tapered footing subjected to axial loading
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Fig 1.1 Column problem Fig 1.2 Column schematic

Figure 1.1 depicts a circular column resting on a tapered footing. The dimensions, properties, and
boundary conditions are shown in Figure 1.2, which also shows how the axial symmetry is being
used. The column is represented as a rectangle rotated about the z-axis; the footing is represented
as a trapezoid rotated about the z-axis. We assume that the column and footing are different,
homogeneous materials. The displaced shape of the column and footing as well as stress and

strains are to be found.
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Fig 1.3 Displacement of the column and footing



Fig 1.3 displays the solution we seek. The displacement at all interior points is uniquely
determined; the solution must satisfy the biharmonic equation and the conditions we specify on
the boundaries.

The column becomes shorter due to the vertical downward loading; there is a smaller radial
displacement. (Refer to Chapter 2 for a step-by-step guide to the solution.)

Al. GEOMETRY - Overall body definition: The problem space is defined and subdivided for
later processing.

The geometry is defined using points, lines, and arcs (Fig 1.4). The problem, therefore, looks like
an unfinished "connect the dots" game prior to region definition. Several tools aid in the rapid
generation of points on lines and arcs.

250qe = = 2 50 T pm
£ z

ooofy g, @ 0.00 ===
0.00 B o050 000 o050

Fig 1.4 Points Fig 1.5 Regions

To utilize the automatic mesh generator, you must define regions (Fig 1.5) meeting specific
criteria. The fundamental region is the curvilinear quadrilateral, a shape defined by four vertices
with each of the four sides having one intermediate point to which a quadratic curve is fitted, for
a total of eight defining points. Complex problems have borders which cannot be described by
only one curvilinear quadrilateral. In this case, you break the total space into multiple regions.
The actual region generation is done by selecting the predefined points in counterclockwise
order, beginning with a vertex. Once eight points are selected, MacElastic draws and shades the
polygon region.



A2. MESH - Mesh generation: The automatic mesh generator takes each properly defined
region and breaks it into triangular subregions referred to as "elements".
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Fig 1.6 Nodes/side  Fig 1.7 Mesh
Each element vertex is known as a "node". The user specifies the number of nodes to be placed
on each side of a mesh generating region (Fig 1.6), with the constraint that opposite sides of a

region have the same number of nodes and that regions sharing a common boundary have the
same number of nodes on the common boundary.

For properly defined regions MacElastic enforces these constraints automatically, creates the
mesh (Fig 1.7) and also keeps track of the coordinates of each of the generated nodes. Facilities to
modify the mesh in other ways (i.e., slightly move a node, reorient a diagonal, and subdivide
elements) are available. When the mesh is satisfactory, the program goes through several
calculations to identify unique lines and the connectivity of line segments, as well as to
minimize the bandwidth of the global "stiffness" matrix. This step reduces both memory
requirements and computational time.



A3. PROPERTIES - Define properties and boundary conditions:
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Fig 1.8 Properties Fig 1.9 Constraints

As mentioned earlier, the solution of a MacElastic problem involves approximating the solution
over a large number of small, connected elements. The material properties of each element are,
therefore, crucial to the outcome of the problem. From the properties menu, choose the material
properties section to set the element material properties, by element, region, or whole body (Fig
1.8). Each element can contain a distributed source.

Next, prescribe the boundary conditions (Fig 1.9). You can set fixed nodal displacement
components, nodal forces, as well as stresses at boundaries. Responsibility for formulating a
meaningful, well-posed problem rests with you.

A4. SOLVE - Solution of the system of equations:

If you have completed the previous steps properly, ME forms and solves the equations which
describe the physical situation. ME uses the Gaussian elimination technique to solve the system
of equations thereby getting the resulting nodal displacements. Once ME finds the nodal
displacement components, you can direct the program to compute element and nodal stresses
and strains.



A 5. PLOT - Plot results:

Fig 1.10 Displacement plots Fig 1.11 Contour plots

Fig 1.12 Shaded plots



MacElastic produces displacement plots (Fig 1.10), contour plots of nodal values, and shaded plots
for element values (Fig 1.12). You can control the resolution to focus on a particular section of
the problem.

You can produce both diagnostic and presentation quality plots.

ME provides labeling of nodes, elements, contours, average values, and text. Zooming
capabilities allow you to refine the plots as needed.

A6. LIBRARY - Project creation and data examination:

ECJ== Nodal Displacements =——|
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9| 7595930662972 10e-5 -7 . 407322167 264240e-5
B | &§.7072240576691208—5 -1 .080451 1576749207
T 0.000000000000000e+0 0 000000000000000e+0
B | 4. 4733757245665 700-5 -9 QRSE3S0RE 22550005
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Fig 1.13 Tabular output

You can examine the tabular output from within ME (Fig 1.13), as well as with a word processor.
With the output data you can compute other interesting properties.

Use the Library to also examine the input and the intermediate calculation steps. The library also
enables you to generate input files without graphical support (in order to study the details of the
process) or to produce a specialized custom mesh.

The plate example which follows parallels the column example just described, but illustrates a
planar problem with a curved boundary. To the extent possible, the text repeats the previous
discussion. Alternatively, you can skip the plate example and proceed to the step-by-step tutorial
in Chapter 2.



B. Flat plate with hole and tensile loading
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Fig 1.14 Flat plate with hole

Figure 1.14 depicts a flat plate with a circular hole. By symmetry only one fourth need be
considered (Fig 1.15). Rollers which allow displacements in only one direction replace the lines
of symmetry. The hole and upper surface are traction free, while the right side has a surface load.
The dimensions, properties, and boundary conditions are shown in Figure 1.15. You are to find
the displacement and stresses.
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Fig 1.15 Schematic of plate
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Fig 1.16a Displacement

Fig 1.16b Constant stress lines

The displacement at all interior points is uniquely determined; the solution must satisfy the
biharmonic equation and the conditions you specify on the boundaries.



The plate elongates in the x direction, becomes shorter in the y direction; and the hole elongates
in the loading direction and shrinks in the other direction (Fig 1.16). See Chapter 3 for a step-
by-step description.

B1. GEOMETRY - Overall body definition: The problem space is defined and subdivided for
later processing.
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Fig 1.18 Regions



The geometry is input as points, lines, and arcs. The problem (Fig 1.17), therefore, looks like an
unfinished "connect the dots" game.

In order to utilize the automatic mesh generator, you must define regions (Fig 1.18) meeting
specific criteria. The fundamental region is the curvilinear quadrilateral, a shape defined by four
vertices with each of the four sides having one intermediate point to which a quadratic curve is
fitted, for a total of eight defining points. Complex problems have borders which cannot be
described by only one curvilinear quadrilateral. In this case, once you have entered all the points
defining the entire problem space, you break the total space into multiple regions. The actual
region generation is done by selecting the predefined points in counterclockwise order, beginning
with a vertex. Once eight points are selected, MacElastic draws and shades the polygon region.

B2. MESH - Mesh generation: The automatic mesh generator takes each properly defined
region and breaks it into triangular subregions referred to as "elements”.
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Fig 1.20 Mesh

Each element vertex is known as a "node". You specify the number of nodes to be used in each
mesh generating region (Fig 1.19), with the constraint that opposite sides of a region have the
same number of nodes and that regions sharing a common boundary have the same number of
nodes on the boundary.

For properly defined regions, MacElastic enforces these constraints automatically, creates the
mesh (Fig 1.20), and also keeps track of the coordinates of each of the generated nodes. Facilities
to modify the mesh in other ways (i.e., move a node slightly, reorient a diagonal, and subdivide
elements) are available. When the mesh is satisfactory, the program goes through several
calculations to identify unique lines and the connectivity of line segments, as well as to
minimize the bandwidth of the global "stiffness" matrix. This step reduces memory
requirements and reduces computational time.



B3. PROPERTIES - Assign properties and boundary conditions:
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Fig 1.22 Constraints

As mentioned earlier, the solution of a MacElastic problem involves approximating the solution
over a large number of small, connected elements. The material properties of each element are



therefore crucial to the outcome of the problem. From the properties menu, you choose the
material properties section to set the element material properties by element, region, or whole
body (Fig 1.21). Each element can include a distributed body force.

Next, you prescribe the boundary conditions (Fig 1.22). You can prescribe fixed nodal
displacement components, along with nodal line forces, as well as surface stress on boundaries
(normal and tangential or along coordinate directions). Responsibility for formulating a
meaningful, well-posed problem rests with you.

B4. SOLVE - Solution of a system of equations:

If you have completed the previous steps properly, ME forms and solves the equations which
describe the physical situation being modeled. This part of the program uses the Gaussian
elimination technique to solve the system of equations thereby getting the resulting nodal
displacement components. Once ME solves two displacement components at each node, you can
direct the program to compute element and nodal stresses and strains.

B5. PLOT - Plotting results:

Fig 1.23 Element stress plot

MacElastic produces displacement plots (Fig 1.16), contour plots of nodal values (Fig 1.16), and
shaded plots for element values (Fig 1.23). You can control the resolution to focus on a particular
section of the problem.



You can produce both diagnostic and presentation quality plots. ME provides labeling of nodes,
elements, contours, average values, in addition to text. Zooming capabilities allow you to refine
the plots as needed.

B6. LIBRARY - Create projects and examine data:

You can examine the tabular output from within ME (Fig 1.24), as well as with a word processor.
With the output data you can compute other interesting properties.

ECJ== Nodal Displacements =—|
Hode X Y
1]5.5266519975550192—1 (R utalaintutalayuintutuluinfulal=g dul
Z | 5.52409554541651 5a—1 0. 00000 000d0d00e+0
3| 5. 4rs322917024590e-1 -1 .1510531959555366.-2
4 |5 699643765121555e—-1 -9 . 41706 1404755455a-5
31 9.21675951445902 41 (R utalaintutalayuintutuluinfulal=g Jul
18 | 7 .616439414455640e-1 -4 4604594415 153565e-2
19 | 7.797464972264625e-1 -4 145461724109029a-2
20 ] 5 .6953754547555495e—-1 -2 .021255059054055a-2
21 ] 9.620811124759220e-1 -4 EOS306557099115=-5

Fig 1.24 Tabular output

Also, use the Library to examine the input and the intermediate calculation steps. The library
also enables you to generate input files without graphical support (in order to study the details of
the process) or to produce a specialized custom mesh.



Chapter 2
MacElastic™ User’s Guide

Macintosh Basics (This section on Macintosh Basics contains only background information and
can be skipped by the experienced user.)

In the manual we assume that you are already familiar with the Macintosh computer and
application programs such as MacWrite™, MacPaint™, and MacDraw™. As a result of our
following the Macintosh protocols, we hope that you can concentrate more comfortably upon the
content of the finite element method, rather than upon the vehicle used to present this powerful
technique.

The program provides an immediate visual indication that it is performing your command.
Computation-intensive commands are accompanied by banners or other visual indicators of the
progress of your analysis.

We have provided multiple paths through the analysis so that you may proceed in the most
comfortable and intuitive manner possible, given the fundamental constraints of the algorithms.
At any stage in the analysis we show in normal print on the screen all permissible steps in a
menu, while non-permissible options are dimmed and disabled. In addition, we present the
most probable next step as the default, indicated by a darkened border of the button.

The Macintosh supports an extensive and elegant use of graphics which, we think, makes it an
excellent instructional vehicle for the finite element method. The problem formulation phase, if
done without graphics support, requires the tedious and error-prone preparation of text files of
tabular data. Similarly, interpretation of the massive tabular results is difficult and less
comprehensible without graphics.

Let's briefly review some of the most important Macintosh topics which are used in the
discussion which follows. The basic assumption of the Macintosh interface is that language-
independent pictures are a more convenient means of communicating than words. The use of
pictures is facilitated by the mouse pointing device.

The central paradigm for the Macintosh is for you to select an object by pointing and clicking,
and then to issue an action command for the selected object. Remember this and your mastery
of this application will come more quickly.

Your Macintosh screen is regarded as an electronic representation of your desktop. You can
rearrange the items on the screen with the mouse which has three basic actions:

Clicking - Position the pointer (of whatever shape) to the desired location by moving the mouse
and then briefly pressing and releasing the mouse button without moving the mouse. Double-
click in quick succession to extend the action of the first click (e.g., to select and open a file).



Pressing - After positioning the pointer, hold down the mouse button without moving the
mouse.

Dragging - Position the pointer with the mouse and, while holding down the mouse button,
move the mouse to a new location and release the button.

The Cursor: The cursor shape changes depending on its function. An arrow is the most common
shape and is used to press the scroll bars, the size box, the title bar, etc. An I-beam pointer
indicates the placement of text entered from the keyboard. The cursor becomes a thin "plus” sign
when used to select an area to be enlarged in a zoom operation or to select a contiguous group of
objects to be acted upon. A wristwatch shows that a lengthy operation is in progress.

Selecting

You must select an object before you can perform an operation on it, but selection itself has no
effect on the object and can be undone. Simply place the cursor on an object and click to select.
Double clicking (clicking twice in succession without moving the mouse) extends the effect of a
single click. For example, double clicking on an icon not only selects that item but also instructs
the program to run or execute that item.

You can select a range of objects. Position the pointer at one corner of a rectangular area you wish
to select and then drag the pointer to the diagonally opposite corner and release the button. A
rectangle shows the outline of the range you selected. When you work with the finite element
method, you use this feature to erase multiple geometry definition points. You can change the
extent of a selection by holding down the shift key and clicking the mouse button. For example,
to apply the same boundary condition along a contiguous range of the boundary in MacElastic,
simply shift-click the beginning point, keep the shift key pressed, and then (moving in a
counterclockwise direction around the boundary) shift-click the ending point.

When you wish to select a rectangular portion of a plot in ME for enlargement, press the option
key to turn the cursor into a plus, then drag to select an area for enlargement. With the option
key still pressed, click inside the area to initiate the zoom.

You can select and edit text and numeric entries just as you do in MacWrite. Simply place the
pointer and click the mouse to fix the insertion point. The I-beam pointer automatically appears
enabling you to insert typed characters. To remove characters, select them by dragging or shift-
clicking and press the backspace key or begin typing to delete the selected material and to insert
new characters.

Windows

The electronic equivalents of rectangular pieces of paper on the desktop are called windows.
Several windows can be visible or partially visible on the desktop at one time.
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Fig 2.1 Windows

Windows have some or all of the features shown in Fig 2.1. You can enter commands only in
the active window, i.e., the window highlighted with ruled lines across the top. The active
window is the front window, and it has a centered title. Click in the window to make it become
the active window. If the window is too small to enable you to view the entire document and if
it has a size box at the bottom right corner, you can change its size by dragging the size box. If
necessary, re-position a window by dragging the window by the title bar. If you still cannot view
the entire document, use the vertical and/or horizontal scrolling bars. Click on a scroll arrow to
scroll a line or a character at a time. Press on an arrow to scroll continuously. Drag the scroll box
to move larger distances, or click in a scroll bar on either side of the scroll box to scroll a screen at
a time.

At the top left corner of most windows is a close box. Click in the close box to make the window
go away; alternatively, choose Close from the File pull-down menu bar at the very top of the
screen. (You either save or regenerate the information in the screen if you subsequently reopen
the window.)
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Fig 2.2 Alert window

You also encounter dialog and alert windows. An alert notifies you that an unusual situation
has occurred or that you need to make an important decision. For example, if you are leaving the
program, an alert window (Fig 2.2) reminds you to save any data files which you would
otherwise lose. You must click on a button; the program indicates the usual or preferred
response as a default by boldly outlining that button.

Modal Temperature Specifications

Flot type: [<] Superimpose mesh
Labels: [ ]Elements R
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® Selected
(<] Temperatures Al
1 Selected
T
L &~

Fig 2.3 Buttons

There are three types of buttons: check boxes, radio buttons, and push buttons (Fig 2.3). Check
boxes are square boxes followed by a description. Check boxes act as toggle switches which you
can click on or off. You can select any number of check boxes. On the other hand, the circular
radio buttons, so named because of their similarity to car radio station preset buttons, occur in
groups, and you can select only one. Selecting one radio button automatically deactivates the
previous selection. You can activate or deactivate any radio button or check box by clicking the
button or clicking within the message associated with the button. In addition to check boxes and
radio buttons, you have two other control types: small rectangular objects labeled with text for



which you simply click or press the button to perform the action, and an analog device called a
dial that is similar to the scroll bars mentioned above.

Dialog boxes allow you to complete a command or choose a set of options. For example, printing
requires you to make some additional choices to complete an unambiguous action. Similarly, a
"Save as ..." command requires you to select a file name and possibly a drive. Many commands
have an undo or cancel option. Re-click an icon tool to undo.

If the foregoing discussion was not a review, we recommend that you take a few moments to
review your Macintosh owner's manual and to practice using your word processor.

A Map of MacPoisson Usage

Main Menu

- Open a Project (or Create Project via Library)

—  Geometry Definition

L { Mesh Generation

—  Property and Constraint Assignment

L {  Solve

— Plot Results

{ Library

Fig 2.4 The structure of MacElastic

Fig 2.4 depicts the organization of the major parts or modules of ME. In the following two
examples you will explore each of the modules.

IHlustrative Examples

In this chapter we present in tutorial format the step-by-step details for the column example
presented in the overview in Chapter 1. Chapter 3 presents a complete description of all ME
commands, including those mentioned in this chapter, and provides complete procedural details
using the flat plate example.

Typographic Convention:
= A bullet (=) denotes a step to be executed.



MacElastic can solve classical elasticity problems governed by the biharmonic equation. Because
we intend this to be a first introduction to the FEM, we shall provide a quick tour of the
procedural details.

Column on tapered footing subjected to axial loading.
0.5 m

23m

Fig 2.5 Column Fig 2.6 Column in cross-section view

Figure 2.5 depicts a circular column resting on a tapered footing. The dimensions, properties, and
boundary conditions are shown in Figure 2.6. Fig 2.8 shows the axial symmetry is being used.
The column is represented as a rectangle rotated about the z-axis; the footing is represented as a
trapezoid rotated about the z-axis. We assume that the column and footing are different,
homogeneous materials. The displaced shape of the column and footing as well as stress and
strains are to be found. You could also specify point and body forces.

1. Start your computer and activate ME.

« Double click the ME icon.
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Fig 2.7 Program credits and copyright notice
= When the copyright notice appears, click to continue.

The Main Menu allows you direct control of ME.

Cooke Publications
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Fig 2.8 The main menu

Problem formulation can begin when the Main Menu appears. The phases of problem
formulation, solution, and output are represented in the Main Menu by the steps which you
execute sequentially. See Fig 2.4 also.

About MacElastic...
About Project...

M Help # 1.30

Demo Mode

Fig 2.9 @ Menu
= Select Demo Mode on the & menu (Fig 2.9) to suppress all file saving.

The presence of the check mark indicates that you are in Demo Mode. You can enter and leave
Demo Mode at any time and as often as you wish; simply select Demo Mode to toggle.



Important: In Demo Mode all file saving is suppressed; this allows you to explore various options
at each stage of the analysis without corrupting the data files. If you fail to select Demo Mode at
this point you may not be able to follow the instructions in the remainder of the exercise.
Conversely, if you are in Demo Mode, you cannot solve an original project.

2. Select a project.

= Click on the long Open Project button on the Main Menu (or on the File menu) (Fig 2.8).

= Change drives and folders, if necessary, to select the column project (Fig 2.10). All of the ME
files pertinent to a project must be kept in the same folder.

5 Column with fuutingm

[ Column with footing 2] Cooke Pub-2
[ Eject |

[ Drive |

[ Open |

= [ Cancel ]

Fig 2.10 Select a project
= Double click the project name (or select the project name and click Open).

The Open Project button on the Main Menu (Fig 2.8) changes to
Close Project.

= Double click the Geometry button (Fig 2.8) or anywhere within that label (or select Geometry
and click the Run button), and the next dialog box appears.
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Fig 2.11 Existing data alert
= Click Edit to use the existing demo file (Fig 2.11).

Your choice of “Edit” assures that the existing data becomes the default.

7]
Coordinate Axes Type ; \
@ Axisymmetric 1.1
» Planar
foannat [ [1].4 J

Fig 2.12 Select coordinate system
= Click OK to select the default coordinate system for the demo (Fig 2.12).
Planar uses Cartesian coordinates (x,y) and assumes no change in the z-direction. Axisymmetric

uses cylindrical coordinates (r,z) and assumes no change in geometry or constraints with respect
to angular position about the z axis of symmetry.
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Fig 2.13 Set axes endpoints

= Click OK to accept the demo values.

You can edit the fields just as you would in your word processor. Use the Tab key or the mouse
to move to the next field. Should you later wish to change these limits to achieve a zoom effect,
i.e., enlargement, without destroying the problem, you can recall this window from the Axes
pull-down menu (Fig 2.14). If you wish, change the values to enlarge different portions of the
screen but restore the original values.

You must assure a consistent set of units throughout the project!

Note: Since you are in Demo Mode, any changes you make will affect only this module,
i.e.,Geometry. You can explore without disturbing the tutorial.



3. Define mesh generating regions.

% File Axes

Column with footing = |

2307

Starting Point
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2: | 00000000
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Fig 2.14 Geometry palette and work area
Fig 2.14 shows the tool palette and completed regions.

The geometry creation occurs in two phases: Phase 1 entails creating an outline of the problem
(points representing endpoints and midpoints of line segments comprising the problem). Phase
2 involves selecting these points in an appropriate manner to create regions. See the section on
region creation in Chapter 3 of this manual for details. This process must anticipate the next
mesh requirements, perhaps the most subjective and difficult step in ME.

Scan the following brief description of the tools; Chapter 3 provides the details.

Point generation icon, when selected, allows you to place single points anywhere in the
problem space. In mouse mode, the mouse controls the point position, and clicking assigns a
point at the current mouse position. In keyboard mode, you type the coordinates of the point,
and then click the OK box.



Line generation icon, shown activated (inverse video), when selected, allows generation of
multiple collinear points. You can use the mouse to specify starting and ending points, with the
number of intermediate points preselected on the keypad in the lower left corner of the screen.
The keyboard mode allows numerical input of starting and ending coordinates followed by
keypad selection of the desired number of intermediate points. You can also connect existing
points (either mode) by moving the mouse to the starting point and clicking, then to the ending
point and clicking.

Arc generation icon, when selected, allows creation of circles (keyboard or mouse mode) or of
ellipses (mouse mode only). Any portion of a circle or ellipse is also possible. Keyboard mode
prompts you for numerical input of the center point, starting point, and degrees of rotation. It
also allows you to specify any or all of these by selecting existing points with the mouse. Mouse
input uses a diagram to select type (circle or ellipse), degrees of rotation, angular direction, center
point, and radius.

X

Delete point icon, when selected, enables you to delete existing points by simply moving the
cursor over the point and clicking. You can remove entire ranges of points by holding down the
mouse button while moving the mouse from one corner of the offending rectangular area to the
opposite corner, thus boxing all the points which should be deleted. A single click inside the
selected box then removes all interior points.

ﬁf‘?

Move point icon, when selected, allows you to move an existing point to a new location. When
you click on the point to be moved, MacElastic replies by displaying the point's coordinates and
causing the point to blink. This verifies your selection and offers two ways to move the point:
dragging the blinking point to a new location or typing new coordinate values into the existing
ones. Click on the screen to accept the change.

Region selection icon, when selected, places MacElastic in the region selection mode, where you
use the mouse to select existing points in counterclockwise order to create regions which enable
the automatic mesh generator to work properly. (See details in Mesh Generation section.)

Briefly: All regions are comprised of four sides, each defined by two endpoints and one
intermediate point, to which a quadratic curve is fitted. If the midpoint is collinear with the



endpoints, ME creates a straight line. The total number of points in a region is therefore eight.
To select a region, invoke the region generation icon and move the cursor to a vertex of your
proposed region. Click on the vertex, move the cursor to the closest counterclockwise point in
the region, and click again. Repeat this until all eight points have been selected. MacElastic now
shades the region, verifying your choice. Notice in Fig 2.14 that when you use multiple regions,
all three points on a common side must be shared by adjacent regions to assure a common
boundary!

o
A
Region deletion icon, when selected, enables you to remove incorrectly defined or otherwise

unsatisfactory regions. Simply select this icon, move the cursor over the region you wish to
remove, and click.

Let’s continue with the demo examples.
= Click the Region deletion icon, and then click within a region.

= Click the Region selection icon and redefine the region (Fig 2.15).

% File RAxes

Column with footing
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o
Define 2 points per region
Reqgions must be CCW Zf
Start at a vertex
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Fig 2.15 Region definition



Optional: To gain experience with the other tools, delete the region(s) and practice adding points,
deleting individual points and groups of points, and adding points on lines and arcs. See above
for instructions or turn to Chapter 3.

If you encounter difficulty recreating the regions, you can either abandon your results because
you are in demo mode or return to the Main Menu (File menu) and re-enter this module.

When you have completed exploring this module,
= select Mesh from the File menu to continue or

= select Quit from the File menu to terminate the session.

Note: To avoid corrupting your files, never simply turn the power off in the midst of a project.
Always exit via the Quit command of the File menu.

If you were not in Demo Mode, ME would ask you if you wanted to save the data. You could
specify either text or binary format. Using the binary format reduces file access time but does not
immediately allow you to review the file contents. (Refer to the discussion of this in the Library
module in Chapter 3.)

4. Create the mesh.

You can enter the mesh module from the Main Menu (Fig 2.8) or as a continuation from the
geometry module above.



Mesh
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Fig 2.16 Mesh module entry

The mesh module has two phases. The automatic mesh generator 1) takes each properly defined
region and breaks it into triangular areas referred to as "elements” [Generate Mesh] and 2)
automatically renumbers the element vertices, referred to as nodes, to improve computational
efficiency [Other Calculations]. Check marks indicate that these calculations have been completed
in the demo examples. If a project had not already been selected, you would be required to do
that at this point. Mesh (Fig 2.16) allows you to branch to other parts of ME.

4.1 Generate a mesh.

= Click Generate Mesh (Fig 2.16).
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Fig 2.17 Nodes per side (Cylinder)

Your first task is to specify the mesh refinement appropriate to this problem. In general, a mesh
with a larger number of smaller elements produces better numerical results than a mesh with
fewer, but larger, elements. On the other hand, a larger number of elements leads to a larger
number of unknowns and, therefore, to a larger number of equations. This, in turn, requires
more computer memory and requires increased computational time. The verification studies in
Chapter 3 provide some guidance on this important, subjective process. In more complicated
problems you reduce the element size in the vicinity of greatest anticipated change in the
dependent variable, i.e., nodal displacement. Conversely, you can make the elements larger
where the expected change is smaller.

To specify the number of nodes along a side of the mesh generating region,
= Click within the small rectangle on a region side (Fig 2.17).

The opposite side is located automatically. When multiple mesh generating regions are being
used, ME identifies all sides which must share this value.

= Click on the table at the top-left corner of the nodes per side window (Fig 2.17) to assign the
value.



The column example has 4 by 9 and 5 by 4 node regions. The number of equations required for
these meshes is 104, as indicated by the degrees of freedom (DOF) displayed.

By the way: The student version is limited to 300 DOF. In the Poisson program, MacPoisson, each
node has one unknown, the potential, rather than two displacement components at each node as
in this MacElastic program.

Elements are joined only at their nodes. Therefore, when you specify the number of nodes you
want to use on a side of a mesh generating region (Fig 2.17), ME enforces the constraint that
opposite sides of a region have the same number of nodes and that regions sharing a common
boundary have the same number of nodes on the boundary. ME calculates the nodal coordinates
and element connectivity.

= Click Generate (Fig 2.17) to produce the mesh (Fig 2.18).
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Fig 2.18 Mesh
Tools to modify the mesh in various ways (i.e., move a node slightly, reorient a diagonal,
subdivide elements) are available.

Optional: Explore the aids listed on the Goodies menu; otherwise, skip to section 4.2, Other
Calculations.



Goodies

Label elements
Label nodes
Modify mesh

= Select Label elements or Label nodes from the menu to identify the node and element
numbers.

= Reselect the command to remove the numbering.
If the numbers are too close to read, enlarge that portion or zone of the mesh.
= Press the option key and the cursor changes to a plus sign.

= Identify (Fig 2.19) the area to be enlarged by dragging a rectangle with the mouse.

ETE

Fig 2.19 Select zoom area
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Fig 2.20 Enlarged view

= Option-click (i.e., press and hold option key and click) in the rectangle to redraw the area as
large as the screen size permits (Fig 2.20).

= Click the close box on the zone window or select a different window using the Windows menu.
= Select Modify Mesh from the Goodies menu.
To redefine elements (the default mode),

= Select two adjacent elements and click Redefine (Fig 2.21) to switch the diagonal.
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Fig 2.21 Redefine elements
To move a node to a new location (Fig 2.22),

= Select Move nodes and enter the new position by keyboard or by mouse.

To use the mouse click (or press for repetition) in the corners of the diamond; click on Home to
restore the initial position.

Note: Don’t click OK until you are ready to leave Modify.
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Fig 2.22 Move nodes
To add a node by subdividing two adjacent elements (Fig 2.23),

= Select Add nodes,
= Select the endpoints of the common side, and

= Click Add.
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Fig 2.23 Add nodes

Note: None of the above modifications will be retained beyond the Mesh module because you are
in Demo Mode.

= Click OK to leave Modify mesh of the Goodies menu.
= Select End Generation from the Generate menu.
The Mesh module screen (Fig 2.16) reappears.
4.2 Other Calculations.
= Select Other Calculations (Fig 2.16).

A bandwidth reduction (Fig 2.24) option allows you to use the Collins algorithm to renumber the
nodes to reduce the bandwidth or to use the existing node numbering. Bandwidth reduction is



especially useful with multiple regions and mesh refinement situations. See Chapter 3 for a
discussion of this topic.

Other numbering and graphics calculations...

A. Optional bandwidth reduction 7 20
@ graphically (slower)

Reduce bandwidth
2 (> without graphics (faster)

B. Calculation of unique plot lines and boundary nodes

[ cancel | ( continue |

Fig 2.24 Bandwidth reduction option
= Select Continue.

After the calculation is completed,

= Click the OK button which appears at the bottom left corner of the screen.
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Fig 2.25 Bandwidth reduction
ME automatically goes through several calculations to remove duplicate plot lines (e.g., a side

common to two adjacent elements), to find boundary nodes and elements, and to determine the
connectivity of elements.

When the results have been reported, you have completed exploring this module,

= Select Properties from the File menu or click the >>Properties button (Fig 2.16) to continue, or

= Select Quit from the File menu to terminate the session.

Note: Never simply turn the power off in the midst of a project.
Always exit via the Quit command of the File menu.

If you were not in Demo Mode, ME would ask you if you wanted to save the data files. You could
specify either text or binary format. See the Library module in the Reference Chapter and the
Appendix for a description of these files.

5. Assign constraints.

You can enter the properties module from the Main Menu (Fig 2.8) or as a continuation from the
previous mesh module.
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Fig 2.26 Properties module entry

This module handles two major tasks: 1) entering and editing element properties [Enter (or Edit)
Properties], and 2) entering and editing conditions at boundary and interior nodes [Enter (or Edit)

Boundary Conditions]. Distributed body force conditions use the same input structure as do
property definitions.

“Enter” indicates the creation of a new file and “Edit” indicates revision of existing files, as in this
demo. If you had not already selected a project, you would be required to do that at this point.
Buttons (Fig 2.26) allow you to branch to other parts of ME.

5.1 Properties.
= Click Edit Properties (Fig 2.26).

= Click Edit (Fig 2.11) to retrieve the existing data files in the demo.
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Fig 2.27 Properties palette: cylinder

The properties palette (Fig 2.27) contains 14 shading patterns with which numerical values can be
associated. Shades indicate the property assignment.

= Click to the right of a pattern to establish a cursor.

= Enter a value.

= Click on the pattern square.

= Click in the body to assign that value.

Optional:

= Select uniformity by Element from the Uniformity menu.

= Assign values to the shades (click to the right of the pattern square and type the value) and then

assign the shades to the elements by clicking on the pattern and then clicking or dragging on the
object (Fig 2.27).



The properties are Elastic Modulus (Young’s Modulus), Poisson’s Ratio, Thickness, Temperature,
and Thermal Expansion Coefficient. The thickness is relevant only for planar problems. Body
forces are entered here because the input format is common. Components for the orthogonal
directions can be entered separately. This menu also contains the exit option.
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End Property Definition

Fig 2.28 Properties menu

= Select End Property Definition from the Properties menu (Fig 2.28) to return to the Properties
module menu (Fig 2.26).

5.2 Boundary Conditions.
= Select Edit Boundary Conditions (Fig 2.26).
= Select Edit (Fig 2.11) to use the demo default data.

The boundary condition tools are on the palette (Fig 2.29).
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Fig 2.29 Boundary conditions (cylinder)
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Nodal displacement

Surface stress
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When you select a force or a displacement condition, specify the component direction too.
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y or z direction component




If you select a surface stress condition, two additional options (normal and tangential) are
available.

@* normal component

o

tangential component

To review the assigned values,

= Drag the cursor over the boundary condition icons on the plot to review the assigned nodal
values.

When you have selected the line force or displacement, ME echoes the nodal conditions when
the cursor is placed on a node; if you have selected the surface stress, ME echoes the surface
conditions of the element face when the cursor passes over the midface marker.

Optional:

To assign boundary conditions individually, select the boundary condition type, assign

numerical value, and then click to assign the condition to the plot.

To assign conditions to a range of consecutive points along a boundary, keep the shift key pressed
and click on the first and last point in counterclockwise order. A range indicator Eappears at
the top left of the window.

When you have completed exploring this module,

= Select End Boundary Condition from the boundary condition (B.C.) menu (Fig 2.29) to return to
the Properties menu (Fig 2.26).

or

= Select Quit from the File menu to terminate the session.

If you were not in Demo mode, ME would ask you if you wanted to save the data. You could
specify either text or binary format. See the Library module in the Reference chapter and the
Appendix for a description of these files.

= Click Solve on the Properties menu (Fig 2.26) to advance to the next module.

6. Form and solve the equations.

You can enter the solve module from the Main Menu (Fig 2.8) or as a continuation from the
properties module (Fig 2.26).
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Fig 2.30 Solve module menu
Each of the three solve options is examined in sequence.

= Select Solve Node Displacements.
ME asks you whether you wish to store intermediate calculations. Usually these are not needed,

require additional storage on the disk, and slow the process. For instructional purposes you
should examine these files in order to examine the computational processes. However, for now,

ﬁ Save intermediate vectors and
matrices?

(slower) (faster)

Fig 2.31 Save intermediate calculations?
= Click No (Fig 2.31).



ME formulates the system of equations, i.e., forms the equations and applies the boundary
conditions in the order listed.

Solving for Node Displacements

Steps:
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Fig 2.32 Solve for nodal displacements
= Click OK (Fig 2.32) when ME has completed the calculations.

= Select Solve Stresses and Strains (Fig 2.30).
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Fig 2.33 Calculate stresses and strains

= Click OK (Fig 2.33) when ME has completed the calculations.

= Select Other Calculations (Fig 2.30).
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v Calculate New Mode Coordinates
Calecmlania Hooe Heactinns

element 37 of 2

# of elements |72 Estimated time
1 min.
# of nodes 52
D.0.F. 104 Elagpsed time
- 21 =ecs.
Bandwidth 9
| Abort ]

Fig 2.34 Other Calculations
= Click OK (Fig 2.34) when ME has completed the calculations.

Note: The New Node Coordinates and Node Reactions may not be required in all problems and
can be omitted.

When you are ready to plot the results,
= Select Plot (Fig 2.30).
or

= Select Quit from the File menu to terminate the session.

If you were not in Demo Mode, ME would save the data files in binary form. See the Library
module in the Reference Chapter and the Appendix for a description of these files.

7. Plot Data.

You can enter the plot module from the main menu (Fig 2.8) or as a continuation from the solve
module above (Fig 2.30).

The Plot menu bar contains several options.



% File PlotSize Plot Edit Goodies Font FontSize Style

Open Project... m

Close Project Generated Mesh
Save Picture... Boundary Conditions
Print Draft Node Displacements
Print Final Element Strains

Element Stresses

rv_lain Menu Node Stresses
Llh_rarg wSCreen size
Quit 8410 page size | |«No Plot

Fig 2.35 Plot Menus

The File menu (Fig 2.35) contains the expected Open Project..., Close Project, Main Menu, Library
and Quit commands. The Save Picture... command allows you to save as MacPaint files the
larger plots (described below). You can save the smaller screen size figures as MacPaint files using
the customary command-shift-3 instruction. Use the Save Picture... command on the file menu
to save the larger pictures. You can print the larger plots from within ME in draft and high
guality modes on the ImageWriter. Use Print Final with the LaserWriter.

Plot provides two classes of output: diagnostic and presentation quality (i.e., screen size and 8x10
page size).

For each of the two sizes there are six available plots (Fig 2.35). A sample plot from the column
example illustrates these plots.



7.1 Screen size plots.

% File PlotSize Plot £:t Goodies Foni Foniiize Style

Column with footing Generated Mesh

Fig 2.36 Generated mesh
The first (Fig 2.36) simply displays the mesh you have seen earlier.



% File PlotSize Plot i Goodies Fond Fosiize Style

Column with footing Boundary Condition
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Fig 2.37 Boundary conditions

The second (Fig 2.37) displays the boundary conditions.
Press on a boundary condition constraint icon to instruct ME to display the value.

Marmmal Coutw ard)
E Surface Stress
-Z.000e+1
|'E:l
o

8



% File PlotSize Plot i Goodies Fond Fosiize Style

Column with footing Node Displacements

Fig 2.38 Displacement

Displacement plots (Fig 2.38) reveal the initial and deformed shapes.

Press on a node of the undeformed mesh to examine the displacement components. With the
(3o | 18607
k-5 29505

Digits command on the Style menu you can set the format of the display.




% File PlotSize Plot i Goodies Fond Fosiize Style

Column with footing Element Strains: Z-component

Fig 2.39 Average element strains
The average strain for each element is depicted by the shading pattern (Fig 2.39).

Press on an element for ME to look up the element number and the average strain of the
element. You can set the display format using Digits on the Style menu.

Z*Ean: -Z.001e+1
The element stress (Fig 2.40) is also displayed with shading.

Press on an element for ME to lookup the value. You can set the display format using Digits on
the Style menu.



% File PlotSize Plot i Goodies Fond Fosiize Style

Column with footing Element S$tresses: Z-component

EZ2%: -2 823e-7

Fig 2.40 Element Stress



% File PlotSize Plot i Goodies Fond Fosiize Style

Column with footing Node Stresses: Z-component

Fig 2.41 Nodal Stress

The nodal stresses (Fig 2.41) are displayed as a contour plot of constant stress lines.

Press on a contour line for ME to lookup the element number and the stress value. You can set

-1.802e+1

the display format using Digits on the Style menu.
7.2 Larger plots.
A description of the techniques to produce the larger plots is not necessary for this quick start

tutorial; we present detailed instructions in Chapter 3. For completeness, we show screen dumps
for the column example (Figs 2.42 - 2.48).



% File PlotSize Plot Edit Goodies Font FontSize Style

Column with footing Generated Mesh

ADD node number

37271989

Fig 2.42 Mesh with selected node numbers



% File PlotSize Plot Edit Goodies Font FontSize Style

Column with footing Boundary Conditions: Input
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Marral Coutw ard)
Surface Stress
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Fig 2.43 Boundary conditions with selected labels
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% File PlotSize Plot Edit

Goodies

Column with footing Boundary Condition

Font FontSize 5Style

MOWE bc Tabel
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Fig 2.44 Boundary conditions with selected labels



% File PlotSize Plot Edit Goodies Font FontSize Style

Column with footing Node Displacements

1.260e-7

| ~3.5396e-5
1

@0
MOWE
displacements

Fig 2.45 Nodal displacements



% File PlotSize Plot Edit Goodies Font FontSize Style

Column with footing Element 5trains: Z-component

A0D element
strain walue

lhse — 37271929

Fig 2.46 Average element strains



% File PlotSize Plot Edit Goodies Font FontSize Style

Column with footing Element 5tresses: Z-component

A0D element
stress value

Fig 2.47 Average element stresses



% File PlotSize Plot Edit Goodies Font FontSize Style

Column with footing Node Stresses: MaH. Prin. Stress

i /]

0.000e+0

{

4

ADD contour Tine

value
Z.000e+0

F2/1989

Fig 2.48 Nodal maximum principal stress contours

When you have explored the various plots,

= Select Library from the File menu (Fig 2.35).

8. Tabular results.

You can reach this module from the Main Menu (Fig 2.8) as well as from the Plot module.

% File



New Project...
Open Project...

ﬂ File Close Project
About MacElastic... Duplicate Project...
About Project... Print Draft

Print Final
ﬂﬂﬂﬁ;h Help # 6.10
Demo Mode Main Menu
Nuit

Fig 2.49 Library menus

The File menu (Fig 2.49) contains the expected Open Project..., Close Project, Main menu, and
Quit commands.

Use New Project... to initialize a new project, as described in Chapter 3.

Duplicate Project... allows you to extract the input files of the Open Project to become the
beginning point for a variation on the existing project.

Both the ImageWriter and LaserWriter are supported.

In this tutorial we simply display typical numerical results of the demo projects. For detailed
instructions refer to Chapter 3 and to the Appendix for the file format.

The project status, which is visible when you enter this module (Fig 2. 50), lists the files.
To examine the contents of a file,
= Double-click on the file name (Fig 2.50).

Note: The files you saved as standard text files (i.e., those with a “T” in the “Exists” column) can
also be examined using a word processor.
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Fig 2.50 Project status

Use the scroll bars to review the contents (Fig 2.51).
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Modal Displacements

Hode R £
1]15.854740476 215320025 0, 0000000000000002+0
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Fig 2.51 Nodal displacement file

= Click the close box to return to the list of files (Fig 2.51).

Either,

= Examine other files,
or

= Select Quit from the File menu (Fig 2.49).

Congratulations! You are now ready to begin using MacElastic. Chapter 3 is a detailed Reference
Guide to the operational aspects of ME. Chapter 4 is a guide to the computational details.
Chapter 5 is a collection of solved problems.



Chapter 3
MacElastic Command Reference

[ About MacElastic..., About Project..., Help, Demo Mode
Module
Submodule
Pull-down menus:
Main File: Open Project..., Close Project, Quit

Geometry  File: Open Project..., Close Project, Main Menu, Mesh, Quit
Axes: Limits..., Type...

Mesh File: Open Project..., Close Project, Main Menu,Properties, Quit
Generate Mesh
Generate: Generate Mesh, End Generation
Windows: Hide all windows, Nodes per side, Generated Mesh
Goodies: Label elements, Label nodes, Modify mesh
Other Calculations

Properties  File: Open Project..., Close Project, Main Menu, Solve, Quit

Enter/Edit Properties

Properties: Elastic Modulus, Poisson’s Ratio, Thickness, Temperature, Thermal
Expansion Coeff., x,r,y,z Direction Body Force, End Property Definition

Uniformity: by Element, by Input Region, by Entire Body
Windows: Whole Plot, Zone

Enter/Edit Boundary Conditions
B.C.: Nodal Boundary Conditions, End Boundary Condition Definition
Windows: Whole Plot, Zone

Solve File: Open Project..., Close Project, Main Menu, Solve, Quit
Solve Node Displacements
Solve Strains & Stresses
Other Calculations

Plot File: Open Project..., Close Project, Save Picture, Print Draft, Print Final,

Main Menu, Library, Quit

PlotSize: Screen size, 8x10 page size

Plot: Generated Mesh, Boundary Conditions, Node Displacements, Element
Strains, Element Stressses, Node Stresses, No Plot

Edit: Cut, Copy, Paste, Clear, Node Labels, Element Labels, BC
Labels, Displacement Labels, Element Strain Labels, Element Stress Labels,
Node Stress Labels, Text Labels, Select All, Refresh, Optimize

Goodies: Change Plot Specs, Zoom, Change Value Increments, Label
Nodes, Label Elements

Fonts: (user specific, including Chicago, Geneva, and Monaco)



FontSize: 9, 10, 12, 14, 18, 24, 36, 72
Style: Plain, Bold, Italic, Underline, Outline, Shadow, Erase Background,
Align Left, Middle, Right, Digits...

Library File: New Project..., Open Project..., Close Project, Duplicate Project...,
Print Draft, Print Final, Main Menu, Quit
Open File: New Project..., Open Project..., Close Project, Duplicate Project...,
Print Draft, Print Final, Main Menu, Quit
Edit: Cut, Copy, Paste, Clear, File Attributes
Numbering: All numbers, Group numbers, Renumber
Set Attribs

Program Organization

The main menu provides branching to all major modules of ME. The menu list, with the
exception of the library which is used both first and last, indicates the typical progression during
problem solving. The probable next module appears as the default when you create the data files
of the previous module. Each module provides a linkage to the next and to the immediately
previous module. If necessary, you can return to the main menu to branch to other modules.

= Geometry and Mesh provide graphical tools for the automatic generation of the mesh and for
you to make detailed refinements in the mesh. Automatic bandwidth reduction, a technique to
reduce storage requirements and computation time, is also available here.

= Properties provides the environment for you to enter the material properties and the
constraints. You are responsible for defining a well-posed problem which has a unique solution.

= In Solve you compute the desired output. This module forms and solves the required system
of equations.

= In the Plot module you produce both diagnostic and publication quality graphical output.

= In the Library module you have access to the numerical results. This module also allows you
to create new projects and to duplicate existing projects. You can also use this module to
formulate problems without utilizing ME’s graphical support. You might choose to do this in
order to gain a deeper understanding of the internal numerical steps or to have greater control
over problem formulation.

MacElastic commands are described in detail in this chapter in the normal sequence used during
problem solving. This sequence also corresponds to the left-to-right ordering of the menus on
the menu bar.

In this chapter a third, more complicated example is woven into the discussion. The illustrative
figures correspond to the classical flat plate with a circular hole which is subjected to tensile
loading. However, our primary goal is to present a definitive description of each command.



Each command description is free-standing and does not depend intrinsically upon this
particular example.

Example: A flat plate with a circular hole subject to tensile
loading

je————1000 mm ——

E = 5595DK1D5PG
Wo=0.3
120 mm R
E
E
o
o
=
thickness = 1 mm |

Fig. 3.1 A flat plate with hole

In this chapter we will use the classical flat plate problem (Fig 3.1) to illustrate the features of
MacElastic. A thin flat plate 1 mm thick and 1000 mm on a side has a circular hole of radius 150
mm at the center. We shall use ME to find the displaced shape and to compute the stresses and
strains. The schematic (Fig 3.2) contains the details you need to analyze this problem. The
meaning of the notes on the diagram become apparent as you complete the following exercise.

The problem is planar—one of the two general classes of problems which you can solve with
MacElastic. Using symmetry arguments only one fourth of the plate need be analyzed. By
subdividing the five sided object two mesh generating regions can be used to automatically
generate a mesh. One boundary of each of these regions has a curved side which will be
approximated using straight sided triangles.

21
C0, 5000 00, 50005 2 —
.3 = —

(=] _} 5
midside [9] ks ho x disp. :3 — 100 107Fa
point .35 S11el generating z Y 5L+jr*f-:u:e

<0, 150 33 Rt Fagion 12 -3 stress
c] :}:F
€130,0x [91] ta0a, 02 2o o0 2o oo
\\ oy disp.
coordinates nodes per side

Fig 3.2 Schematic of the flat plate problem.



Fig 3.3 Plot output
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Fig 3.4 Tabular output



You wish to compute the displacements, stresses and strains. You also require plot and tabular
output (Figs 3.3 & 3.4).

3.1 Main Menu.

MMain Menu gl
) MacElastic™ - FINITE ELEMENT AMNALYSI1S - Elasticity
[ Open Project... ]

i)
@ {_) GEOMETRY - Define overall body

3 MESH - Generate mesh

{_) PROPERTIES - Add properties and boundary conditions

[-::';'1 ”F] {3 SOLUE - Solve system of equations

‘ 3 PLOT - Plot results

[ RUN ]
uﬂﬂﬁ (@ LIBRARY - Create and modify projects

Fig 3.5 Main Menu
% File

“ File
About MacElastic...
About Project...

§ o b Help # 0.00

+

+Odemo Mode

Fig 3.6 & menu from the main menu

The & Menu (Fig 3.6), a standard feature of Macintosh applications, is the first menu.



MacEfastic™ ) o s

Solutions of two-dimensional easticity probl

Professional version
1026 DLOF. allowed
S ME1 Q1 2089004

Concept: JR Cooke, DC Davis, ET Sobel
Programming: Ted Sobel

-4 —=-
40Fk
4 —

Far orders
and inquiries

| 411 Rights Reserved|

@ 1956 Cooke Publications, PO Box 4445 [thaca, MY 143852

In WY state: 1-800-435-4435 ext 15
Outzide NY: 1-500-482- 4435 ext 15

Single-User License — 3/2,/1929

Fig 3.7 About MacElastic...

Cooke Publications

About MacElastic... (Fig 3.7) describes the application. Included are the following: Title, credits,
version number, available RAM, serial number, copyright notice, licensing, and ordering

information.

Note: This program and documentation are not copy protected, but are protected by federal
copyright laws and the license agreement; illegal transfer of this licensed intellectual property

will be regarded an act of theft.



Project: Plate with hole (planar)
Description

[Tensile loading of thin flat plate with a
hole.

Available memory: 713730 bytes

Fig 3.8 About Project...

The About Project... (Fig 3.8) displays the project description, the problem type, and available
memory any time a project is active, i.e., open.

Keep a brief description of the problem here. Use this as a scratch pad for reminders; make
changes at any time.

Use this command to monitor memory utilization when you attempt to solve large problems,
especially when you successively refine the mesh to verify the solution. Memory utilization
varies dynamically throughout the process. Unneeded data structures are purged and new data
structures are created as needed.

4 o B Help # 0.00

+H

Fig 3.9 Help reference

The Help # (Fig 3.9) varies throughout ME to serve as an online guide or index to the appropriate
help paragraph in Appendix Al. The help message in the Appendix may also cross-reference
other portions of this manual.

Check Demo Mode (Fig 3.6) to suppress all file saving. You can enter and leave Demo Mode at
any time and as often as you wish; simply reselect Demo Mode to toggle. The presence of the
check mark indicates that you are in demo mode.

Use Demo Mode to explore tangential issues without fear of corrupting the data files which are
used in subsequent modules. The file attribute system, described in the Library module,
prevents the accidental use of incompatible data files. For example, if you alter the dimensions
or properties files of a previously solved problem, all data files obtained using the previous



values are no longer compatible with the new data. ME automatically disables such files and
will not load the files. Your classroom presentations can be conducted in Demo Mode without
fearing that your lecture materials will vanish before your eyes!

NOTE: If you unintentionally remain in Demo Mode while solving an original problem, you
will NOT be asked to save any data; therefore, you cannot continue with the next module which
requires the non-existent file.

Go to the Library module (Fig 3.95) to examine the status of the 18 files. A black bullet in the
status column denotes active files; a blank denotes an inactive file. An experienced user can use
the Set Attribs option in the Library module to change the attribute flags to recover files in some
instances or to manually construct files.

The remaining entries in the @ menu are desk accessories. Refer to your Macintosh Utilities
User’s Guide for a description of the Font/DA Mover.

Open Project...
Close Project

Ouit

Fig 3.10 File Menu (Main)

Open Project... is enabled (not dimmed) only when no project is active. Use the usual Macintosh
procedures to select your data disk drive and to navigate through the folders to locate your
project folder (Fig 3.11). Select and open the folder. Then select and open the project file. Only
one project can be open at any time.

(2] MacElastic Prof

3 Plate § <+ 2] MacElastic P...

[ Eject |
[ Drive |
[ Open |
= [ Cancel ]

Fig 3.11a Select a project folder and Master file



] Plate §

[0 Plate with hole Master 2] MacElastic P.
[ Eject |

[ Drive |

[ Open |

= [ Cancel ]

Fig 3.11b Select a project folder and Master file
. g
3
4.

Note 1: When you create (define) a new project using the Library module, ME produces a project
folder and places a master file in the folder. The master file (the workbook icon) contains the
data required to initialize and use the project’s 18 data files.

Close Projectis enabled (not dimmed) only when a project is active. Use Close Project if you wish
to open another project. The Quit command automatically closes the open project.

Quit terminates your ME session and, if necessary, closes an open project.
cx._ﬂ\
3.2 Geometry Module. @:’

If you have not previously opened a project, do so now. As you enter this module,
you must answer several preliminary questions.

Do you wish to create a “NEW?” data file, completely ignoring all previous values? Or do you
wish to be presented the previous data so you can “EDIT” (adapt or accept) the old values?



|E Prervious data edists.

You may start with NEW data or EDIT the old data

ST

Fig 3.12 Use previous data?

The default coordinate axes type corresponds to the existing problem if you elected to modify
existing data. Make that determination now, but you can change the type from the Mesh
module.

]
Coordinate Axes Type ; \

{(_» ARisymmetric 1.1

i@ Planar

Lannat [ 0K }

Fig 3.13 Select coordinate axes type
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Fig 3.14 Assign axis endpoints

Word processor editing conventions apply here. Use the tab key or mouse to change fields. Press
return or click OK to accept the data.

The Geometry tool palette and work area now appear along with a new set of pull-down menus.

% File Axes

About MacElastic...
About Project...

]
@ Help # 1.30

Oemo Mode

Fig 3.15 & Menu (Geometry)

These commands are described in the Main menu section above.



OpenProject...
Close Project

Main Menu
Mesh
Quit

Fig 3.16 File Menu (Geometry)

Open Project..., Close Project, and Quit commands are described in the previous section on the
Main Menu. The remaining commands control branching. Each module, including this one,
allows branching to the Main Menu, which then allows you to branch to any other module.
Branching to the next logical module in the formulation sequence, Mesh, is also provided.

Limits...
Type...

Fig 3.17 Axes menu (Geometry)

Limits... and Type... allow you to revise your choice of axis endpoints and coordinate type. You
can change these limits at any time without destroying points outside the displayed range to
provide the equivalent of zooming.
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Fig 3.18 Geometry Palette
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Fig 3.19 Examples of regions

In this module you define points (Fig 3.18) on the coordinate system which you subsequently
connect to form the curvilinear quadrilaterals used in the automatic mesh generation algorithm
of the next module. Curvilinear quadrilateral “mesh generating regions” (Fig 3.19) include
squares and rectangles with straight sides, as well as a generalization of these with second degree
polynomial sides. You can form a triangular region as a degenerate case of a rectangle with two
consecutive sides forming a single straight line.

The placement of these points has special significance. Vertex points of the mesh generating
regions correspond to nodal points. However, the intermediate points along the side of a
generating quadrilateral do not, in general, correspond to nodal points, but the placement of



these intermediate points does determine the spacing of the nodal points. A point centered on
the side produces equally spaced nodes. On the other hand, a point placed nearer one end
produces nodes spaced more closely at that end of the region. You must place the intermediate
point between the first and third quartile point of the side for the algorithm to work.

Tools to generate regions

Let’s review the uses of the tools on the palette (Fig 3.18).

Point tool

Use the point tool to create individual points. Select either the mouse or the keyboard icon to
prescribe the input style.

Mew Point

1 o
c:

With keyboard input (the default), enter the exact coordinates and click OK.

If you choose mouse input, the cursor becomes a small square when placed within the range of
coordinate values, and the coordinates of the cursor are displayed at the bottom. Position the
cursor and click. You can press the option key to truncate the decimal portion of the coordinates.



Deletion tool (selected)
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Fig 3.20 Use of tools

Just beneath the point tool is the point deletion tool, which can be used with the mouse (the
default) or the keyboard. With the mouse, position the cursor (a circle with an x) over a point
and click to remove the point. To delete all points within a rectangular cluster (Fig 3.20), select
the points by dragging an enclosing rectangle and click within the selection rectangle. Click
outside the rectangle to deselect the points. With the keyboard option, enter the exact coordinates
and click OK to delete a point. Hint: The Move tool provides coordinate lookup for points. Note:
ME ignores extraneous points during region definition.

N\

Use the line tool to enter multiple points on a straight line (Fig 3.18). With the keyboard (default)
mode, enter the starting point coordinates, press tab, enter ending point coordinates, and click OK
or press return. ME draws a connecting line.

Line tool




il L=
413

Click on the small numeric keypad icon to designate the number of interpolated points to be
spaced equally along the line. To modify the number of intermediate points, reselect from the
numeric keypad on the screen. If you wish to adjust the spacing of the points along the line,
simply drag the point along the line. ME constrains movement to the line segment bounded by
the adjacent points. The coordinates and the fraction of the distance along the line from the
starting point to the ending point are displayed. Click OK when you are satisfied with the

placement of the points.
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Mouse implementation of this tool requires that you select the number of intermediate points
first and then visually place the starting and ending point. To move points, use the move point

tool described below.

Arc tool
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This tool generates points defined by circular and elliptical arcs. The default keyboard entry mode
requests a center point for a circular arc, the starting point, and the number of degrees
counterclockwise. Use the numeric keypad icon to set the number of intermediate points and

click OK to generate the points along a circular arc.

The mouse entry mode allows you to select a circular or elliptical arc and to designate clockwise
or counterclockwise entry and the coordinates of the center point. Designate the number of



intermediate points with the numeric keypad icon before drawing the arc. Then click the circles
on the coordinate axes icon to select 90, 180, 270 or 360 degrees quickly.

Using the mouse, place the cursor at the center point and drag to establish the “radius”. The
“radius” will be the semi-major and semi-minor axes of the elliptic arc.

Change Paint

R0 1100000

¢ [0.20532030

Move point tool

Place the loop cursor over a point and click to select it. Then enter the coordinates of the change

point.

Note: In axisymmetric problems, to minimize errors, one side of each element should be parallel
to the axis of symmetry. See Chapter 4 for the computational details.

Region definition tool
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Fig 3.21 Region definition

After you define the individual points, click the region definition tool. Use the loop cursor to
locate the points. Begin at a vertex point and click. Continue in counterclockwise order until



you have designated all eight points (Fig 3.21). If you make a mistake, reselect the region icon to
undo and begin again. Press the shift key to change the cursor symbol from a circle to a small
square. Clicking with the shift key pressed defines a new point at the cursor location and selects it

as the next point of the region definition.

A different fill pattern identifies each of the multiple generating regions (Fig 3.22).

1.00
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Correct joining

(3 common points)
Correct joining

(3 common points)
Incorrect joining

(3 points not common)

Fig 3.22 Defining multiple regions

One or more sides of a generating region can be a second degree polynomial (Fig 3.23). In this
instance, we split a five-sided region to form two four-sided regions.
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Fig 3.23 Regions with curvilinear sides
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Delete region tool

Select this tool and then click within a region to remove the defining boundaries. To undo, i.e.,
redefine the region, click the delete region tool again before any other operation.

Note: Click any tool icon before clicking OK aborts the operation for a restart.

When you have defined all regions,

= Select Mesh from the File menu, and you will be asked to save the data.

|E save geometry data?
Binary Format
Yes ® y
O Tont Pormat
[ Mo ] [ Cancel ]

Fig 3.24 Save data dialog




Unless you are in Demo Mode, you must save the data before you leave a module (Fig 3.24). You
can save data in Binary Format (i.e., untranslated) for greatest speed, or in the standard Text
Format which can be read by a word processor. In fact, you can formulate a problem without the
graphics tools by using a word processor. You can translate file types using the Library module.

If you save the data, as you must if you intend to use the data in subsequent modules, ME
disables all existing dependent files. Click NO if you do not wish to save the data. Click Cancel if
you wish to return to the Geometry module without saving the data.

3.3 MESH Module.

Use this module to generate the mesh of elements, to save nodal coordinates and mesh
connectivity data, to renumber the nodes to improve computation efficiency, and to identify the
boundaries. ME uses the file (.Geom) from the previous module. Three files (.Mesh, .RMesh,
and .L/B) are created by this module.

% File
e e
About MacElastic... OpenProject...
About Project... Close Project
Help # 2.00 Main Menu
vDemo Mode Properties
Ouit

Fig 3.25 Mesh menus
The & menu (Fig 3.25) contains the commands already described for the Geometry module. The
help number, of course, has changed.

Open Project... and Close Project were also described in Geometry. Main Menu sends you to the
Main Menu; Properties is the normal exit path and Quit allows you to terminate the session.

The mesh module handles two major tasks: 1) generating and refining a mesh and 2)
renumbering the mesh for improved computational performance.
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Fig 3.26 Mesh module
3.3.1 Generate Mesh.

= Click Generate Mesh (Fig 3.26).

The following menu commands (Fig 3.27) become available:
% File Generate Windows Goodies

About MacElastic...
About Project...

Generate mesh

Help # 2.10

«w0Oemo Mode

End Generation

Fig 3.27a Nodes menus



Hide all windows

Nodes per side Goodies
Region 1 Label elements
Region 2 Label nodes

Plate with hole - Generated Mesh Hﬂﬂifg mesh

Fig 3.27b Nodes menus

The Help number has changed to reflect the new situation. Otherwise the & menu is as described
earlier.

The File menu is dimmed, indicating that it has been disabled.

The Generate Menu and the Generate button activate mesh generation after you specify the
number of nodes you want to place along each side of a mesh generating region.

Use the Windows menu to bring the desired window to the front.
Use the Goodies menu to label elements and nodes and modify the mesh.
Detailed instructions follow.

Let’s now define the mesh
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Fig 3.28 Nodes per side palette

To specify the number of nodes along the side of a region (Fig 3.28), you first

= Select a side by clicking in the small rectangle on that side.

If you have generated the regions properly, the opposite side of the region is automatically
selected by the program. If you have defined multiple regions, commonly constrained sides are
also identified by the program.

To specify the number of element vertices along the selected side(s),

= Click the desired number in the numeric keypad at the top left of the window.

= Repeat the process for each side.

After you have assigned a value to each side, ME displays the number of variables to be
computed, i.e., the number of degrees of freedom or DOF, below the keypad. For this scalar
potential problem, one unknown is associated with each element node. Also, the DOF is equal to

the number of equations to be solved.

= Click Generate to produce the mesh.
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Fig 3.29 Generated mesh (region 1)
Each mesh is generated separately (Fig 3.29) and then a composite is produced (Fig 3.30).
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Fig 3.30 Generated mesh (all regions)
Labels:

= Select Label elements or Label nodes from the menu to identify the node and element
numbers.

= Reselect the command to remove the numbering (and the check mark before the command),
or,

If the element or node numbers are too close to read, enlarge that portion or zone of the mesh as
follows:

= Press the option key and the cursor changes to a plus sign.

= Identify the area to be enlarged by dragging a rectangle with the mouse (Fig 3.31).
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Fig 3.31 Define a zoom rectangle
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Fig 3.32 Enlarged view

= Option-click (i.e., press and hold the option key and click) in the rectangle (Fig 3.31) to redraw
the area as large as the screen size permits (Fig 3.32).



= Select the Generated Mesh window (Fig 3.27) using the Windows menu (or Click the close box
on the zone window).

Modify:

We described two techniques for specifying mesh refinement: 1) move the middle point between
two vertices on the side of a mesh generating region nearer one end of the side to make the
elements smaller at that end, and 2) specify the number of nodes on each side of the mesh
generating regions.

Since you must specify the displacement boundary conditions at nodal points, place nodes such
that:

= elements are smaller in regions of greatest change of dependent variable;
= elements are roughly equilaterial; and

= element sides coincide with geometric boundaries, material property changes, and points of
loading.

NOTE: Nodal placement must anticipate these requirements.

Three additional graphical techniques are provided in this module to accommodate these
requirements.
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Fig 3.33 Reverse elements
= Select (the default) Redefine elements (Fig 3.33). Then,

= Click in two adjacent elements. Next,

= Click Redefine to reverse the common boundary (Fig 3.34).

SRR

Fig 3.34 Before, during, and after redefine

= Click OK only after you have completed all modifications of the three types.

Move nodes:
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Fig 3.35 Move nodes
= Click Move nodes (Fig 3.35).

= Click on a node to select it (Fig 3.36).
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Fig 3.36 Before, during, and after move node
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Fig 3.37 Node movement

The node and element sides connecting to that node are highlighted and the coordinates
displayed (Fig 3.36).

Either
= Assign the exact coordinates via keyboard, or

= Click in a triangle on either side of the Home button (left, right, above, or below) within the
diamond to move the point.

= Continuously press the mouse button to make repeated steps. If you wish,
= Click on Home to return to the original location.

= Click OK only after you have completed all modifications of the three types—redefine, move
and add.

Add nodes:
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Fig 3.38 Add nodes
= Click Add nodes (Fig 3.38).

= Click on two nodes of any element (Fig 3.39), and then

« Click on Add to bisect that side of the element.

SURRgE

Fig 3.39 Before, during, and after add nodes

Two elements having a common side become four elements. If the side connecting the nodes is
a boundary, ME creates only one additional element. Note: No undo command exists for this
operation; you must regenerate the mesh to begin again.

When you are satisfied with the mesh (i.e., after you have completed all modifications of the
three types—redefine, move, and add),

e Click OK. Then

= Select End Generation from the Generate menu (Fig 3.27) to return to the Mesh menu.



If you are not in Demo mode, ME asks you to save the Mesh data (Fig 3.40).

f Save generated mesh data?

i_) Binary Format
i Text Format

) [ cancet )

Fig 3.40 Save mesh data

Yes

Either:

= Click No to abandon the data and return to the Mesh module menu

or

= Click Cancel to abandon the data and return for another attempt at mesh generation
or

If you need to use this data in subsequent steps,

= Select either Binary Format for faster performance or Text Format if you will need to examine
the file with a word processor.

= Click Yes (Fig 3.38). Note: This also disables all data files which might now be incompatible.
Experienced users can use the techniques described in the Library module to over-ride this status
(83.7.1).

3.3.2 Other Calculations.

Click Other Calculations (Fig 3.26) to access node renumbering and calculations to speed
subsequent graphics calculations.
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Fig 3.41 Bandwidth reduction choices

Normally you select bandwidth reduction, especially if you have used multiple mesh generating
regions (Fig 3.41). However, if you have manually created a file with a desired numbering
scheme, you may wish to prevent automatic renumbering. In that case you would choose
Cancel. Instead,

= Choose Continue to proceed with the bandwidth reduction.
Observe the progress of the reduction process (Fig 3.42). The display traces the steps in the

renumbering process. If bandwidth reduction is not possible, the original numbering is
preserved.
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Fig 3.42 Bandwidth reduction display
If you are not in Demo Mode, ME asks you to save the Renumbered data (Fig 3.43).

f Save renumbered data?
i Text Format

) [ Cancel

| S

Fig 3.43 Save renumbered data

Either:

= Click No or Cancel to abandon the data and resume with unique lines,

or
= Select either Binary Format for faster performance or Text Format if you need to examine the

file with a word processor; and then,



= Click Yes to save this data for subsequent steps. This also disables all data files which might be
incompatible.

The next step is the automatic identification of unique plot lines and the boundary lines. This
reduces the plotting time and finds lines to be presented during the subsequent boundary
condition assignment process.

If you are not in Demo Mode, ME asks you to save the line information (Fig 3.41).

f Save line information?

i_) Binary Format
i® Text Format

) (Cancer )

Fig 3.44 Save line information?

Yes

Either:

« Click No or Cancel to abandon the data and return to the Mesh module menu.
or

If you need this data in subsequent steps,

= Select either Binary Format for faster performance or Text Format if you need to examine the
file with a word processor. Then,

= Click Yes. This also disables all data files which might be incompatible.
When you have completed the mesh calculations,

= Select >>Properties from the Mesh module screen (Fig 3.26) or from the File menu (Fig 3.25).

3.4 PROPERTIES Module.

After you have prepared the mesh files using the Mesh module (or without graphics support
using the Library module), enter the Properties module to define the material properties and to
assign the boundary conditions. These steps are required to uniquely define a problem and to



create the properties file (.Prop), the initial (or input) boundary conditions (.IBC), and final (or
equivalent nodal values) boundary conditions (.FBC). This is the final step in problem
formulation.

% File
About MacElastic... DpenProject...
About Project... Close Project
: # ......................................................
Help # 3.00 Main Menu
+Demo Mode Solve
Ouit

Fig 3.45 Properties menus

The & menu (Fig 3.45) contains the commands described in the Geometry module. The help
number, of course, has changed.

The Open Project... and Close Project are also described in Geometry. Main Menu sends you to
the Main Menu; Solve is the normal exit path and Quit allows you to terminate the session and
automatically close the project.

This module handles two major tasks: 1) entering and editing element properties and body forces
and 2) entering and editing boundary conditions or constraints (on boundaries and at interior
nodes). You enter body force conditions here because the input structure is the same as for
property definition.

You can enter properties and boundary conditions (Fig 3.46) in either order because ME does not
combine the results until you leave this module.

Let’s discuss properties first.
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Fig 3.46 Properties module
3.4.1 Properties.
If you have not selected a project when you reach the Properties module screen (Fig 3.46), follow

the usual steps to open a project file. If you have not previously created data files for this
module, the Properties and Boundary Conditions buttons will read “Enter”, rather than “Edit”.

= Click Enter (or Edit) Properties.
If a project is already open and a properties file already exists, you can either create a completely
new data file or edit the existing data. If only minor variations are needed, the latter approach is

qguicker; then

= Click Edit.
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Fig 3.48 Properties menus

The & menu contains previously described commands; see the Geometry module. The help
number, of course, has changed.

You must select and assign values for each property. Use End Property Definition to leave this
submodule. The File menu is unavailable until you return to the Properties module screen (Fig
3.46).

The Uniformity menu allows you to enter common properties for the largest possible unit.



The Windows menu provides movement between the whole plot and a zone plot, which can be
created as described below. We now describe each of these menu commands.
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Fig 3.49a The properties window (by regions)
The properties palette (Fig 3.49) provides visual assignment of properties.

= Select the property type from the Properties menu (Fig 3.48).

The property selected is named in the title bar of the window. The default is the first listed
property.

= Click slightly to the right of one of the 14 shaded squares, and a blinking cursor appears. Using
a consistent set of units (See Chapter 4),

= Enter the value you wish to associate with this pattern.
= Click on the shaded square to the left of your entry to select this value.

A small square around the pattern identifies your choice.



The properties listed on the menu can vary from element to element, vary only by mesh
generating region, or be uniform throughout the problem. Use the Uniformity menu to set the
largest unit of uniformity. If you select “by Element”, ME creates the required data structures (Fig
3.49b). If the properties are uniform except for a few elements, first select “by Entire Body” (Fig
3.49c) to make the global assignment and then use “by Element” to revise the exceptions.
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Fig 3.49b The properties window (by element)
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Fig 3.49c The properties window (by entire body)

= Click on regions (or elements or the entire body) to assign this value.

The number of the selected element is displayed at the bottom of the screen. If you wish to shade
multiple contiguous elements, simply drag the cursor with the mouse button pressed (Fig 3.49b).

If you require an enlarged view to satisfactorily assign the properties,

= Press the option key while dragging to create a selection rectangle.

= With the option key still pressed, click within the selection rectangle.
After assigning values,

= Select Whole Plot from the Windows menu (Fig 3.48).

CAUTION: Do not assign meaningless values, e.g., zero thickness or conductivity, to elements.
The thickness value does not appear if the problem has axial symmetry.



= Select the other properties from Properties menu and enter values.

Note: Enter distributed body forces (Fig 3.48) in this submodule; enter line forces in the boundary
conditions submodule considered next.

= Revise your property assignments if necessary, then

= Select End Property Definition from the Properties menu (Fig 3.48) to return to the Properties
module screen (Fig 3.46).

If you are not in Demo Mode, ME asks you to save the properties data.

f Save properties data?

i_) Binary Format
i Text Format
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Fig 3.50 Save properties data

Yes

Either:

= Click No or Cancel to abandon the data and return to the Properties module menu (Fig 3.46),
or

If you need this data in subsequent steps,

= Select either Binary Format for faster performance or Text Format if you need to examine the
file with a word processor, and

= Click Yes. Note: This also disables all data files which now might become incompatible.
ME returns you to the Properties module screen (Fig 3.43).

3.4.2 Boundary Conditions.
If you have not selected a project, the Open Project button is enabled on the Properties module
screen (Fig 3.46). You must follow the usual steps to open a project file. If you have not

previously created data files for this module, the Properties and Boundary Conditions buttons
will read “Enter”, rather than “Edit”.



= Click Enter (or Edit) Boundary Conditions.

If a project is already open and boundary condition files (initial and nodal equivalents) already
exist, you can either (Fig 3.51) create a completely new data file or edit the existing data. If only
minor variations are needed, the latter approach is quicker.

= Select Edit (Fig 3.51).

|E Previous data exists.

You may start with NEW data or EDIT the old data
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Fig 3.51 Edit existing data

A tool palette and new menus appear. In this module you assign constraints —boundary
conditions and internal nodal conditions—which the solution must satisfy. The problem must
be “well-posed”, i.e., lead to a unique solution. The responsibility for creating a well-posed
problem rests with the user. An improperly formulated problem can lead to an ill-conditioned
system of linear algebraic equations. Access to the data files in the Library module permits you to
explore the numerical details.
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Fig 3.52 Boundary condition menus

The & menu (Fig 3.52) contains previously described commands; see the Geometry module. The
help number, of course, has changed.

The palette for the visual input of boundary conditions is immediately available when you enter
this submodule. After you have assigned the boundary conditions, by selecting Nodal Boundary
Conditions you can display the internally generated nodal equivalent conditions which will be



used in subsequent calculations . Use End Boundary Conditions to leave this module; the File
menu is unavailable until you end boundary condition input.

Note: Recall that the strategy used in ME is to formulate a system of equations to find the
dependent value at the nodal points. Consequently, ME converts the input constraints into
“nodal equivalents”.

The Windows menu provides movement between the whole plot and a zone plot. See Fig 3.54
for details required to create a zone plot.

These menu commands are described in detail below.
Assign the constraints.

As indicated in the discussion of the properties submodule, you can apply three types of
constraints. The first and second (nodal forces and displacements) are applied at nodes, and the
third (surface stress) apply to the face of an element (and are assigned at the midpoint between
two nodes, but are internally converted to equivalent nodal force values). In all instances you
must use a consistent set of units! (Refer to Chapter 4.)
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Fig 3.53 Boundary condition tools



Enter
w-Direction
Foint Force

—> Value:

nodal forces

You can specify line forces at nodes for two-dimensional problems and ring forces for
axisymmetric problems. You must supply the signed value of the source per unit length (or
negative values for opposite coordinate direction) before you assign the icon to appropriate nodal
points.

Force components are applied in the coordinate directions.

Enter
A-Direction
Cvisplacernent

oo Value:

nodal displacement

You can specify the displacement at nodes on the boundary or in the interior. You must supply
the numerical value before you assign the condition to the nodes.

Enter
A=Direction
Surface Stress

—a Value : | AT |

stress along the surface of any element on the boundary

You can specify the (signed) surface stress on the face of any element. Assign the icon at the mid-
side point of the edge of the element. Select the stress component (x or r direction, y or z
direction, or normal or tangential) before entering the numerical value.



&7

erase a constraint

Use this tool in combination with the above four tools. ME erases ONLY boundary conditions
of the type selected. This is especially useful when multiple types of condition appear at the same

node, such as at a corner

To assign the same constraint value over a range of the boundary, keep the shift key pressed
continuously as you select first the beginning point of the range and then counterclockwise
around the boundary to the ending point. A circle icon appears at the top left of the work area to
indicate you are applying the range condition.

Note: Your choice of beginning and ending point determines the designated segment. If you
make the wrong choice and select the complement, use the eraser tool.

iz

Obscured
If you need increased resolution to unambiguously assign constraints,

= Press and hold the option key to turn the cursor into a plus sign and drag a selection rectangle
(Fig 3.54). With the option key continuously pressed, click inside the selection rectangle to
produce an enlarged view.
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Fig 3.54 Zoom to assign conditions
After assigning the constraints

= Select Whole Plot from the Windows menu to return to the composite view.

Note: To review boundary condition assignments: If you have selected the nodal force or

displacement icon, place the cursor over a node; if you have selected the surface stress icon, place
the cursor over an element side marker.

After you have assigned all conditions,
= Select End Boundary Condition Definition from the B.C. menu (Fig 3.52).

If you are not in Demo Mode, ME asks you to save the boundary conditions (Fig 3.55).

f Save Boundary Conditions?
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Fig 3.55 Save boundary conditions?




Either:

= Click No or Cancel to abandon the data and return to the Properties module menu (Fig 3.46), or,
If you need this data in subsequent steps,

= Select either Binary Format for faster performance or Text Format if you need to examine the
file with a word processor. Then,

= Click Yes. This also disables all data files which might be incompatible.
If you need make no further changes to properties or boundary conditions,

= Select >>Solve from the Properties module screen (Fig 3.46) or from the File menu (Fig 3.45) to
move to the next module. You have just completed the formulation process.

Sl

3.5 SOLVE Module. 5-u F

This module uses the data files which describe the mesh (.RMesh), the properties (.Prop), and the
boundary conditions (.FBC) to form a system of simultaneous linear algebraic equations and then
to solve for the nodal values, average element values, and nodal and element stresses and
strains.

Normally you save the nodal values (.NDisp) but intermediate results can be saved for tutorial
purposes, if desired. ME first uses the geometry and properties files to create by superposition of
element values a global system of equations (force vector .1V and stiffness matrix .IS) in matrix
form. Next these global equations are modified to satisfy the constraints. If you have assigned
any force conditions, ME applies them to the “stiffness” matrix first and stores them (.CF file).
Then ME applies the remaining constraints, converted earlier to nodal equivalent conditions, to
the force vector and stiffness matrix (and stores them as .MF and .MS, respectively).

Enter Solve from the Properties menu (Fig 3.46) or double-click Solve from the Main menu (Fig
3.5). If no project is open, you must open one.
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Fig 3.56 Solve menus



The About MacElastic..., About Project..., Help, and Demo Mode commands (Fig 3.56) were
described for the Geometry module and are the same here, except the help number has changed.

Similarly, Open Project..., Close Project..., and Quit have been described already. Plot is the next
logical module when solve has been completed.

For two dimensional problems specify whether you wish to assume plane stress or plane strain
deformation (Fig 3.57). For a thin body with no loads perpendicular to the plane of the body,
assume plane stress. On the other hand, if the dimension of the body normal to the applied load
may not change, assume plane strain. See Chapter 23 of Segerlind for further details.

Does the analysis assume: [ﬁ]””
S.u F
@® Plane STRESS 4.01

or

(_) Plane STRAIN

Fig 3.57 Computational assumption
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Fig 3.58 Solve Module



The Solve module (Fig 3.58) computes: nodal displacements, element strains and stresses,
element principal stresses, nodal coordinate stresses, nodal principal stresses, and miscellaneous
calculations. You need not calculate all three groups, but if computed, the top-to-bottom order
must be followed.

3.5.1 Nodal Displacements.
= Click Solve Nodal Displacements (Fig 3.58).

ME forms the system of equations, modifies them to reflect the boundary conditions, solves them
by Gaussian elimination, and stores the nodal results (.NDisp).

If you do not wish to examine the intermediate files (.IF, .IS, .CF, .MF, .MS) or do not have
sufficient disk space, do not save the intermediate vectors and matrices.
(See Appendix 2 for a description of these files.)

= Click No (Fig 3.59).

9 Save intermediate
vectors and matrices?

(slower) (faster)

Fig 3.59 Save intermediate files?

You can interrupt computations at any time by clicking the Abort button, which changes in name
to OK (Fig 3.60) when ME completes the calculations. The speed of these calculations is
dependent upon available RAM. Significantly more disk activity is required for a 512KE
Macintosh than for more recent Macintoshes with more memory. The Macintosh Il is noticeably
faster than an SE; the ME professional version which utilizes the 68881 math coprocessor
(standard with the Macintosh 1) is dramatically faster, perhaps by a factor of 25 to 30. ME
provides progress markers and time estimates for the Macintosh being used.
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Fig 3.60 Nodal displacement calculations
= Click OK (Fig 3.60) to return to the Solve module screen (Fig 3.58).

After ME computes the nodal displacements, you can, if desired, calculate the average element
strains and stresses and the nodal stresses. ME uses the consistent element method of smoothing
(Segerlind, 1984) to obtain these nodal values.

3.5.2 Stresses and Strains.

If desired,

= Click Solve Stresses and Strains (Fig 3.58).
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Fig 3.61 Stress and strain calculations
You can interrupt the computations at any time by clicking the Abort button (Fig 3.61).

= Click OK (alias the Abort button in Fig 3.61) to return to the module menu.
3.5.3 Other Calculations.
If desired,

= Select Other Calculations (Fig 3.58) for the infrequently needed nodal equivalent forces which
would have produced this solution and the coordinates of the displaced nodes.

You can interrupt computations at any time by clicking the Abort button (Fig 3.62). ME reports
the elapsed time.

= Click OK (alias the Abort button in Fig 3.62) to return to the Solve module menu.

Note: Regardless of Demo Mode status, ME saves the computed files.
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Fig 3.62 Other calculations progress indicator
When ready to resume,

= Click >>Plot on the Solve module menu (Fig 3.58) or select Plot from the File menu (Fig 3.56).

3.6 PLOT Module. ]—»

Note: To enter Plot, either click the >>Plot button on the Solve module screen (Fig 3.58) as
discussed at the end of the Solve module, or double-click Plot on the main menu (Fig 3.5). If you
have not opened a project, you must choose Open Project... from the the File pull-down menu
(Fig 3.63).

This module uses the data files created in the previous modules to graphically portray the project
and to present the results. Two classes of graphics are possible: screen-sized diagnostic plots and 8
by 10 inch publication quality plots with extensive labeling. Plots include: Generated Mesh,
Boundary Conditions, Nodal Displacements, Element Strains, Element Stresses, and Nodal
Stresses. In the next section (Library module) we describe the tabular output.
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Fig 3.63 Plot menus ptl

The & menu (Fig 3.63) provides the usual information about MacElastic and the project. The
help number identifies the context-sensitive help message from the Appendix. You can select
and unselect Demo Mode at any stage. However, Plot creates picture files, but no data files, and,
therefore, cannot corrupt the data files as long as you remain in this module. Demo Mode does
not affect file saving in this module.

The File menu provides the usual capabilities to open and close a project, to branch to the Main
Menu or to the next logical module, and to quit. In addition, you can print 8x10 plots on an
ImageWriter or a LaserWriter. Note: Use Chooser on the ® menu to select the print driver.

You can send copies of the screen sized plots to the ImageWriter using caps-lock command shift 4
or save them to disk using caps-lock command shift 3. For a LaserWriter screen dump you must
have an additional desk accessory or first save the screen as a MacPaint file using command-shift-
3.

You can print the 8x10 page size plots on the ImageWriter or the LaserWriter using the print
commands on the File menu. Using MacPaint or a program having similar capabilities you can
print later plots saved using the Save Picture... command.
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Fig 3.64 Screen plots with lookup

The PlotSize menu defaults to the smaller and more quickly drawn Screen size plots (Fig 3.64).

With the smaller plots no space is saved for a tool palette. The edit and label pull-down menus
provide node and element numbering, zoom capability, and control for the numbering format.
ME provides automatic value lookup for node displacement, element stresses and strains, and

nodal stresses.

The larger plots (Fig 3.65) correspond to the maximum size printable with an ImageWriter. ME
provides the usual cut, copy, paste, clear, and select all commands. In addition it provides font,
font size, and style selection, as well as left, middle and right justify and background control.
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Fig 3.65 Larger 8x10 plots with rapid scrolling and labeling

LaserWriter quality labels are available for node displacement, element stresses and strains, and
nodal stresses, and free-form text labels.

You can produce six different plot types in either of the two sizes. The plots of problem
formulation are generated mesh and boundary conditions; and the output results include
contour plots of displacement, shaded plots to depict average element stresses and strains, and
contour plots of nodal stresses.

Depending on the plots, you can elect to superimpose the mesh or not, display only the
boundary, label some or all nodes and elements, choose the components of stresses and strains,
choose the contour line values, set the format of displayed values, and automatically locate some
or all labels and prescribe various display style features. ME automatically retrieves the relevant
data files as needed.

3.6.1 Screen Size Plots.

First, let’s examine a set of screen size plots.



Generated Mesh

NM& 2\ Z\

l{fzmzﬂnshmz\ g

1231 122,113 1|:|1 a9 '."E

?

124 4

2% E6 21 w5

o

1

12

Fig 3.66 Node numbers

Fig 3.66 shows a mesh with numbered nodes. To

produce this figure,

= Select Generated Mesh from the Plot menu (Fig 3.63).

= Select Label Nodes from the Goodies menu (Fig 3.67)

« Reselect Label Nodes to remove the labels.
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Fig 3.67 Plot menus-2
If desired,

= Select Label Elements from the Goodies menu.

= Reselect Label Elements to remove them.

Use the zoom option of the Goodies menu for a clearer view of the bottom corner.
= Select Zoom (Fig 3.67) on the Goodies menu.

= Create a selection rectangle (Fig 3.68) by dragging with the mouse.

= Click OK (Fig 3.68) to generate the enlargement (Fig 3.69).

= Select No Plot (or Generated Mesh again) from the Plot menu (Fig 3.63) to resume.
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Fig 3.70 Multiple plot

ME also provides an alternative zoom. Again,

EI OIEIICYENESE] ~

= Select Generated Mesh from the Plot menu.,
and

= Select Zoom from the Goodies menu. Then

= Select Multiple (Fig 3.70) and, if desired, adjust the number of subdivisions along each
dimension. This technique creates multiple zones which ME draws to the same scale and you
can assemble to form a large mosaic.

= Click in the rectangle of greatest interest, click OK, and that zone will be drawn.

= Select zoom again. The previously drawn zone will be shaded.

= Click in another zone and then click OK.

Boundary Conditions

Next plot the boundary conditions.



= Select Boundary Conditions from Plot (Fig 3.63).

Boundary Condition Specifications

i Input
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Fig 3.71 Boundary conditions type

You can plot the boundary conditions (Fig 3.71) as entered (Input) as well as the computed nodal
equivalent values (Nodal).

Note: The Labels option is available only for 8x10 plots. However, ‘display only’ labels are
provided for diagnostic plots.

= Select Input and click OK.

After ME has drawn the figure and completed the cursor count-down (while data structures are
being created),

= Position the cursor over each boundary condition and press to echo the boundary condition
type and numerical value.

Note that the nodal equivalent stress boundary condition at the edge is half the other values.
To improve readability of the numerical values,

= Select Digits from the Style menu (Fig 3.83) to set the display format (Fig 3.72).
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Fig 3.73b Boundary conditions
= Click Fixed, and

—
w—Direction
Surface Stress
| 100.0
= Scroll to Rounding Position of 1 (Fig 3.72). ™*

« Click OK.

Now redisplay selected boundary condition values (Fig 3.73).

If desired,

= Select Boundary Conditions from the Plot menu again (Fig 3.59).

= Choose Nodal Boundary Conditions (Fig 3.67) to produce the second plot in Fig 3.69.
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Fig 3.74 Superimpose mesh
= Select Nodal Displacement from the Plot menu.
If you do not wish to superimpose the mesh on the lines of constant potential, leave that item

unchecked. The Labels option does not apply to these smaller diagnostic plots and remains
dimmed.

After the cursor count-down finishes, press on any original node to display the displacement
components. You can use Digits... from the Style menu (Fig 3.72) to set the display format.
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Element Strains
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Fig 3.76 Element strain options

This option produces a shaded plot of the average element strains—X-component, Y-component,
and X-Y shear.

= Select a component option.

Decide whether to include a mesh overlay (Fig 3.76) and

= Click the box to draw only the boundary, i.e., without the mesh.
« Click OK.

= Assign ranges for the plot. Usually the defaults are adequate. Note: See the nodal stresses
section for a discussion of the window.
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Fig 3.77 Specify the shading values
= Click OK.
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Fig 3.78 Element strain plot
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Fig 3.79 Element stress options
This option produces a shaded plot of the average element stresses—X-component, Y-

component, and X-Y shear with the Coordinate direction option, and Maximum principal stress,
Minimum principal stress, and Maximum shear in x-y plane with the Principal option.

= Select Coordinate direction and x-component.

Decide whether to include a mesh overlay (Fig 3.79) and

= Click the box to draw only the boundary, i.e., without the mesh.

= Click OK.
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Fig 3.80 Element stresses
= Assign ranges for the plot (Fig 3.77). Usually the defaults are adequate. Note: See the nodal
stresses section for a discussion of the window.
= Press the cursor on an element for the auto-lookup feature.

= If desired, use the Digits option of the Style menu to set the display format.
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Fig 3.81 Select stress plot type
= Select Nodal Stresses from the Plot menu.

= Designate the stress type you want to plot, e.g., coordinate direction.

= Designate the component you want to plot, e.g., Xx-component.

= Designate whether you want the mesh displayed, e.g., do not select Superimpose mesh.
= Click OK.

= Supply a compatible set of rounded plot values.



5et range of data values ‘l_j,:?

Actual: Min. ralue = -7F.425e+0 5 40
May. value = 4.209g+2 ]

Min. value: |-7.425e+0

4
Max. value: (4.209e+2 | << |

Increment: |Z2.141e+1 < Calc

Increments:

20

[ [ aneel ] [ Digits ] [ Reset ] [ 0K ]

Fig 3.82a Select contour lines

The default minimum and maximum contour lines correspond to the actual minimum and
maximum of the data. For ease of interpolation and visual effect, you will frequently wish to

select rounded values for the contour lines. ME provides a convenient calculation capability for
finding such values.

Due to screen size considerations an upper limit of twenty contour lines can be displayed with
clarity. Furthermore, if rounded minimum and maximum contours are specified, the increment
size and number of increments are interdependent. Choose either the increment size or the
number of increments and click the arrow button to the right of the other to calculate a

compatible set. The OK button will be dimmed until a compatible set has been computed (Fig
3.82b).
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Fig 3.82b Select contour lines

= After ME generates the plot (Fig 3.83), place the cursor on a contour and press to display the
contour value.




3.6.2 Presentation Plots.
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Fig 3.83 Plot menus-3

Screen siZe
+8110 page size

= Select the 8x10 PageSize to produce presentation quality plots.

You can produce each of the six plot types previously described in larger publication quality size.
Also, the remaining plot menus which deal with labels apply here (Fig 3.83). The Font and
FontSize menus reflect the fonts in your system file.

The first six entries of the Style menu correspond to their use in word processors. Erase
Background specifies whether the background for a label is erased. The next three options
determine whether the labels are left, middle, or right justified within their fields.

The last (Digits...) has been demonstrated already (Fig 3.72), but we describe it below too.
After you have selected items in the Style menu, all subsequent labels will be affected until

changed. Any or all previously entered labels can be changed if you first choose Select All from
the Edit menu or shift-click to select any subset of labels and then change the style.
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Fig 3.84 Large plot with contour labels

Labeling capabilities allow you to label some or all of the elements, nodes, boundary conditions,
and contour values. You can move labels and select the font, font size, and display style of the
labels. The label can be made opaque or transparent and can be left, center, or right justified
within its field.

After you select the combination of features required in your plot, ME creates only the required
data structures. A progress indicator (Fig 3.85) reports the steps in this process. The image ME
creates is larger than the standard Mac SE screen and is slightly larger than the Mac Il standard
screen so ME generates the plot off-screen.
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Fig 3.85 Progress indicator
Figures 3.86 through 3.91 illustrate these capabilities.

The generated mesh (Fig 3.86) was saved as a MacPaint™ picture, pasted into this document and
reduced to 50% of the original size. All node numbers were placed using the defaults. The plot
need not contain all labels of a given class. You select the font, font size, and style. You control
alignment within the print field and whether the label overwrites or masks the figure. The
labels can be repositioned for clarity and aesthetic purposes, even if the erase background feature
has been used.
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Fig 3.87 Boundary conditions

The boundary conditions (Fig 3.87) plot also provides automatic lookup of values. In this plot
some labels have been removed and others repositioned for improved clarity. Somewhat higher



resolution is obtained by printing directly from within ME since the object-oriented graphics need
not be converted into the lower resolution bit-mapped form.
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Fig 3.88 Nodal displacements on boundary

Fig 3.88 illustrates the nodal displacements for boundary nodes. You specify the format of the

displacement labels. The labels can be repositioned. This figure also illustrates the use of free-
form text labels.



The boundary conditions (Fig 3.87) plot also provides automatic lookup of values. In this plot
some labels have been removed and others repositioned for improved clarity. Somewhat higher

resolution is obtained by printing directly from within ME since the object-oriented graphics need
not be converted into the lower resolution bit-mapped form.

Fig 3.89 Average element strains

The average element strain for a selected component can also be represented using up to 16

different shading patterns (Fig 3.89). Automatic lookup of element number and element average
strain is available.



e

2
L L
L

T,
R R
e
e

90 Average element stresses

ig3
the average element stress for a selected component can also be represented us

F

ing up

lookup of element number and element

larly,

imi
to 16 d

S

IC

Automati

.90).

ig 3

tterns (F

ing pa

fferent shadi

is available.

average stress



103.0

MNode Streszes

w=direction 0.0

0.0
i

Fig 3.91 Constant stress lines

Fig 3.91 displays lines of equal stress (x-component). Up to 20 contour lines can be displayed with
or without labels. Format and position of labels can be specified.
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Fig 3.92 Plot palette

The standard screens can display only a portion of the larger plots (Fig 3.92); therefore, ME
provides scroll bars for horizontal and vertical movement. In addition, the miniature portrait
window at the top left corner provides rapid scrolling, including diagonal movement. Drag the
inversed rectangle, which corresponds to the visible portion of the plot at the right, to a new
location and release. Click the box in the bottom right corner to center the figure.

Just below the miniature portrait are the icons for adding, deleting, and moving labels of the type
selected from the Edit menu. ME provides eight label types (Fig 3.93).

= Select either node, element, boundary condition, displacement, element strain, element stress,
node stress, or text label.

You must select the leftmost icon of Fig 3.92 when you wish to add a label. The second icon
displays an X and is active only when you have selected a label by shift-clicking. Click the third
icon to drag a label.

Note: If you have selected the third icon and subsequently wish to add a label, you must first
reselect the add icon!
Note: Shift-click to select labels before making any changes in font, font size, style, etc.
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Mode Stresses Specifications

Stress type: i Coordinate direction
i Principal
Component options: @ H-component
i 1 ¥Y-component
i+ H-Y shear
Flot type: [] Superimpose mesh
Labels: [<]Elements Al
i Selected
[<] Nodes 3 Al
i Selected
(<] Contours AN
i Selected
L A

Fig 3.93f Plot specification menus



S5tress type: 3 Coordinate direction
™ Principal

Component options: ® Maximum principal stress
y Minimum principal stress
{y Maximum shear in H-Y plane

Fig 3.94 Plot specifications for principal stresses

Figs 3.93 and 3.94 display the plot choices.
Cut, copy, paste, and clear on the Edit menu work as you would expect.

Note: These options are enabled only if you elected to create the requisite data
structures—either before you created the figure or from the Goodies menu later—and
only for the relevant plot type.

Note: You must select the ADD icon, not the MOVE icon, when you wish to add labels.

j=——= Plate with hole Node 5Stresses: H-component

‘\\\_ 140.0
175.0
;\‘21 0.0
xh245.lil
400 contour Tine Mode Streszes
w“—direction

value

Fig 3.95 Modify labels

If you chose selected nodes, elements, or contours, click on the location of the desired label and
ME automatically looks up and places the correct value on the plot. Use shift-click to select one or



more labels (Fig 3.95). While selected, the font, font size, and style menu selections can be

changed.
| Edit

Cul 3EH
Copy #LC
Paste 3#EU
Clear

NMode Labels

Element Labels

BC Labels
Displacement Labels
Element Strain Labels
Element Stress Labels
Mode Stress Labels

+TeHt Labels
Select Al #A
Refresh #H
Optimize #E

Fig 3.96 Edit menu

Use Select All to select all of the currently selected class of labels (on the Edit menu—Fig
3.96) for modification, e.g., change of font or font size. Shift-click to remove objects
from the set of selected objects.

= Select Digits from the Style menu (Fig 3.83) to modify the format of the numbers if
adjacent labels conflict, for example. Shift-click to select existing labels before
changing the default format.

= Select Text Labels from the Edit menu to add text labels. Drag a rectangle to create a
text window. Enter text in the usual word processor manner.

= Select Optimize to shrink-fit a text window to the added text. To resize again, press
the option key while dragging the resize tab in the lower right corner of the frame.



Change Plot Specs
Joom

Change value increments

Label Nodes
Label Elements

Fig 3.97 Goodies menu
If you did not select a desired type of label,

= Select Change Plot Specs (Fig 3.97) to redraw the same plot but with a different set
of labels chosen from the Specifications dialog box.

@ Single
1 Multiple

VA

Cancel

K

M N e 5't

Fig 3.98 Zoom selection

= Select Zoom (Fig 3.97) to enlarge a rectangular portion of the plot (Single—Fig 3.98) or to plot
one or more equal-sized rectangular regions (Multiple). In the latter case, you can combine the
composite of these rectangles to produce an enlarged view of the plot. See the discussion for
screen size plots. If you are using a LaserWriter for output, you can choose automatic size changes



from 25 to 400% of the standard page at print time. (See the corresponding discussion for screen-
sized plots.)

= Select Change value increments (Fig 3.97) to adjust the number and value of contour values
(Fig 3.99).

5et range of data values ‘l_j,:?

Actual: Min. value = 23.76
Max. value = 30.00

Min. value: |23.00

<<
Max. value: |30.00 | << |
Increment: |0.50 | < Calc

Increments:

14

[ § s syinal ] [ Digits ] [ Reset ] [ 13

Fig 3.99 Digits menu

You can prescribe any three of the four values—minimum, maximum, increment, and

number of increments—and have ME calculate the remaining value. The OK button is
not enabled by ME until such a consistent set has been calculated.

= Use the Digits button to format the numbers.

= Edit the minimum and maximum values for conveniently read values.

= Set either the increment size or the number of increments and click opposite the other to
calculate a compatible value. The OK button is not enabled until you have done this. If more
than 20 increments are needed, you will be required to alter the requested values to achieve
conformity with this limit.
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Fig 3.100 FontSize

The FontSize menu (Fig 3.100) allows you to change the size of selected text or change
the size of text you now enter. The sizes listed in outline style are available in the
system file; the other sizes are synthesized from an existing size.

Plain
Bold
flafic
Underline
Dmilime
Bhadomm

Align Left
Align Middle
Align Right

Fig 3.101 Style menu

Use the Plain, Bold, Italic, Underline, Outline, and Shadow styles (Fig 3.101) as you
would in your word processor.

= Select Erase Background to blank the background around a label. To restore the
background for a label, shift-click to select the label and click Erase Background to
remove the check.



= Select Left, Middle, or Right to align future text entries within the label field. Shift-
click to modify existing labels.

= Select Digits... (Fig 3.101) to modify the display format.

= Select Left, Middle, or Right to align future text entries within the label field. Shift-click to
modify existing labels.

= Select Digits... (Fig 3.101) to modify the display format.

Plate with hole Node Stresses: H-component

—

a0.0

Fig 3.102 Nodal stress contour lines
The corresponding plot of constant maximum principal stress is produced in a similar manner.



Plate with hole Node Stresses: MaH. Prin. S5tress
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Fig 3.103 Maximum principal stress contour lines

ME provides great flexibility in creating and labeling plots. If desired, print or save the plot you
produced. When ready to examine tabular results, select Library from the File menu.

M

The Library module provides tools to enable you to initiate new projects, to modify existing
problems, and to examine the numerical results of existing projects. It provides the primary
access to tabular results—screen and printed. (Note: You prepare graphical results in the Plot
module, not the Library module.) The Library module also creates a master data file to
coordinate the creation of the project files. This master file maintains the status flags for each of
the data files. If you wish to solve a problem which is a variation of an existing project, you can
duplicate the problem formulation files in this module.

3.7 LIBRARY Module.

If you have not opened a project when you enter this module, the Library module allows you to
open a project, create a new project, or duplicate an existing project.



% File

New Project...
Open Project...

“ Close Project

Ahout MacFElastic... I]u_pli[:ate Project...
About Project... Print Draft
Print Final
elp .
ﬂﬂﬂh Help # 6.10
Main Menu
+wOJemo Mode Quit

Fig 3.104 Library menus

The usual & menu (Fig 3.104) contains a description of MacElastic, a description of the open
(active) project, a context specific help reference to a help message in the Appendix, and a demo
mode enable/disable command.

The File menu allows you to create a new project, open an existing project, or close an open
project. In addition you can duplicate the input files of an existing project so you can study a
variant of the existing project. You can print the data files of an open project on ImageWriters
and LaserWriters.

This menu allows branching to the Main Menu. Quit allows you to exit ME.

Consider the handling of each alternative—examine an existing project, create a new project, and
duplicate an existing project (Fig 3.105).



uﬂﬂﬁ Library

™

Create New Project ]

[ Ouplicate Project ]

[Hain Henu]

| Plot |

[l]pen Pruject...] [ Ciaes Frafend

Fig 3.105 Library module screen (viewed when no project is open)
3.7.1 Examine an Existing Project.

From the Finder (not from within ME), a project folder (Fig 3.106) contains the notebook icon
(master file) and icons for notebook pages (data files).

Emg Plate gmgl
16 jtems 237K in disk 234k available
X

j j

Flate with holePlate with holPlate with hol Plate with holePlate with hoFPlate with hole Geomn

B =T wa B =T wa

I I
Flate with holPlate with ho Plate with hcPlate with hole Plate with holPlate with hole NPStr

'F[j [j 'F[j
wa war wa

Flate with hol Plate with ho'Plate with ho'Plate with hole BMesh

=l =

Fig 3.106 Project file icons
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Bl Froject $tatus = —————————|

Eegword: FPlate with hole Total =ize: 7K bytes
Fec Exists Status Hame Sizeck
Geomeatry 3 *late with hole. Geom 1,1
Mesh 2 E,T ® Flate with hole.Mesh 5,5
3 E L Flate with hole.RMesh =,0
4 B - Flate with hale. L/E 2,0
ﬁﬁﬁhé#iiéé ....... HER g SRRt F]Efé'ﬁ}iﬁ'ﬁﬁié'ﬁﬁﬁh ................ é;ﬁ'”
5] B - Flate with hole. |BC 1,0
...................... ‘B ..% Flate with hale FBC 3.0 | Frpnip |
Solue g Flate with haole. IF a,o0
g Flate with hole. 15 oo
10 Flate with hale.CF oo
11 Flate with hole HF o,0
12 Flate with hole. M5 a0
13 =] L Flate with hole HDisp 3,0
14 =] L Flate with hole . EStra G,0
15 E L Flate with hole . EStre G,0
16 B - Flate with hale EPStr 11,0 [SEt Httrihs]
17 B - Flate with hole. HStr 4.0
18 B - Flate with hole. HPStr 7,0
19 =] L Flate with hole. HCoord 3,0
20 =] L Flate with hole. React 3,0

Fig 3.107 Project status

Refer to the Appendix for a description of the structure of each file. You can read and edit these
files from within the Library module when the project is open.

= If necessary, open the Plate project.

Note: If no project is open, the first screen displayed is the Library module (Fig 3.105); if a project
is open, the Project Status (Fig 3.107) is the first screen displayed.

The project status screen lists the 20 data files listed in the master file. File names consist of the
project name and a period plus a descriptor which indicates the type of file.

The first column indicates which ME module created the file.

The second column provides the file number which corresponds to the order in which you
created the files.

The third column indicates whether a file exists. A blank means no file exists, a “T” means the
file is a text file and can be read by a word processor. A “B” means the data has been stored as a
binary file. Binary files can be created and read more quickly because the data need not be
translated. ME can translate the binary file into a text file (Fig 3.108); this slows file access but
allows you to examine and modify these files.



ﬁ 5ave changes?
(@ Binary Format
1 Text Format
[ No ] [ Cancel J

Fig 3.108 Change file format

You can change the file format. If you modify anything in a file, immediately correct the change,
and then close the window, a format translation occurs.

A dot in the fourth column indicates that the file status is active and prevents the use of
inconsistent data files. If you change the contents of an input file, ME makes all files inactive
which are now inconsistent and removes the dot in the status column.

The file name appears in the fifth column. See Appendix 2 for a description of the contents of
these files.

The last column indicates the file size (kilobytes). The number before and after the comma
corresponds to binary files and text files, respectively.

Click on a file name to select it. The “Geom” file has been selected in Fig 3.107. Click on the open
button to open the file. Alternatively, double-click on the file name to open it.



Plate with hole.Geom - Text

A. Coordinates of lnput Data Points
B. Region Definitions and Connectivity
C. Arc Data
A1l 120 0O 1 ii
AZ| 122.5219 57.4025 1
A3 106.066 10G6.066 1
A4| 37.40253 133.3219 1
A3 O 130 1
AG| =00 0
A7 300 500
A=| 0 500
ARI| 272.5 0
A10| 200 230
A11| 230 300
A1zl O 272.5
A12 242.9429 2432 9429
Bif 196 10 7 12 2 2 201.3863235 144 676425 00 2 0 2 9
B2 2 132 7 11 8 12 5 4 144 676425 201.38635 1 000 2 9
Cif 150 130 0 0 =
cz 1 3 2 3 4
i
] EEE

Fig 3.109 shows the geometry file which is described in Appendix 2. As an academic exercise or to

Fig 3.109 Examine a file

gain greater flexibility, you can create these files directly from within the Library. When a data
file is open, another set of menus becomes available.

% File Edit Numbering

New Project...
Open Project...
Close Project

Print Draft
Print Final

Main Menu
Quit

ODuplicate Project...

| Edit

Cut 3EH
Copy #LC
Paste 3D
Clear

File Attributes

Numbering

All numbers
woOroup numbers
Renumber

Fig 3.110 Library menus

Only the Help number changes on the & menu; the File menu (Fig 3.110) does not change.



The standard Cut, Copy, Paste, and Clear commands appear on the Edit menu. Cut and Copy are
enabled only when text is selected; Paste is enabled only when the Clipboard contains text. The
last command, File Attributes, allows you to change (or set) the size of the arrays in the file, as
was discussed in the introduction to this section.

The Numbering menu provides line numbering for the file. Use All numbers to number the
entries consecutively. Group numbers identify the data class for each line, and the lines are
numbered consecutively within each class. Use Renumber to refresh the line numbers if you
have edited the file.

| |=———+——— Plate with hole.Mesh - Text
A. Element Dafinitions

B. Mesh Hode Coordinates

C. BandHidth

A1 10 11 11
A2 11 2 11
A2 11 12 2 1
A4 12 2 2 1
A3 12 13 2 1
AG[ 13 4 3 1
A7 13 14 4 1
A2 14 5 4 A
RI 14 15 5 1
RI1O0] 12 6 5 1
A11] 13 16 & 1
A1Z] 16 7 6 1
A3 16 17 7 1
A4l 17 2 7 1
A1) 17 12 2 1
RI1G| 12 9 2 1
A17 19 20 10
A1E] 20 11 10
A19] 20 21 1
pz2of 21 12 11

L I I L . I L . ]

= [0

Fig 3.111 The mesh file
When you have selected a file (Fig 3.107), ME enables the Attribs button.

e —_ —a

= Click the Attribs button to obtain the following (Fig 3.112).



File Attributes

Mame: Plate with hole.mesh

(<] Active

Items:
Element Definitions 224
Mesh Node Coordinates 135
BandWidth 1

(concet ] [ change |

Fig 3.112a Set file attributes

File Attributes

Mame: Plate with hole.Geom

(<] Active

Items:
Coordinates of Input Data Points 13
Region Definitions and Connectivity 2
Arc Data 1

[ Cancel ] [ Change ]

Fig 3.112b Set file attributes

You can change the status flag if you are confident the data files are compatible. If you create data
files within the Library module, you set the array sizes here. You can examine the contents of
inactive files.



EC] Nodal Displacements ——=]|
[Hode X ¥
1]&.626651997535019e—1 0, 00oQao0000a000de+0
2| & 5740955454165 1581 0, 00oQao0000a000de+0
3| 5. 475322910245902-1 -1 . 1510319595555660-2 o
4 | 5 699645373 1715538e—-1 -9 41 P06 140475545525
5| 9. 2167393 1445902921 0, 0000000000 00000e+0

Fig 3.113 Output listing

= Click Cancel to abandon any changes or click Change to accept changes.
= Double click a file name (Fig 3.107) to view the output listing (Fig 3.113).

You cannot edit the output listings from within ME. See the Appendix for a discussion of the
structure of the output files.

= Click the square box in the top left corner of the window to close the window.

3.7.2 Create a New Project.
If no project is open, click on Create New Project or select Open Project from the File menu.
= If necessary select a disk and folder.

= Enter a project name (Fig 3.114) and click save.

=] Plate

Dy Plate i bals Ma.
v Piate wiih hals Eé‘*‘%é;
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{#+[2] MacElastic

v Biata oapith hola P
Dy Prate pbth hole FRE :
© Prate with bole Gearm [

Create Project Named...
New Project | Cancel |

Fig 3.114 Name project




Enter Project Description
Project: New Project
Description:

Type problem description here.

Fig 3.115 Describe project

= Provide a project description (Fig 3.115).
= Note the available memory for the project.
= Click OK.
3.7.3 Duplicate a Project.
To use an existing project to create a template for a variation of the problem,
= Open the project you want to duplicate if it is not already open, and
= Select Duplicate Project... from the File menu (Fig 3.105) of the Library module.

= Supply a file name (Fig 3.116) or accept the sequentially numbered default.
Change disks or drives if necessary.

= Click Save.
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Fig 3.116 Name duplicate file

sS[ /=———————=— Project Status
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Fig 3.117 Initialized files

ME creates a new folder with the project name and a script f appended. It duplicates a new
master file and the seven input files.

When you close the current project and open the new one, use the About Project command from
the & menu to update the project description. ME allows you to begin revision of the project
files with any input module.



Chapter 4
Computational Details

This chapter presents a brief overview of the computational details handled by MacElastic. Refer
to Applied Finite Element Analysis (Segerlind, 1976,1984) and The Finite Element Method
(Zienkiewicz, 1977) for additional details.

4.1 Function Variation Within An Element.

In our use of the finite element method in elasticity, displacements are expressed as a continuous
function within each element. We select both the shape of the element and the form of the
displacement function, but they are related. Element shapes can be triangles or quadrilaterals
with straight or curved sides. Straight-sided elements require a node at each vertex. Curved-
sided elements require additional nodes to define the shape of the element sides.

4.1.1 Shape Functions.

The form of the element displacement function is determined by the interpolation given by a set
of shape functions. Commonly, shape functions are polynomials of the node coordinates, so the
order of the polynomial depends on the number of nodes in the element. Here, we use the
simplest element, a 3-node, straight-sided triangle.

The shape functions used for a 3-node triangular element are linear functions of the two problem
coordinates. Thus, displacements are linear functions of the coordinates. Consider the two-
dimensional element shown in Fig 4.1.

Y

"

Fig 4.1. Representation of a 3-node triangular element

Let a displacement in a given direction be represented by the symbol u, which is a continuous
function within this triangular element, i.e., u(x,y). Displacement values at the nodes i, j, and k
are U;, U;, and U,, respectively. Displacements throughout the element are defined as linear
combinations of the node values:

u(x, y) = Ni(x, y) U + Nj(X, y) Uj + Ny (X, y) Uy 4.1

or, in matrix form,



[ ]
u=[N; Nj N I{Ujy =[N]T{ U} 4.2
[UJ
where Nj, Nj, Nk are shape functions® (functions of the coordinates) defined by

— coordinates of the nodes for the element and
— coordinates of the point of interest.

Shape functions used here are linear functions of x and y (or r and z for axisymmetric bodies)
within an element, and are defined as:

Ni=[a+bx+gyl/2A
Nj=[g+bx+qgy]/2A 4.3
Ny=[a+bx+cyl/2A

where A is the area of the element
(x,y) are the coordinates of the point within the element.

In matrix form, the shape functions are a column vector:

g +bx +qy
[N]=(1/2A){ g +bXx+gyy 4.4
{6\<+ka+CkyT

where constants are defined from the node coordinates as follows:

A= XY + XY, + XY - XY - XY - XYy 45
S :Xij- XkY]

g = X Yi- XYy

& = XIYJ - XJYI

bi = YJ - Yk

bj = Yk - Yi 4.6
bk = Yi - YJ

G =Xy - X

G =Xj- Xy

G = xj - X

! Segerlind, 1976, 26; Zienkiewicz, 1979, 23



Example 4.1 - Shape Functions for a 3-Node Triangle.

d U, =25 ,(4.5)

(.2)
U.=la

(3.1)
Uj=EEI

¥
Fig 4.2. A 3-node triangular element example
Evaluate the shape functions for the element shown in Figure 4.2.

Coefficients in the shape functions are determined by substituting the nodal coordinates of this
element into equations 4.5 and 4.6:

2A= XY+ XY+ XY - XY - XY XY
2A=(5)(5)+ (21 + @2 - 52 - A1) - (2(5) =11

a=X;Y- X\ Y;j=(5)(06) - 4)(1) =21
g =X Y- XjY = (4)(2) - (2)(5) =-2
& = XIYJ - XJYI = (2)(1) - (5)(2) =-8

bI:Yj_Yk:1_5:-4
bj:Yk'Y|:5'2:3
bk: i-Yj:2-1:1
Ci:Xk-Xj:4- 5=-1
CjIXi-Xk=2-4=-2
Ck:Xj'Xi:5'2:3

For this element the shape functions evaluated using equation 4.3 are:

ja+bx+ay 21- 4x -y
[N]:(1/2A)iq+b,-x+qy y =(1/11)§-2+3x- 2yy
|ﬁ<+ka+CkYL {-8+x+3y]

Compute the shape function values at the nodes of this element:



a atnodei (2,2)

N, =[21- @)(2)- (D@]/11 =
N; =[-2+(3)(2- 2@]/11 =0
Ne=[-8+ (D@ +()?2)]/11 =0

aatnodej (5,1)

N, =[21- @(B)- (D@D]/11 =0
N; =[-2+((B)- QD]/11 =1
Ny =[-8+(@0)(©B)+ ] /11 =0

a atnode k (4,5)

Ni =[21- 4@4)- (DBI1/11 =0
N; =[-2+Q3)4)- (B1/11 =0
Ny=[-8+D@+ B]/11 =1

This illustrates an important property of element shape functions: they are unity at their node
and zero at the other two nodes. Elsewhere in the element they have values between zero and
one.

4.1.2 Computing Displacements.

A displacement within an element is defined by the product of the shape functions and the
displacements at the nodes:

[ ]

u=[NTT{U}=[N; N; N Iq Uy 4.7
[ UJ

Thus, a check of the shape function coefficients is this:

aat node i, u must equal

Ui, which requires that
Ni =1
NJ =0
Nk =0

a at node j, u must equal
UJ’, which requires that



aat node k, u must equal
Uk, which requires that

Ni =
NJ =0
Nk =1

The shape functions for this element, being unity at their node and zero at the other nodes,
produces the proper interpolated displacement values at the nodes. You can use these shape
functions to determine the displacement u(x,y) at any point in this element by substituting the
coordinates of the selected point into the shape function equations.

Example 4.2 - Displacement At A Point

For the element used in the previous example, determine the displacement at the interior point
with coordinates (3,3). Now compute the shape functions at this point using the element shape
functions obtained in the previous example and coordinates (3,3):

[21- #) - (1)(3)] [6]
[N]=(1/11){-2+®3)@3)- Q@) y=(1/11)
l-8+(1)(3)+(3)(3) l41/

and the displacement is defined by equation 4.7:

12
u=[N] {U}=(1/11)[6 1 4] { 20y=17.45
[

Thus, using the shape function and the known temperature values at the nodes

Ui, Ui Uk), you determine the temperature value u(3,3) to be 17.45. Likewise, you can determine
displacement values at all points within any element using the shape functions for the selected
element and the displacement values at the nodes of that element.

4.1.3 Derivatives of Functions.
The finite element equations for elasticity presented below are based on derivatives of the

displacements®. Recall that the displacement functions within a 3-node triangular element are
linear with respect to each coordinate direction and are used to obtain displacements from:

2 segerlind, 1984,138; Zienkiewicz,1979, 423



P atbx+ayp’
u=[N]T{U}=(1/2A)_'q+bjx+cjy_' {U} 48
lek"'bkx"'cky}/

The partial derivative of u(x,y) with respect to x is:

U
[u/fx] [N/ d
, sy = , — 'U-’ 9
Lowrn) " ooy [B]'[UJJ 4

where [B] is the shape function derivative matrix given by

[B] :[ﬂN/ﬂX], :i 'bi bj bkl:l
[y T2A & g od

This illustrates that the derivatives of the displacements in an element are constants. We show
strains and stresses within an element to be functions of the derivatives of displacements (see
Segerlind, 1984, p. 288ff or Zienkiewicz, 1979, p. 22ff). Thus, because the derivatives are constant,
the element strains and stresses are too. This also requires that you divide your problem into
many elements when 3-node triangles are used if strain or stress are of interest to you. We
discuss the calculation of strains and stresses in a later section.

4.10

(DD

Example 4.3 - Derivatives Of Temperature For A 3-Node Triangle.

Evaluate the derivatives of the displacement within the element shown in Figure 4.2. To do this
use equations 4.9 and 4.10 together with coefficients calculated in example 4.1:

12
[u/Pa &4 3 10[ ] 13361
| qu/ 1y =Wig | 3Hl ;gr ~ {209

Within this element, the displacement gradient is constant as indicated by the vector shown in
Figure 4.3.



Fig 4.3. Derivatives of the temperature in an element
4.2 Finite Element Equation Formulation.

The general form of finite element equations is a matrix product of a square stiffness (coefficient)
matrix and a column displacement vector set equal to a column force vector:

nxn nx1  nx1 (rowsx columns)

[KI{U} ={F} 411

where
[K] is a square, symmetric "stiffness" matrix,

{U} is the "unknown"displacement vector,
{F} is the "force" vector, and n is the number of "unknown" displacements.

A matrix equation of this type is formed for each element and combined into a global equation
for the entire problem domain. After you form the global matrix equation for the entire problem
domain, you apply boundary conditions to modify the equations. Solution of the modified
equations yields the displacements for the given problem and boundary conditions. Then, if
desired, you can evaluate element strains and stresses and nodal strains and stresses.

In 2-dimensional (and axisymmetric) elasticity problems, each node has two "unknown"
displacement components. For 2-dimensional problems, these correspond to the x and y
component displacements as shown in Fig 4.4. Symbols i, j, and k denote node numbers, and
subscripts of the displacement components are functions of the node numbers. Odd subscripts
refer to x components and even subscripts refer to y components of the displacements U.



Uy

U

Fig 4.4. Notation for nodal temperature values

Because the unknown displacement at each node is a vector quantity and has two components,
the matrix equation for each element has six "unknown" nodal displacements. You evaluate the
2-dimensional displacement at a point in the element from the shape functions and nodal
displacements as follows:

1x1 1x3 3x1 (rowsx columns)

u={N}"{U} 4.12
where

[ Vai-1] éNi Oy

R .
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{u} = UJ , [N] OJ N B, and { u} =[ X}', 4.13
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and N;, Nj, N are the linear shape functions defined in equation 4.3
4.2.1 Two-dimensional Cartesian Coordinate Systems.

For elasticity in 2-dimensional Cartesian (X,y) coordinate systems, the strain in an element has
three components:
exx]
{e} =1 8yy 4.14
[ exyr

and can be defined as derivatives of nodal displacements:

1 (rows ~ columns)

31 36. 6
{e}t=[Bl{U} 4.15



where the shape function derivative matrix is:

[B] = (1/27) EO G 0g 0 g 4.16
G b ¢ b o bo

Stresses in the element are defined from strains and material properties
31 33 31 (rows ”~ columns)

{s}=[DI{e} 4.17

where [D] is the material property matrix.

The material property matrix depends on the choice of assumptions used to achieve a 2-
dimensional problem.

= For plane stress (loads applied only in the plane of the body), the material property matrix is:

édlm 0 g
E u
[D] :ge—Q@m 1 03 418
1- nf%, o 1M
& 2 0

= For plane strain (body constrained so no displacement can occur perpendicular to the plane of
the body), the material property matrix is:

1-m m

1- 2m 1-2m
m 1-m
-2
0

m
o

[D]:&

T m? 4.19

1- 2m 1-2m

MD: D> (D> @D (D> (D> (D~
o
e N enii en @ < el et a2

NI O

0

where mis Poisson’s ratio and
E is Young’s modulus.

The finite element matrix equation describing 2-dimensional elasticity in a 3-node linear
triangular element is:

6 6 61 6 1 (rows ~ columns)

[t A[BI'[D][BII{U}={F} 4.20



which matches the form of equation 4.11. The force matrix {F} is zero prior to application of
boundary conditions. The element stiffness matrix for 2-dimensional elasticity is the 6-by-6
matrix evaluated by the matrix multiplications shown in the first term of equation 4.20. The
unknown displacements are two component nodal values; thus, 3-node triangular elements
have 6 degrees of freedom (6 unknowns).

The finite element equations presented are valid for any consistent set of units. For SI (metric)
systems, forces, displacements, and stiffnesses can be expressed in Newtons, meters, and
Newtons/meter, respectively. Stresses and elastic moduli are defined in Pascals.

If we use local node numbers for nodes i, |, and k equal to 1, 2, and 3, respectively, then subscripts
for the unknowns become 1 through 6; and equation 4.20 can be expanded to the following
matrix equation:

€11 kio Kiz Kig Kis kl,Gg.l[ Ull [ Fll

|
eko1 Koo Koz kog kos Kaggi Uz'l' F2'|'
gka,l K32 K33 K3g K35 ks,sgi U3y _! Fay 491
eKa1 K42 Koz Kga Kas Kaetj Usi i Fai
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|
~ . |'
©s1 Kso K53 Kss Kss ks gl Ugl 1[

é U
eke1 Ko Koz Kea Kes k6,60lU6J

Each of the six displacements represents a degree of freedom (dof) for this element. U: is the x-
displacement of node 1 (dof=1), U: is the y-displacement of node 1 (dof=2), Usis the x-
displacement of node 2 (dof=3), etc. Each stiffness coefficient, ki;, represents the force that must be
applied at one node to produce a unit displacement at another node. The first subscript denotes
the degree of freedom of the force, and the second subscript denotes the displacement degree of
freedom. Thus, ki is the x-direction force applied at node 1 (dof=1) that produces a unit y-
direction displacement of node 1 (dof=2); kss is the x-direction force applied at node 2 (dof=3) to
produce a unit x-direction displacement of node 3 (dof=5).

Example 4.4 - Finite Element Equation Formulation.

Determine the element stiffness matrix for the element shown below. Assume plane stress
conditions. Material properties are:

E =50 x 103 Pa

n=0.3

t=01m
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Fig 4.5 Material properties

For this 2-dimensional element, the shape function derivative matrix is defined by equation 4.16
together with coefficients determined in Example 1:

€ 0 by 0 b OU €40 3 0 100
[B]=(1/2A)§O G 0g O ckE:(lel)go 10 -2033 4.22
&G b G b o b &1-4-2 3 31

The material property matrix is defined by equation 4.18:

=

Lm0 €1 3 o
2 E ¢¢m1 oY 5 |
[D]=%—n?6@ g=54,945§,3 1 OE 4.23
LntP8y o 1Ma &0 0 .350
e 2 0

The element stiffness matrix is determined using the matrix products in the first term of
equation 4.20,

[K® =t A[B]"[D] [B] , which, by grouping constants, is

€4 0 -1u

e u
© ég 01 ‘21@@1 3 0Ué4 0 3 0 10U
k'] = 4995 ¢ "o o - . u 4.24
[k™] 995éO o qu83 1 03a0 -1 0 -20 3

é ue0 0 .3506-1-4 -2 3 313

al 0 3§

60 3 14

Substituting values from above yields the following 6 x 6 element stiffness matrix:



€16.35 26 -11.3 1.35 -505 -3.95U
§26 66 19 -22 -45 -44
(K9] = (a905) €113 19 10.4 -39 09 20 g
€13 -22 -39 7.15 255 -4.95U
-505 -45 09 255 4.15 195
6-395 -44 20 -495 19 ®&35Q

4.25

Note that the diagonal coefficients (in bold type) are positive and have the largest magnitude in
each row and column. Also note that the coefficients which are symmetric about the diagonal
are equal, e.g.,

ki3=kz1=-11.3 The sum of coefficients in any row or in any column is equal to zero. These
attributes exist in all of the element stiffness matrices and in the global stiffness matrix produced
by assembling the element matrices.

If you number nodes i, j, and k for the element of interest locally as 1, 2, and 3, respectively, the
finite element equation for this element becomes:

€16.35 2.6 -113 135 -505 -3.95@-,[ U51 ,[ F51
£26 66 19 -22 -45 -444] Ue'l' | Fe i
e-11.3 19 10.4 -39 09 20 g! Ugl
(499.5) Iy Jog =
21.35 -22 -39 7.15 2855 -4954; Uy |
a-505 -45 09 255 4.15 195 31yl T,

6-395 -44 20 -495 195 9.350|y,| |F,|

The force matrix is zero because no forces are applied to this element. The boundary conditions
are added only after all of the element equations have been assembled into a global matrix
equation.

4.2.2 Axisymmetric Systems.

For axisymmetric (r-z coordinate) systems, the 3-node triangular element is a triangular toroid (a
triangle of rotation about the z-axis). In axisymmetric coordinate systems, the strain in an
element has four components

I[ err}
{g = Ty 427

T €4
e
and can be defined as derivatives of node displacements:

41 46 61
{e}t=[Bl{U} 4.28



where the shape function derivative matrix (evaluated at the element

centroid) is:
ébp 0 b 0 b, Oy
é , , a
[é]—(uzA)gNo ) I\IO ’ |\(|) " 4.29
- i— 0 =2 0 = OH '
al r r l,J
G b G B G b
where

r is the r-coordinate of the element centroid.

Stresses in the element are defined from strains and material properties.
(sy=[D1("e) 430
where [D] is the material property matrix.

For axisymmetric geometries, the material property matrix is:

é m m u

é 1 1-m 1-m 0 u

é 1

e 1 L o g

[D] = g EQ-m gsglm I-m u 431

€(1+m(1- 2m ﬂ§ m m 1 0 u

gl- m 1-m 3

é 2(1-2maq

You can evaluate the finite element equations at the element centroids with minimal error if the
elements are small .

The finite element matrix equation defining axisymmetric elasticity in a 3-node triangular
element is:

66 61 61
[2prA[B]'[DI[BI1{U}={F} 432

Note that A is the element area,
2p ris an equivalent thickness for the element, and

[B] is the shape function derivative matrix evaluated at the element centroid.



The form of equation 4.32 matches the form of equation 4.11. Note that this element equation
has the same dimensions as does equation 4.20 for 2-dimensional Cartesian coordinate systems
even though the dimensions of [D], [B], {e}, and {s} differ in these two coordinate systems.

4.2.2 Review of Element Equations for Elasticity.

a Element shapes and sizes can differ because nodes need not be on a regular grid. Nodes i, j, and
k are at coordinates:
X, Yi), (X, Y)), and (Xi, Y\, respectively.

a Unknowns are defined by continuous polynomial shape functions in an element. For 3-node
triangular elements, the shape functions are linear with respect to x and y (or r and z):

u(x,y) = INGy)l '{ U}

a Finite element equations are defined in a common matrix form:

[KI{U} ={F}

a The element stiffness matrix is a function of node coordinates (in A & [ B]) and material
properties (in [ D ]):

[K]=tA[B]"[D] [B]

a The strain is defined within an element as:
{e} =[B} {U} and is constant throughout an element.

a The stress is defined within an element as:

{s} =[Dl{¢

a Yet to be discussed are:
a Mapping from element coordinates to global coordinates
a Combining element equations into a global matrix equation
a Applying boundary conditions to the global equations
a Solving for "unknown" displacement components at the nodes

4.3 Global Matrices.

A finite element equation of the form of equation 4.33 exists for each element in the problem
domain.

K9] {u®} = {1} 4.33
where the superscript (e) indicates the element number.

The solution must satisfy all of these equations simultaneously to develop a solution to the
problem posed. Thus, it assembles a larger matrix equation (a global matrix equation) from the



individual element equations to establish the total set of conditions that govern the problem
solution. The global matrix equation must have a number of rows equal to the number of
degrees of freedom (unknowns) for the problem; for elasticity problems, this is equal to twice the
number of nodes.

The rpogram systematically combines equations from individual elements to develop a global set
of equations. First, it establishes the global matrix equation to provide the number of rows (and
columns in the global stiffness matrix) needed for all degrees of freedom. Then it inserts element
equations into the global matrices by adding stiffness coefficients and sources to values in their
respective global locations. We illustrate this later.

The number of simultaneous equations existing for each element is equal to the number of
degrees of freedom (unknowns) for the element. A 3-node triangular element has six degrees of
freedom if two unknowns occur at each node as is the case with two-dimensional elasticity (and
three degrees of freedom if one unknown exists at each node as with Poisson’s equation).

Figure 4.6 shows a body with elements 1, 2, and 3 and nodes 1, 2, 3, 4, and 5. Because two
unknown displacements exist at each node, you need six equations for each element. Degree of
freedom numbers are based on the node number and the displacement component as defined in
Table 4.1.

3

()

4 — 5
Fig 4.6. A body with three 3-node triangular elements
Table 4.1 Degree of Freedom Definitions for Problem in Fig 4.6.

DOF Node Direction
1 1 X
2 1 y
3 2 X
4 2 Yy
5 3 X
6 3 y
7 4 X
8 4 y
9 5 X
10 5 y




For element 1, containing nodes 1, 4, and 2, the element equation is:
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Values of the stiffness coefficients depend on the geometry and material properties of the
element as discussed earlier but are designated only by symbols for this illustration. Note that a
complete matrix equation would include rows and columns for degrees of freedom 5 and 6;
because these coefficients are zero for element 1, they are not shown here. The total number of
columns required to display this element stiffness matrix (including intermediate zero values) is
called the bandwidth (BW) of the element stiffness matrix, given by:

BW = (highest dof) - (lowest dof) +1 4.35

which gives for element 1,
BwY=8-1+1=8

Thus, in a global matrix format, element 1 equations would require 8 rows, and the stiffness
matrix would have 8 rows and 8 columns if the intermediate row and column were included.

For element 2, containing nodes 2, 4, and 3, the element equation is:
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The bandwidth for element 2 is
BW?=8-3+1=6

Because the node numbers for element 2 are consecutive, this bandwidth is the minimum that
can occur for a 3-node triangular element with two degree of freedom per node.



For element 3, containing nodes 3, 4, and 5, the element equation is:
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é
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The bandwidth for element 3 is
BW® =10-5+1=6

The global matrix equation for the body being considered has ten degrees of freedom (five nodes
with two dof each). The values in the global matrices are the sums of the corresponding values
in all of the element matrices. For example, for a 3-element body, the force component in the ith
row of the global force matrix is

izt + 62+ 19 437
and the global stiffness coefficient in the ith row and jth column is
ki =k + k2 + K 4.38

Because the unknown displacements for each degree of freedom are the same regardless of the
element equation from which it arise, they appear in the global equation without superscripts.
Thus, the global matrix equation for the 3-element body being considered becomes

gkl,l kio Ki3 kiga O 0 ky7 kyg O 0 ﬂl[ Ull |[ fll
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€k31 k3o kg3 K34 k35 kg K37 kgg O 0 0fugl T f37
Skt Kiz Kes Ko Kos Kao Kag keg O 0 Slud 16,

g 0 0 ksz Kss k55 Ksg K57 Ksg Ks g k5,10@Il USl :l fsl, 439
e 0 O kez Kesa kes Kee Ke7 Keg Keo k6,108':' Ue%/ : fe i .
gkm k7o k73 K74 kos koe K77 K78 K79 k7,103::: U7: :f7:
§k8,1 k8,2 k8,3 k8,4 k8,5 k8,6 k8,7 k8,8 k8,9 k8,10L:1j Usj | f8]f

g 0O 0 0 O Kos kog Ko7 kog Kg o k9,103.'. ugl 1 fgl

e 0 0 0 0 Kkios Kioe Kio,7 Kios Kioo klO,lOﬂl”lOJ lfloJ

The primary diagonal of the global stiffness matrix includes coefficients



K11, K22, K33, ™, Kqp,10. Coefficients with reversed subscripts are symmetric about the primary
diagonal and are numerically equal:

Ky 1 =Kq 2, K6 =Ke 2, Ka g =Kg 4, etc. Note that the global stiffness matrix contains zeros (also
symmetric about the primary diagonal) where no nonzero element stiffness terms occurred (e.g.,
no element contained nodes with degrees of freedom 1 and 10, so K; 190 = Kj01 =0). Note also that
all nonzero coefficients lie within a band about the primary diagonal. Matrices of this type are
called banded matrices.

Because the global stiffness matrix is a banded symmetric matrix, only the diagonal and half of
the nonzero numbers (shown in bold type in equation 4.39) are unique. The bandwidth of the
global stiffness matrix is the minimum number of columns required to retain all unique
numbers in the stiffness matrix. By condensing the global stiffness matrix as shown in equation
4.40, the bandwidth becomes less than the number of degrees of freedom; thus, 8 rather than 10
columns are kept to retain all unique stiffness coefficients.

g Kii Kio kis kya 0 0 kyy k1,88
akoo Koz kpu 0 0 k7 kg O g
2~3,3 Ks,a K35 kg Kz7 kzg O O 3
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gk7,7 k78 K79 k710 O 0 0 © 3
ekao Koo Kgao O O O 0 04
gkg,g Kg 10 O 0 0 0 0 0 3
éklo 10 0 0 0 0 0 0 0 a

The bandwidth for the global stiffness matrix as shown in equations 4.39 and 4.40 for the 3-
element body is 4.

BW=8-1+1=8

The numbers in the condensed stiffness matrix (equation 4.40) are defined so that the primary
diagonal of the original matrix becomes the first column of the condensed matrix; subsequent
diagonals are subsequent columns in the condensed matrix, e.g.,

1=k, ko3 =koo, By 1=Ks s, Byoa=Kyo, Boa=kos, Ksa=kay etc.

Here, the condensed matrix contains only 80 (10 x 8) numbers as compared to the 100 (10 x 10)
numbers in the original stiffness matrix. The amount of space saved by condensing the matrix in
this manner depends on the number of unknowns and the manner in which nodes were
numbered.

The bandwidth of the global stiffness matrix (and the number of columns in the condensed
matrix) depends on where the nonzero coefficients occur in the global stiffness matrix, which



depends on the bandwidths of the included element stiffness matrices. The largest element
bandwidth becomes the bandwidth of the global stiffness matrix. Larger bandwidths require
more computer memory and longer computation times; therefore, it is important that you
number nodes in a manner that minimizes the bandwidth.

When you manually assign node numbers, you can achieve smaller bandwidths by numbering
nodes sequentially in the direction of smaller mesh dimensions. For example, consider the mesh
in Figure 4.7 with two different node numbering schemes. Numbering first along the longer side
(side with the most nodes) as shown on the left results in a larger bandwidth than numbering
parallel to the shorter side. In more complex geometries or in automatic node numbering
approaches, node renumbering algorithms can be used to reduce the bandwidth after the entire
mesh has been defined. ME uses the Collins renumbering algorithm to reduce the bandwidth of
the global stiffness matrix before the element equations are assembled to produce the condensed
stiffness matrix. Global stiffness matrices are stored in the condensed format.

2
1 7 12 1 3
7 g 4 :
14 6
3 9 T 3
15 9
4 10 10 11
15 12
11 13 14
3 17 15
5 12 18 18 L7 13
BW =7 BW =4

Fig 4.7. Bandwidths resulting from two node numberings
Example 4.5 - Global Stiffness Matrix Assembly.

A mesh has numerous elements with a total of 50 degrees of freedom. The element stiffness
matrices for elements 1 and 2 are given below. Combine these two element stiffness matrices as a
first step in assembling a global stiffness matrix.
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The global stiffness matrix has 50 degrees of freedom, the first 10 of which are shown below. All
remaining coefficients are zero at this time. You obtain the first coefficient in the global stiffness
matrix,

ki1, by adding the K

coefficient from the element 1 matrix
(1)
ki1=12)

to that from element 2
(2)
ki1= 0)

yleldlng

kl,l =12+0= 12

(The element 2 matrix has a zero value for
(2)

ki1

and Is not shown because element 1 does not have dof #1.) Both element matrices have degree
of freedom 6; therefore,

Kes = kb +KZL=-5+1=-4

You can obtain all other coefficients in the global stiffness matrix similarly by adding
corresponding coefficients from the element matrices.
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4.4 Material Properties.

Material properties used in elasticity problems include the following:
E elastic (Young's) modulus of the material
| Poisson's ratio
t thickness (when not axisymmetric)
a coefficient of thermal expansion
DT temperature difference, relative to a reference.

You can use any consistent set of units for these properties. We present example units for
material properties in Table 4.2.

Table 4.2 Units for Material Properties

Property SI Units English Units

Elastic modulus Pascals Pounds/inch?2

Poisson’s ratio -- --

Thickness meters inches

Coeff. thermal expansion 1/°C 1/°F Temperature diff °C °F

You may specify each property for each element, thus allowing widely varying property
variations throughout the body. Assume Young's modulus, Poisson's ratio, and the coefficient
of thermal expansion to be isotropic (equal in all directions). The coefficient of thermal
expansion and temperature difference specify initial thermal strains in the material, a part of the
boundary conditions. The temperature difference is the temperature of the material above some
reference temperature at which no thermal stresses exist in the material.

4.4.1 Two-dimensional Cartesian System Thermal Strains



Incorporate thermal strains into the finite element equations by defining fictitious point forces at
the nodes of the elements under thermal strain. The element thermal force vector for Cartesian
coordinate systems is

{F®} =tA[B]"[D] { &} 4.41
where, the thermal strain,
{eo},is
1
{e} =a DT l 1Y) 4.42
of

for plane stress, and

{eo}=(1+n')aDT'l%f 4.43

for plane strain.

The element thermal force vector has six components (force in two directions acting at each of
the three nodes).

4.4.2 Axisymmetric System Thermal Strain

In axisymmetrix systems with thermally induced stresses, the equations are modified in a
manner similar to that in the two-dimensional case. The element force equation resulting from
thermal strains is:

{F®} =2prAI[B] D] {e;} 4.44

!vhere A is the element cross-sectional area,

r_is the r-coordinate of the element centroid, and

[B] is the shape function derivative matrix evaluated at the element centroid. The thermal
strain,

{e}is

1

{e} =a DT 1y 4.45

d



Even though the [B] and [ D ] matrices for axisymmetric systems differ in dimension from those
for Cartesian coordinate systems, the element thermal force vector has six components, two
directions for each of the three nodes.
Example 4.6 - Element Thermal Strains
Consider the element used in Example 4.4 with material properties:

E =50 x 108 Pa

n=0.3

t=01m

a =5x10% 1/°C

T=5°C
Assuming plane stress conditions (Equation 4.42), the thermal strain is:

[ R

_ 6y (5) { 16 = 2 ol
{e} = aDTlo}/ (5 10 )(5)léT 25° 10 léf

and from equation 4.41 , the thermal force vector for this element is:
{FP =t A [B]" [D] {e)}

Using previously determined matrix values (from Example 4.4) and grouping constants,
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which yields the element force vector:
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which consists of six components (forces in two directions at three nodes).
4.5 Boundary Conditions

Boundary conditions impose physical forces and displacements on the elasticity problem.
Without them, there is no problem since all displacements would be zero. In solving the finite
element equations, boundary conditions are used to define specific constraints placed on the
matrix equations to yield nodal displacements appropriate for the physical problem being
analyzed. Boundary conditions allowed in this program include forces applied at nodes, stresses
applied on boundaries, and displacements fixed at nodes. Nodal forces and boundary stresses are
used to define the force vector on the right-hand side of the matrix equations; fixed
displacements signify fewer actual unknowns and are used to modify the stiffness coefficients to
yield these nodal displacements. Because nodal displacements are vector quantities, the
boundary conditions have both magnitude and direction. You can specify surface stresses in
directions normal or tangent to boundaries, but the program converts them to global coordinate
direction components before applying them to the matrix equations.

We give two sets of units commonly used for boundary conditions in Table 4.3. You can use any
consistent set of units.

Table 4.3. Units for Boundary Conditions.

Variable SI Units English Units
Force Newtons Pounds

Stress Pascals Pounds/inch?
Displacement Meters Inches

4.5.1 Point Forces.
A force acting at a node has two force components,
fy and fy. Add these force components to the force matrix, {F}, in the rows corre- sponding to the
proper node and directions (degree of freedom). Change the element force matrix for a force
applied at node i as follows:

[
i
{F}={F}+|'8y 4.46
I ol
|0

where

fx and fy are x and y components of the force at node i.

In axisymmetric problems, the force matrix modification is:
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where f;and f; are r and z components of the force at node i.

4.5.2 Body Forces.
Forces acting uniformly over the volume of an element (such as gravitational, inertial, or
magnetic forces) are called body forces. You can treat body forces as point forces by distributing
the total force among the nodes of an element. The body force modifies the element force matrix
in a Cartesian coordinate system as follows:

[X]
Lyl
| x|
{F ={F} +(tAR)| vy 4.48
i Y3
. X
14
where X and Y are x and y components of body force per unit volume.

Axisymmetric body forces are not distributed equally to all nodes of an element. Because
portions of an element further from the z-axis have greater mass, they experience more of the
body forces; thus, nodes with larger z-coordinates receive more of the total body force. The
program distributes body forces to the element force matrix as follows :

[ @R+R+R) R|

'[ (2R+R+Ry) z-'[

{F} ={F} +(2p A/12) | (R+2R;+R,) Ry 4.49
L (R+2R+R) Z !

(R+R+2R,) Z

where R and Z are r and z components of body force per unit volume and R;, Rj, and Ry are the
r-coordinates of nodes i, j, and k, respectively.

4.5.3 Surface Stresses.
Treat stresses acting on the boundaries of elements as point forces distributed to the nodes on the
element sides affected. Modify in the following manner the element force matrix for a stress
applied to the element side bounded by nodes i and j in a Cartesian coordinate system:
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where Sx and Sy are x and y components of the surface stress (force per unit area) on side i-j, Li,j
is the side length, and t is the element thickness.

co$ v B

For axisymmetric problems, the distribution of the applied stress to boundary nodes depends on
the radial coordinate of each node where the stress acts. Because the element thickness is
proportional to the r-coordinate and surface area depends on thickness, the allocation of force to
the nodes on side i-j of an element is as follows:

[(@R+R) s
i (2R+R)) sz-i-

(A ={R +1(pLy;) 6l Ri2R) s
i (R+2R) s;i
I o I
| o |
where S;and S; are r and z components of the surface stress (force per unit area) on side i-j,

Lij is the side length, and Ri and R;
are the r-coordinates of nodes i and j, respectively.
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4.5.4 Fixed displacements.
You can assign prescribed values to nodal displacements by altering the matrix equation to yield
the desired "unknowns". Below we give a procedure for constraining the solution. This method
retains the original size of the matrix equation, i.e., no reduction in problem size is achieved.
Perform these changes to the global matrix equation after you apply all other boundary
conditions. This procedure fixes one displacement component at a time; you can use it
repeatedly for multiple displacement constraints. The procedure modifies the equations to
constrain the displacement in row p to the value Up.

1. First, set the force component to the value that will yield the desired displacement, Up,
when only the diagonal term in this row is nonzero.

Fo=Kpp Up 4.52



2. Next, adjust all other stiffness coefficients in the pth row and the pth column so you can
set to zero all non-diagonal coefficients in the pth row and column without invalidating the
equations.

Fi=F- KU, foralli* p 4.53

3. Finally, set the non-diagonal stiffness coefficients in the pth row and pth column equal to
zero.

Kpi =Kjp=0 foralli® p 4.54

4.6 Equation Solution

The global set of equations modified by the boundary conditions has a number of rows equal to
twice the number of nodes. Solution for the unknowns (nodal displacements) is accomplished
by Gaussian elimination with back substitution. However, because the stiffness matrix is stored
in condensed form, the solution algorithm includes extra manipulation of subscripts from that
normally required in the Gaussian elimination and back substitution methods.

Because the number of columns in the condensed stiffness matrix is equal to the bandwidth of
the original global stiffness matrix (and is less than the number of unknowns), the condensed
stiffness matrix is not square. The global solution vector has displacement components arranged
according to their degrees of freedom as shown in Table 4.4. Odd numbers correspond to x-
displacements; even numbered degrees of freedom correspond to y-components.

Table 4.4 Degrees of Freedom for Nodal Displacements

DOF Node Component
1 1 X
2 1 Yy
3 2 X
4 2 y
5 3 X
5 3 Yy
2i-1 i X
2i i y

4.7 Postprocessing

Once you determine the nodal displacements, you can obtain auxiliary values. Element strains
in each direction are constant within an element and are defined by equation 4.15 (for Cartesian
coordinate systems) or by equation 4.28 (for axisymmetric systems). Element stresses also are
constant throughout an element and are defined by equation 4.17 (for Cartesian coordinate
systems) or by equation 4.30 (for axisymmetric systems). Using Mohr's circle relationships you
can obtain the principal stresses in an element. Generally, you assume element strains and



stresses act at the element centroid. Use a weighted interpolation procedure to estimate stress
values at the nodes.

The program uses the following to determine resultant forces acting at the nodes by the product
of the global stiffness matrix (before application of boundary conditions) and the global nodal
displacement vector:

{F} =[K]{U} 4.55

Example 4.7 - Strains And Stresses In An Element

Consider the element shown in Example 4.4 with node displacements of:

Node  x-component y-component

i .0025 .0020
j .0010 .0015
k .0020 .0010
From equation 4.15, the element strains are:
[ .0025]
] . 1.0020!
&4 0 3 01 09[.0010‘,

{e(e)}=[B(E)]{U(e)}=(1/11)§0 10 -2034i oy
&1-4-2-23108 i

:.0020§
.0010J
which yields
- 0.0050ji [exx]
{9} = (110 | - 0.0020y = &,y
l - 0.001012 l exyT

and the element stresses (assuming plane stress) are given by equation 4.17 with equation 4.18:

€1 .3 0uf-.005|
{s} = D] {®} =(54,945) (V1) €3 1 ou'l-.002'

go 0 .355 -.001
yielding
]-0.00560" | - 27.972§ SXX]
{s") = 4995 - 0.00350y = { - 17.483y =1 S,yy
l-o.ooossr 1-1.7483r [rxy]



You can use any consistent set of units for these properties. Sample sets of units for material
properties are presented in Table 4.1.

---------- Footnotes ----------
(1]
(2]
[3] Segerlind, 1984, p287; Zienkiewicz, 1979, p28
[4] Segerlind, 1984, p. 314ff, Zienkiewicz, 1979, p. 119ﬁ)
[5] Segerlind, 1976, 201
[6] Segerlind, 1984, p. 294
7 Segerlind, 1984 p298,318
[8] Segerlind, 1984, p. 417ff
[9] Conte, 1965, p. 156

[10] Segerlind, 1976, p. 100ff



Chapter 5
Solved Problems

This chapter compares the ME results for the three examples with the theoretical solutions
whenever feasible. The first two examples appeared in the tutorial chapter and the third
appeared in the reference command chapter.

At least one example for each type of problem is included in the addendum supplied with the
unrestricted (professional) version of ME. These examples illustrate ME techniques and the
strengths and weaknesses of the triangular element. These problems can be solved with the
student version too. In addition to the necessary role of validation, these examples provide hints
for using ME more effectively.

Format for problems

Title

Project name (as on diskette)

Description of the problem, including specific issues
Screen dumps of major parts of the solution

Output (graphical and tabular)

Theoretical solution (assumption, equations, etc.)
References

Addendum

List of problems
Student version
01:

02:
03:
Professional version Supplement
04:
05:
06:
07:
08:
09:
10:
11:
12:
13:
14:
15:
16:
17:
18:
19:
20:
(and more)



(NOT COMPLETE)
Project 01:

Folder: (See Ch?2))



Appendix 1
Help Messages

r
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This section provides additional procedural details grouped by Main Menu sections. For help,
locate the context-dependent Help number on the Apple pull-down menu; then locate the
corresponding help message in this section. Although this is a reference section, read it at least
once to become familiar with procedural details not presented elsewhere.

Help
2]
N
Geometry ﬁ’
Number

1.00 Geometry Menu -

You cannot gain access into the Geometry Definition section of the program until you have
opened a project. Other options are: proceed to the Mesh Generation section, go the Library, or
return to the Main menu.

1.10 Set the Coordinate Axes Type -

This is the only opportunity for you to choose between a two-dimensional and an axisymmetric
geometry. The element cross section appears to be triangular in either case; however, in the
axisymmetrical case the triangle sweeps out an annular region. Mathematically, the problems are
similar but different (Segerlind, 1984, pp. 87-99 and pp. 165-176). Likewise, the plots produced are
similar in appearance but different. For axisymmetric problems, you must use the Z axis as the
axis of symmetry (see Segerlind, 1984, p. 166, Fig. 13.1).

1.11 Set Axes Limits -
This sets the horizontal and vertical limits of the plot axes. You can adjust these limits at any
time to produce the equivalent of zooming and then restore the full view.

1.20 Add aPoint (Keyboard Entry Mode) -

Add a point by typing in its coordinates, and then pressing <Return> or clicking in the OK
button. If the point is outside the range of the coordinate axes or the point already exists, then the
program BEEPs and does not enter the point.

1.21 Add aPoint (Mouse Entry Mode) -

Enter a new point by clicking inside the range of the plot axes. The coordinates of the cursor are
indicated on the bottom of the panel. You can round these coordinates to the nearest integer by
pressing the Option key. If the point you select is inside a region or coincident with an already
existing point, then the program will not accept it.



1.30 Enter a Line (Keyboard Entry Mode) -
Enter the STARTING POINT for a line by typing its coordinates (See Help 1.20) or by selecting an
already existing point with the cursor. Click on the Line icon to cancel at any time.

1.31 Enter aline (Keyboard Entry Mode) -
Enter the ENDING POINT for a line (Help 1.20).

1.32 Enter aLine (Keyboard Entry Mode) -

Enter any intermediate points along this line by clicking into the small keypad at the bottom of
the panel. Evenly spaced mid-side points on a region produce equal-sized elements. The mesh
should be finer in areas of greater change and coarser in areas of smaller change. Therefore,
adjust the placement of the mid-side nodes to achieve this effect. Usually a placement of 0.3 to 0.7
of the distance from one corner to the next is workable. If you place the mid-side points too near
the extremities, the algorithm will fail (see Segerlind, 1976, p 369 or Steinmueller, 1974). You can
move the points on the line by dragging them with the mouse. Individual points are not allowed
to pass other points or to move off the line. When you drag a point, its coordinates and
percentage distance along the line from starting point to ending point are displayed. Note: For
axisymmetric problems one side of an element must be parallel to the axis of symmetry to avoid
introducing an additional approximation error. See the Reference chapter.

1.33 Enter a Line (Mouse Entry Mode) -

Enter a line using the mouse. First, select the desired number of intermediate points from the
keypad at the bottom of the panel. Then click in the plot axes the two points that are your starting
and ending points for a line. After you select the second point, the program automatically enters
the intermediate points if you selected any number greater than zero from the keypad. If you click
on or within a few pixels of an existing point, the program will not add a new point; instead, it
will use the existing point. As an example, Mouse Entry Mode for a Line is most useful if you
enter the corner points of a body using Point Entry, and then quickly and easily enter the
intermediate points using Mouse Entry for Lines.

1.40 Enter an Arc (Keyboard Entry Mode) -
Enter the CENTER POINT for an arc (Help 1.20). This is the origin of the circle or ellipse of which
the arc is a part.

141 Enter an Arc (Keyboard Entry Mode) -
Enter the STARTING POINT for an arc (Help 1.20).

1.42 Enter an Arc (Keyboard Entry Mode) -
Enter the number of degrees from the starting point to the endpoint measured counterclockwise.

1.43 Enter an Arc (Keyboard Entry Mode) -
Enter any intermediate points along this arc (Help 1.32, except that the points cannot be dragged).
If you enter extra points and do not use them, they are ignored.



1.44 Enter an Arc (Mouse Entry Mode) -
Instructions are the same as for Entry of a Line in Mouse Entry Mode (Help 1.33) with the
following additions:

]
20

Enter in the boxes the starting and ending angles for the arc. The value in the box is NOT
accepted by the program until you press <Return>!

You can also enter the starting and ending angles by pressing the mouse button at the starting
angle, dragging until you reach your desired ending angle, and releasing the mouse button. You
can also click in one of the four small circles at the end of the axes lines to get four preset angles.

The four buttons to the right of the small axes are for selecting whether you want the arc to go
counterclockwise
from starting point to ending point or clockwise

from starting point to ending point and whether you want to create an arc from a circle

=

or from an ellipse

1.50 Define a Region (Using Pre-existing Points) -

Define a quadrilateral region by clicking on eight points in a counterclockwise order. Lines
cannot cross but can coincide with a side of another region. Neither can regions overlap other
regions. The first point of a region must be a vertex and not a midpoint of a side. Adjacent
regions must share all three points of a common side.

151 Define a Region (See Help 1.50) -
The difference here is that you do not necessarily need to click on a pre-existing point. You can
create a region by shift-clicking eight times anywhere in the plot area.

1.60 Delete a Point (Keyboard Mode) -
Delete a point by entering the coordinates of an existing point or by clicking on the point in the
plot. You can reinstate deleted points by clicking again in the Delete Point icon.

1.61 Delete a Point (Mouse Mode) -
Delete a point by clicking on the point. You can delete a group of points by clicking in the plot and
dragging a box over the group. (See Help 1.62.)

1.62 Delete a Group of Points -
Click inside the box to delete the points. Click outside the box to cancel.



1.70 Examine Points -
Click on a point to review its coordinates. You can modify a selected point. (See Help 1.71.)

1.71 Modify Point -

The point that can be modified is blinking. You can either type in the new coordinates for the
point or drag it with the mouse. Clicking in the OK box, on another point, or anywhere else in
the plot enters the new coordinates. If you move a point, its original location appears as a gray
point. You can cancel a move by clicking in same icon tool again.

1.80 Delete a Region -
Click inside a defined region to delete. Cancel by clicking in the Delete Region icon.

Mesh

2.00 Mesh Menu -

The buttons on the left, as throughout, allow you to move between sections of the program. The
buttons on the top right permit entry into the two processes of the mesh generation process. A
completed process contains a check mark next to the title of the process.

2.10 Define Nodes Per Side -

Specify the number of nodes for each pair of opposite sides by selecting a side (denoted by a small
rectangular box) and then selecting a number from the palette on the left. ME automatically
identifies and matches sides of adjacent regions that are in common. ME calculates the number
of degrees of freedom (DOF) for you as soon as you define all sides, at which time you can
generate the mesh. You can modify your choices as often as you wish by reselecting the side and
selecting another number from the palette.

211 Grid Plot -

You can examine the plots for the entire generated mesh or for any regions that might exist. You
can also select the Goodies menu to examine the element numbering and node numbering or to
modify the mesh. At any time you can regenerate the mesh.

212  Windows -
You can examine any of the windows using the Windows menu.

2.13 Reverse Elements -

Well-shaped (nearly equilateral) elements give better computational results; avoid triangular
slivers. The mesh generation routine automatically selects the diagonal of an element pair that
gives the better aspect ratio. Sometimes, however, you may wish to over-ride this (e.g., to obtain
greater symmetry in the mesh or to avoid having two sides of an element fall in the corner of a
boundary). You can reverse the element definition of two adjacent elements by clicking inside
them and pressing the reverse button.



You cannot reverse elements that have sides that are collinear or nearly collinear

(e.g. ) or that have sides that form a concavity (e.g., ). If, by chance, you wish to over-
ride these two exceptions, press the Command and Option keys and click the Reverse button. Do
not click OK until you have completed all mesh modifications.

2.14 Move Nodes (See Help 2.13) -

HOrE

You can move nodes by first clicking on a node and typing in new coordinates or you can move it
using the arrows. Click in one of the four directional arrows (inside the diamond and to the left,
right, top, or bottom of the Home button) to move the node; if you hold the button down, the
node moves repeatedly. ME does not allow a node to be moved so far that lines of elements
might cross. Click in the HOME button to return the node to its original position. Do not click OK
until you complete all mesh modifications.

2.15 Add Nodes -

You can further refine the mesh by adding nodes and, consequently, splitting existing elements.
To add a node, select two adjacent nodes and press the Add button. Do not click OK until you
have completed all mesh modifications.

2.20 Other Calculations (Reduction of Bandwidth and Calculation of Unique Plot Lines and
Boundary Nodes) -



Within this option the computer attempts to reduce the bandwidth of the problem. By
judiciously renumbering nodes, you can greatly expand the scope of problems that you can solve
using this microcomputer. Execution of this part of the program can become significant, but the
real benefit is a more compact formulation of the global equations needed if significant
instructional problems are to fit within the limited memory. The additional computation at this
step reduces execution time. The bandwidth reported here represents the maximum difference
between the subscripts of unknowns at nodes connected through a side of a triangular element
plus one. This corresponds to the width of the array required to store the stiffness matrix if each
node has one degree of freedom. Since the system of simultaneous linear algebraic equations is
resident in memory during the Gauss elimination solution, the node renumbering process
becomes a important step.

Note 1: Other solution techniques allow you to find a solution if only parts of the large array are
resident at any time.

Note 2: The Collins renumbering algorithm does not guarantee optimal renumbering. ME
retains the original renumbering if the bandwidth is not reduced. If you choose to renumber, you
have the choice of watching the progress of the computation which takes much longer than just
allowing the process to occur in memory. Calculation of unique plot lines and boundary nodes is
necessary for the next sections of the program. In the initially generated mesh, ME plots each of
the three sides of an element even when a side coincides with a previously plotted element. To
avoid redundant double plotting of common element boundaries and to identify the boundaries
required in the PROPERTIES segment of the program, ME identifies unique lines.

Properties

3.00 Properties Menu -

The buttons on the left allow you to move between sections of the program. The buttons on the
top right allow you to enter the two segments of properties and boundary conditions definition.
Instead of check marks, as described in Help 2.00, these buttons either show Edit... or Enter...
depending on whether data exists or not.

3.10 Property Entry -

You can assign each of the five properties to the entire body, to separate regions as defined in the
Geometry definition section, or to individual elements. With the Uniformity menu you
determine at what level of detail you wish to define the properties. You select the property being
defined in the Properties menu. When you have completely defined a property for the problem,
then its name in the menu appears as outline. Assignment of properties is accomplished as
follows:

Assign values to as many of the patterns in the panel at the left as needed. Click to the right of a
pattern (when the cursor is active) to insert or edit a value.



You can select patterns only when a pattern has a value associated with it. Select a value for entry
by clicking in its pattern box.

Assign a value to an element, to a region, or to the entire body, depending on what you selected
under the Uniformity menu, by clicking the cursor in that part of the plot. You can assign the
value to a range of parts by dragging (painting). You can also assign values using one uniformity
designation and redefine selected values using a finer subdivision.

You can zoom the plot by pressing the Option key and dragging a box over the area that you wish
to enlarge. When you have drawn a box, then Option-click inside it. Use the Windows menu to
switch between the full plot and the zone plot. You can assign values in either mode.

3.20 Enter Point Force -

To enter a single point force, select the coordinate direction of the force, enter the force value
then click in the node to which you wish the source to be applied. To enter forces for a range of
boundary nodes, hold down the Shift key (

appears in the top left corner of the plot window) while clicking on a starting and then ending
node. The program applies forces to these nodes in the designated, counterclockwise order.

3.21 Enter Displacement (See Help 3.20) -

3.22 Enter Surface Stress (See Help 3.20) -

Do not apply surface stresses to nodes but rather to faces of the body between adjacent boundary
nodes. The small crosses on a line indicate the locations of the midpoints of these faces. You can
add surface stresses in coordinate directions or in a normal (outward) direction.

3.23 Erase Boundary Conditions -
Use this option in conjunction with the other three to delete boundary conditions from the plot.
It functions in the same manner as entry of boundary conditions. (See Help 3.20.)

3.25 Nodal Boundary Conditions -
Convert the input boundary conditions to equivalent values at the nodes. Surface stresses
become point forces distributed to appropriate nodes.

s

Solve

4.00 Solve Menu -

The buttons on the left, as throughout, allow you to move between sections of the program. The
buttons on the top right allow you to enter the three computational segments of the program.
Completed segments are denoted by a check mark.

4.01 Stress/Strain Assumption -



For two dimensional problems specify whether you wish to assume plane stress or plane strain
deformation. For a thin body with no loads perpendicular to the plane of the body, assume plane
stress. On the other hand, if the dimension of the body normal to the applied load may not
change, assume plane strain. See Chapter 23 of Segerlind for further details.

4.10 Solve Nodal Displacements -
Nodal displacements have been calculated. You can now click OK and proceed to the Solve
Menu.

411 Save Intermediate Files -

Solution of nodal displacements requires several steps during which the program computes
intermediate calculations. If you wish to examine these intermediates, save them in data files.
However, if you are just interested in the final results or you wish to save time and the large
amount of disk space that these files consume, then click the No button.

4.20 Solve Strains and Stresses -
The program has computed Element and Nodal Stresses and Strains.

4.30 Other Calculations -
The program has computed equivalent Nodal Reactions and New Node Positions. In other
words, these equivalent values would lead to the same result.

Plot M

5.00 Plot Menu -
You cannot gain access into the Plot module until you open a project.

5.10 Several options are available at this point-

You can select a plot size from the PlotSize menu. The screen size plot is useful for a quick
viewing of a plot but gives you limited labeling capabilities. If you wish to do some advanced
labeling and make a print of a plot, choose the 8 x 10 plot size. Next choose a plot type from the
Plot menu. If you are going to make an 8 x 10 plot with labels, then you can also select a font, font
size, and style for the labels before making the plot.

511 Labels-
You can select from the Goodies menu for labeling nodes and elements. Other labels (values) are
available by clicking for the following plots:

Node Displacements - click on an initial node. You may encounter a  delay for the lookup in a
large mesh

Boundary Conditions - click on a boundary condition symbol

Nodal Stresses - click on a contour line

Element Strains and Element Stresses - click in an element



You can also change the plot specs, data value range, and number of digits in the labels for certain
plots.

5.12 Labels can be edited -
You can also change the plot specs and data value range for certain plots.

520 Zone enlargement -
Select a zone for enlargement using the mouse or switch to multiple zones. If you have
previously selected a zone, then it appears in gray.

5.21 Multiple Zones -
You can divide the plot into multiple, equal-sized zones of button-selected magnifications. Zones
already plotted are marked. The last zone plotted, if applicable, is gray.

5.30 Numeric Label -
Select the format for all following numeric labels. The digit buttons select the number of digits
after the decimal point.

540 Range Selection -

You can select a range of data values for your plot. The program calculates the maximum and
minimum values as the defaults. You can change these numbers by entering new values in the
boxes and pressing Return. Since the change of one value affects the other values, you can only
change two of the values at a time which, consequently, affects the third.



Appendix 2
File Structure

To enable you to more fully utilize the input data, we organized the data files for MacElastic, with
the exception of the Project Master file, as simple text files. This format makes it possible for you
to edit the data using a word processor or to manipulate the data with another program. End of

lines are denoted by nothing more than a carriage return character (0D16).

Efl——F—————————— Prl]jE[:t Status
EKegward: Plate with hale Total =ize: 72K bytes

Fec Exists Stotus Name Sizacky
Geoms Lty 3 "late with hole. Geom

................................................................................................... | Lrenip |
Sl ve g Flate with hale. IF o,0

g Flate with hole. 15 oo

10 Flate with hole. CF oo

11 Flate with hole HF oo

12 Flate with hale M5 oo

13 B L Flate with hale HDisp 2,0

14 E - Flate with hole . EStra G, 0

15 =] L Flate with hole EStre G,0

16 B - Flate with hole EPStr 11,0 [SEt Httrihg]

17 B - Flate with hole H5tr 4.0

18 B - Flate with hale.HPS5tr 7.0

19 B L Flate with hole. HCoord 2,0

20 B - Flate with hole.FReact 2,0

Fig A2.1 Library file directory

For greater speed, you can elect to use a binary format for data storage. Both binary and text
formats can be present on the disk in the same file; see the Library menu for this information.

You can translate the data entry files from one form to the other from the Library menu.

Each project is made up of 21 files altogether. Twenty of the files are data files containing text.
ileis
e has
your project name. Files 8-12 for the project shown in Fig A2.1 were not saved in Solve; the

These files have your project name plus a file extension described below. The remaining f
the master file which contains the status and dimensions for each of the data files. This fil

“faster” button was selected.




3 Ll

Master file icon Data file icon

A2.1 Summary of Data Files

Rec. # File ext

1

.Geom

.Mesh

.RMesh

.L/B

.Prop
ABC
.FBC
AF

AS

.CF
.MF
.MS
.NDisp
.EStra
.EStre
.EPStr
.NStr
.NPStr
.NCoord
.React

Item description

Coordinates of Input Data Points

Region Definitions and Connectivity

Arc Data

Element Definitions

Mesh Node Coordinates

BandWidth

Renumbered Element Definitions
Renumbered Mesh Node Coordinates
Renumbered BandWidth

Unique Lines

Boundary Nodes

Elastic and Thermal Properties

Input Boundary Condition Specifications
Nodal (Final) D.O.F. Boundary Conditions
Initial Thermal Force Vector

Initial Global Stiffness Matrix

Combine Initial and Boundary Forces
Forces Modified by Displacement BC
Stiffness Modified by Displacement BC
Nodal Displacement Magnitudes
Element Strains in Coordinate Directions
Element Stresses in Coordinate Directions
Element Principal Stresses and Directions
Nodal Stresses in Coordinate Directions
Nodal Principal Stresses and Directions
New Coordinates of Nodes

Resulting Reactions at Nodes



A2.2 Structure of Master File

The Master File contains 21 Pascal records of type FileDescrip .

TYPE
AxesSystems = ( Planar, Axisymmetric);
PrbTypeRange = General .. Gravitational,
Descrip = ( main, data );
FileName = String[63];
FileDescrip = RECORD
CASE DescType : Descrip OF
main : ( Keyword : String[20];
Description: Str255;
AxesType: AxesSystems;
ProbType : PrbTypeRange );
data : ( name: FileName;
status : boolean;
DataGroups: integer;
Groupltems: ARRAY [ 1..3] OF integer)
END;

The first of these records in the file is of type main. This contains the keyword and description
plus the axes system for the project. The remaining 20 are of type data. Each of these contains the
name of the file, a status flag, and information pertaining to the amount of data in the files. The
status flag is set if the data in the file is valid data. DataGroups is the number of groups of items
in the file, which can be a number from 1 to 3. The Groupltems array contains the number of
items in each group.

A2.3 Description of Data Files

Following is a detailed description of the contents of each of the data files. Each can contain from
1 to 3 "lItems,"” which are groupings of data within the files and which are inter-related in some
way. The groups are further broken down into a "format,” which is then given a description.
Each general description is followed by a portion of the data for the flat plate demo problem of
Chapter 2.

File 1 -.Geom
Items-
1. Coordinates of Input Data Points
2. Region Definitions and Connectivity
3. Arc Data
Format-
l.xy[al...an]



2.pl..p8cxcysl...sdrc

3.trexceyf
pl...pn

Description-

1.

2.

x and y = coordinates of point

al ... an = optional arc numbers

pl ... p8 = ccw list of points defining the region

cx and cy = centroid of region

sl ... s4 = the regions connecting each of the four sides
r and ¢ = rows and columns of nodes

t = top of rectangle enclosing arc

r = right of rectangle enclosing arc

cx and cy = center of arc

f = c if complete circle; s if semicircle

pl.. pn = point numbers of points on arc ( at least 2)

Plate with hole.Geom - Text

A. Coordinates of lnput Data Points
B. Region Definitions and Connectivity
C. Arc Data
A1l 120 0O 1 ii
AZ| 122.5219 57.4025 1
A3 106.066 10G6.066 1
A4| 37.40253 133.3219 1
A3 O 130 1
AG| =00 0
A7 300 500
A=| 0 500
ARI| 272.5 0
A10| 200 230
A11| 230 300
A1zl O 272.5
A12 242.9429 2432 9429
Bif 196 10 7 12 2 2 201.3863235 144 676425 00 2 0 2 9
B2 2 132 7 11 8 12 5 4 144 676425 201.38635 1 000 2 9
Cif 150 130 0 0 =
cz 1 3 2 3 4
i
] EEE




File 2 - .Mesh

Items-
1. Element Definitions

2. Mesh Node Coordinates
3. BandWidth

Format-

1. vl..v3r

2. xyf

3. b
Description-
1. vl ... v3 = element vertices

r = region that element belongs to
2. x and y = node coordinates

f ="1" if node is internal,

‘b’ if node on boundary of region
3. b = bandwidth

[JE=——— Plate with hole.Mesh - Test BV————|

Element Definitions
Mesh Mode Coordinates
Bandlidth

A1f 10 11 11
RZ[ 11 2 1 1
A3 11 12 2 1
A4 12 2 2 1
RS 12 13 2 1
RE[ 12 4 3 1
A7 12 14 4 1
AS( 14 5 4 1
A9 14 13 5 1
ROl 15 6 5 1
A11] 12 16 6 1
R1Z] 16 7 6 1
A1Z 16 17 7 1
A14] 17 8 7 1
A1 17 18 &8 1

o m D

AI1G[ 182 9 8 1
AR17 19 20 10
R1Z] 20 11 10

AR19] 20 21 1
Rz20] 21 12 1N

(o b | b 1 I L IS, o]

=l

b —_ —a




Plate with hole.Mesh - Text

A. Element Definitions

B. Mesh Mode Coordinates

C. BandHidth

e 1r - LT It
AZ12| 5 132 131 2
Az1a| & 7 133 2
AZZO| & 133 132 2
AZZ1| 7 8 134 2
AzzZ| 7 134 133 2
Azz3| 8 0 135 2
Az24| 8 135 134 2
E1| 106.066 106.066 b
Ez| 12045533125 12045583125 b
EZ| 160.231925 160.231925 b
E4| 10830428125 108.309428125 b
ES| 243.0420 242.0420 b
BE| 206 27778125 206 27772125 b
E7| 257.192925 257. 199925 b
EZ| 424 00633125 424 00633125 b
EQ| S00 S00 b
E10| 117.S09093877551 93.052877SS10204 b
E11| 130.8204106428571 112.8247830285714 |
E12| 160.5203275510204 132, 0467724420796 |
E12| 206 4222176020402 171.220843 1122449 |
q:::jlﬁ‘l.-‘l S0 AOseornTaEnied 240 1EernEnieeEm 34 H
=[] Plate with hole.Mesh - Teut

A. Element Definitions

B. Mesh Mode Coordinates

C. BandHidth

| =D
BE117
BEi112
E119
E1z0
E1z1
Bi1z2
Bi1z3
Bi1Z4
B125
B1Z6
B1Z7
B1z5
E1z29
E130
BE121
B132
E133
E134
B135

P T e T T T L e D b S i By e g e [Tl e T |
283 .7142857 142857 300 b

T9.3283673469388 127.2299183673469 b
0558952232 14286 148, 7920223214286 i

117,
143,
176,
213,
256,
203,
237,

126570216326

177 . 3170280612244 |

Q39T3VE2YIS 2133869353536 7347 i

Q233979591536
2921600755205
0338239795912
Q5032966232672
1428571428571

236 . 4077443979392 i
206 . 279435994892 |
263, 902082277351 i
422 .37358354539123 i
499, 9999999999929 b

93. 0338773510204 117.30909337VY351 b

112,
138,
171
210,
233,
306,
364 .
428,
128

2347539255714
Q457244209705
2892431122449
16399359 122672
ZE22208672469
0354795391536
4729471938773
2714285714286

139.8804 196428571 i
169, 2203273510204 |
206 . 4282176020408 |
250. 6052297959124 |
202.031344 13265331 i
360, VASVE06 122449 |
426, 7483992346939 |
200 b

C1
]




File 3 - .RMesh

{ same format as file 2}

g| |=—————=—=— Plate with hole.AMesh - Text

Fenumbered Element Definitions
Fenumbered Hesh Hode Coordinates
Fenumbered BandHidith

—oom ofll

A1 45 46 54
AZ[ 46 33 54
A3 46 47 53
A4| 47 56 55
AS| 47 42 56
RE( 42 57 56
A? 42 49 57
AS| 49 35 37
A9 49 39 35
A10f 29 62 52
A11] 59 70 &2
R1Z] V0 79 &3
A1z V0 22 74
A14] 82 91 V9
A13] 82 95 9N
A1G[ 95 104 91 A
R17| 26 37 45
A12] 37 46 45
A19] =27 38 46
RZ20] 35 47 46

(o b | b Lo = T o R

b —_ —a

=l




Plate with hole.AMesh - Text

A. Renumbered Element Definitions
B. Renumbered Hesh Hode Coordinagtes
C. Renumbered BandHidith

e T 1 Uy L o

A217| 52 62 6O 2

Az1z| 52 62 67 2

Az19| 62 72 =0 2

Azzo| 62 80 B9 2

Azz1| 79 91 9z =2

Azzz| 79 92 20 2

A222( 91 104 105 2

A224| 91 105 9z 2
E1| Z.72500000000000e+2 1.40266631642016e-14 b
B2| Z.32031250000000e+2 1. 161948455858 147%e—14 b
B3| Z.3045522385204 1e+2 Z.96796422193578e+1 |
B4| Z.710038 1836734 7e+2 3.59190673469358e+1 |
ES| 2. 195231250000000e+2 1.68438612751265e-14 b
E6| 1.92125000000000e+2 O .622326546665502—15 b
E7| 1.96586203603878e+2 2. 440530974450706e+1 |
BS| 1.93756917346939:+2 4. 845575405 16326e+1 |
B9| Z.27802779336735e+2 5.89134170918367e+1 |
Bi10| 2.686465020408 16e+2 7. 14314408 163265+1 i
E11| 2. 18232503230706e+2 4. 3213672831632 7+1 i
Ei12| 2.73125000000000e+2 2.007 1070520622714 b
[ =1 ] b I o L Lo o T o o T o P e I S o Ll L B ] o L L, e ] i=

=[] Plate with hole.RMesh - Text

| =20 B L= I

B117| 1.42853714285714322+2
BE118| 2.03663330357V 1432+1
E119]| Z.449339744397962+ 1
B1z0| 2.967V9642219357 7 e+
Bi121| 2.39190573450338=+1
B122| 4. 321367222163262+1
B123| 5. 15632452867V 346942+1
Bi1zZd4| 1.7292443979539 122+ 1
B125| 6.0965842457V 244902+ 1
B126| V. 142857142857 14e+1
B127( O.00000000000000=+0
B122| O.00000000000000+0
B129| O.00000000000000+0
E1z20| 0. 00000000000000e+0
E131| 0O.00000000000000e+0
E132| O.00000000000000e+0
B 133 O.00000000000000=+0
B134| 0.00000000000000+0
B135| O.00000000000000+0

Cif 15

ETEH TV OE T 0T TOE T . 5 T oo e T TOETE
L Q00a0a00000a00e+2
LBEE9RE VISR Vet
L9E5E63096935 Vet
3045322385204 e+
L0032 1836734 Vet
L 1222325932307V06e+2
214 154845002822+2
L4EEa0322448980a+2
LI2VI06E4036 122a+2
L Q00a0a00000a00e+:2
LPOTEA230000000e+2
L921230000000002+2
L3202 12500000002+2
L P23000000000002+:2
L1953 1230000000&+:2
L3 1230000000002+:2
CFF2E230000000e+2
L S0000000000000+2
L Q00a0a00000a00e+2

N e W R R R o W WRIR = =

A. Renumbered Element Definitions
B. Renumbered Hesh MHode Coordinagtes
C. Renumbered BandHidith

TOOOOT O OO OO =0 = = = = = = T

=]




File4 - .L/B

Items-
1. Unique Lines
2. Boundary Nodes
Format-
l.enln2
2.b
ine
Description-
1. e = element containing line
nl and n2 = endpoints of line ( renumbered nodes )
2. b = number of separate boundaries
i = indices of beginnings and endings of separate boundaries
n = boundary node number ( numbers are listed ccw )
e = element containing node
=[] Plate with hole.L/B - Text
A. Unigue Lines
B. Boundary MHodes
A1l |0 45 46
AZ| 0 46 54
AZ[ 1 54 45
A4| 0 46 55
AS| 0 55 54
AG| O 46 47
ATl 0 47 55
AZ| 0 47 56
AO| 0 56 55
A10| O 47 42
A11] O 48 56
A1Z| O 48 57
A13| 0 57 56
A14| O 48 49
A1S| O 40 57
A16| O 40 52
A17| O 58 57
A12| 0 49 59
A19| 0 SO0 52
AZ0| O 59 62
AZ1| O B2 52 =1
a2l 050 70 L
] EE




S |==—-—"—————=— Plate with hole.L/B - Text ==i————=|

A. Unhigque Lines
B. Boundary Modes
| g =T | L P 0 = |
AZ52| 0 69 52
AZS53| 0 79 80
A354| O 80 63
AZS5| 0 91 92
AZS6| O 92 79
AZ57| 223 104 105
AZ52| 0 105 91
E1| 1
Bzl 1 54 1
B3| 44 45 17
B4| O 36 33
BS| 0 27 49
BE| O 26 65
BE?| 0 25 &1
B3| 0 24 95
Ba| 0 23 97
B10[ O 13 99
E11| 0 6 101
Biz| 0 2 103
B13[ 0 1 105
E14| 0 5 107
15l 0 12 109
= e
File 5 - .Prop
Items-
Elastic and Thermal Properties
Format-
u
pel
pen
Description-

One set of the above format exists for each of the 5 properties.
The properties are:
1. Elastic modulus
2. Poisson's ratio
3. Thickness (not used for axisymmetric problems)
4. Temperature
5. Thermal Expansion Coefficient
u = uniformity of property
'b" if uniform by body;
r' if uniform by region,;
‘e" if uniform by element
pe{n} = property value for element n



If the property is uniform by body, then only 1 property
value is listed in the file.

The value at the beginning of the file is the Reference
Temperature for the Thermal Expansion Coefficient.

sS[ =————=— Plate with hole.Prop - Text

Elastic and Thermal Properties

1| |o. 0O0O0000000000+0
2 b
2| 6.89500000000000a+4
4|

S| 2. 00000000000000e-1
G =.000000000000002-1
7| 2. 000000000000002— 1
2| 2. 000000000000002— 1
a( =.000000000000002-1
10| 2 .000000000000002-1
11| 2.00000000000000e-1
12| 2.000000000000002- 1
12| 2.00000000000000=-1
14| 2 .000000000000002-1
13| 2.00000000000000a-1
16| 2 .000000000000002-1
17| 2.00000000000000e-1
18] 2. 000000000000002- 1
19| 2 .00000000000000=-1
20| 2.00000000000000e— 1
21| 2.00000000000000a=1
22| 3.00000000000000e—1
{h| 23| 3. 00000000000000e—1




=01

Plate with hole.Prop - Text

Elastic and Thermal Froperties
e T, e
826( 0. 00000000000000e-+0
537 0. 00000000000000:+0
535 0. 00000000000000e+0
£29( 0. 00000000000000+0
200( 0. 00000000000000:+0
201 0. 00000000000000:+0
802 0. 00000000000000e+0
593 0. 00000000000000:+0
594 0. 00000000000000e+0
895 0. 00000000000000:+0
206 0. 00000000000000:-+0
207 0. 00000000000000:+0
805 0. 00000000000000e-+0
599 0. 00000000000000:+0
900( 0. 00000000000000e+0
901 0. 00000000000000:+0
a0z | 0. 00000000000000:-+0
anz| 0. 00000000000000:+0
and| b
a05| 0. 00000000000000e+0 i
906| b :]
907 0. 00000000000000:+0
L
4] S
File 6 - .IBC
Items-
Input Boundary Condition Specifications
Format-
ntdv
Description

n = Boundary node number ( not an actual node number, but
an index into the Boundary Node list from file 5)

t = Type of boundary condition
1 = Point force
2 = Displacement

3 = Surface st

ress

d = Direction of boundary condition
1 =X or R direction
2 =Y or Z direction
3 = normal outward ( stress only )
4 = tangent ccw ( stress only)
v = value of boundary condition



=01

Plate with hole.IBC - Text

Input Boundary Condition Specifications

One row for each degree of freedom

t = Type of Boundary Condition
0 = No BC for this degree of freedom
1 = Point force
2 = Displacement

v = Value of Boundary Condition

1] 135 2 1 0.00000000000000e+0 ity
2[ 133 2 1 0. 00000000000000:+0
3| 132 2 1 0.00000000000000e+0
4 121 2 1 0.00000000000000+0
5 120 2 1 0.00000000000000:+0
6 128 2 1 0.00000000000000+0
7l 128 2 1 0.00000000000000e+0
s 127 2 1 0.00000000000000:+0
g 134 2 1 0.00000000000000e+0
10 23 2 2 0.00000000000000e+0
11 12 2 2 0.00000000000000+0
12| 6 2 2 0.00000000000000+0
13 2 2 2 0.00000000000000e+0
14 1 2 2 0.00000000000000+0
15[ 5 2 2 0.00000000000000e+0
16 12 2 2 0.00000000000000e+0
17 22 2 2 0.00000000000000+0
12| 35 2 2 0.000000000000002+0
L
=l [
File 7 - .FBC
Items-
Nodal D.O.F. Boundary Conditions
Format-
tv
Description-



Plate with hole.FBC - Text

Modal D0.0.F. Boundary Conditions
1] O O.000000000000002+0
2| 2 0.000000000000002+0
3| 0 0.000000000000002+0
4| 2 0.00000000000000+0
3| O 0.00000000000000=+0
G| O 0O.00000000000000=+0
7| O 0O.000000000000002+0
Z| 0 0.000000000000002+0
9| 0O 0.000000000000002+0

10 2 0.00000000000000e+0
11| O O.00000000000000=+0
12 2 0.000000000000002+0
12| O O.000000000000002+0
14 O O.000000000000002+0
15| O O.000000000000002+0
16 O O.00000000000000+0
17 O O.000000000000002+0
12| O O.000000000000002+0
19 O O.000000000000002+0
20( O 0. 00000000000000+0
21( 0 0O.00000000000000+0
22( 0 0.00000000000000e+0
23 0 0. 00000000000000=+0

=




File 8 - .IF

Items-
Initial (Thermal) Force Vector values
Format-
vl
vn {n=dof}
=l Plate with hole.IF - Text
Initial (Thermal » Force Uector
1] 0. 00000000000000e+0
2| 0.00000000000000e+0
3| 0.00000000000000e+0
4| 0.00000000000000&+0
5| 0.00000000000000&+0
6| O.00000000000000&+0
7| 0. 00000000000000e+0
8| 0.00000000000000e+0
9| 0.00000000000000e+0
10| 0. 00000000000000:+0
11| 0. 00000000000000:+0
12| 0.00000000000000:+0
13| 0. 00000000000000e+0
14| 0. 00000000000000:+0
15| 0. 00000000000000:+0
16| 0. 00000000000000:+0
17| 0. 00000000000000:+0
13| 0. 00000000000000:+0
19| 0. 00000000000000e+0
20| 0. 00000000000000:+0
21| 0.00000000000000e+0
22| 0.00000000000000:+0
23| 0.00000000000000:+0 |

=]




File 9 - .IS

Items-

Initial Global Stiffness Matrix values ( rows x columns)
Format-

vil ...vlb

vn, 1 ... vn, b{n =dof, b = Bandwidth }
(Multiple screen widths not shown)

=01 Plate with hole.l1$ - Text
Initial Global Stiffress Matrix
1 270 20 i&
2 9. 11087797237709=+4 2. 21170716 12334242+4 -2 .851396956914706=+4 —1.2324337302325
3 1.13328089209432e+3 —-1.421261216202840e+4 -1, 121462183873 10e+4 2 . 446216923613
4 9423429784074 73e+4 2. 1036100033989 12+3 -3, 3227620701794 1e+4 5. 456962210637
3 1.1643919762938 1e+3  1.81893940334380e— 12 -9, 4936039 1479330e+4 0. 00000000000
G 1.76332342516077e+3 1.3213536137289750e+4 —-3.03574 13 133954953e+4 -2, 662053309407
T 2348326547137V 3e+5 -2 66203209407322e+4 -2 2206923393544 2e+4 0. 00000000000
gl 1.728867431724 182+5 2. 50403820 170532e+4 -4 87YS322572454568=+2 2. 451122851970
a 2.32021673378853 192+ 2. 453112285197032e+4 6. 7272233431 1625e+2 0. 0000000000000
10} 9213724511878V le+4 2. 186731003360 182+4 0. 00000000000000e+0 0. 0000000000000
11 1. 11715050915303=+5 0. 000000000000002+0 0. Q0000000000000e+0 0. 0000000000000
12| 9.96904790097060a+4 -2, V237 150620930065e+4 —3 52022 14775006538e+4 2. 933261274 12
13 1.1233210350945393e+5 2. 955261274 12395a+4 -9 18Y26345726292=+4 0. 000000000000
14 1.22673423053322 1e+5 —-1.2131834769602 1e+4 -2 . 424023527772856e+4 -9.21512534216
13| 2.33826397963200e+3 -9.2131234316738%e+3 -9 87746103233 167e+4 0. 00000000000
16 1. 61730962507384=+5 1.963037222498972+4 -3, 775053407227022e+4 -2 738943223092
17| 2.4234433963399%e+3 -2 . 73394322392 194e+4 -2 2399949233 1823e+4 0. 00000000000
18 1.60946213639228e+3 1. 74118130243967e+4 -3 8052724 144404 Ve+4 -2 67437191032
19( 2.379204329423365e+5 -2.67437191032693e+4 -2 01323439360 195e+4 0. 00000000000
200 1.614612450591702+5 1.68211525187734e+d4 -1 . 5841610291 1423 1e+4 2 403664502472
21| 2.298353975 110728 1e+5 2. 40366450247268e+4 —1 . 8YETT247352090=+2 0. 000000000000
22| 1.75559693748833e+5 34707443 172993 1e+4 -5, 19991509006398=+3 2. 4552450524854
23| 2. 21829758 1937V38e+a 2. 4322409524882 0e+d — 1. 88708037225 10e+2 0 DDDDDDDDDDDEE{}
B




File 10 - .CF

Items-
Combined Initial and Boundary Forces values
Format-
vl
vn {n=dof}
S[ |=——————=— Plate with hole.CF - Text
Combined Initial and Boundary Forces
1| |o. 00000000000000e+0
2| 0.00000000000000:+0
2| 0.000000000000002+0
4| 0.000000000000002+0
S| 0.000000000000002+0
G| 0.00000000000000:+0
7| 0.00000000000000s+0
&| 0.000000000000002+0
al 0.000000000000002+0
10| 0.000000000000002+0
11| 0.000000000000002+0
12| 0.00000000000000s+0
13| 0.00000000000000e+0
14| 0.000000000000002+0
15| 0.000000000000002+0
16| O.000000000000002+0
17| 0.000000000000002+0
18| 0.00000000000000s+0
19| 0.00000000000000e+0
20| 0.000000000000002+0
21| 0.000000000000002+0
22| 0.000000000000002+0
23| 0.000000000000002+0

=l




File 11 - .MF

Items-
Forces Modified by Displacement BC values
Modified Sources *
Format-
vl
vn {n=dof}
| |S=———"——=———= Plate with hole.MF - Telt SQfc—F—————|
Forces Modified by Displacement BC
1] 0. 0000000000000 0e+0
21 0. 00000000000000=+0
3 0. 00000000000000=+0
41 0, 00000000000000e+0
S 0. 00000000000000=+0
G| O.00000000000000=+0
T 0. 0000o000000000=+0
g 0. 00000000000000=+0
g 0. 0000o000000000=+0
10 O, 00000000020000e+0
11 0. 00000000000000=+0
12| 0. 000000000000002+0
12 0. 00000000000000e+0
14| 0. 00000000000000e+0
13 0. 00000000000000e+0
16 O, 00000000000000=+0
17 0. 00000000000000e+0
12| 0. 000000000000002+0
19 0. 0000Q0o0000000e+0
Z20( 0. 0000o000000o00e+0
21 0. 00000000000000=+0
22 0.000000000000002+0
{;l 23 0. 00000000000000=+0




File 12 - .MS

Items-
Stiffness Modified by Displacement BC ( rows x columns )3
Format-
vil ...vlb
vn, 1 ... vn, b{n =dof, b = Bandwidth }
s =————= FPlate with hole.M5§ - Text
Stiffrness Modified by Displacement BC
1| vo 20 i
2| 9. 11087797237700e+4 0. 00000000000000e+0 -2, S5 1596959 14706=2+4 0, 000000000
2l 1.155220802004322+5 0. 000000000000002+0 0. 00000000000000:+0 O . 000000000
4| 0.422420724074722+4 0.000000000000002+0 -2, 2227620701704 1e+4 5. 4560622 10
5| 1.1642019762052 1e+5 0. 000000000000002+0 0. 000000000000002+0 O . 0000000000
6| 1.765525425160772+5 1.58135615732976e+4 -5.0574 15153095495e+4 -2 66205209
7| 2.248526547157732+5 -2 . 66205209407322e+4 -2 . 22060833935442e+4 0. 00000000
S| 1.736667431734 18e+5 3.50403530170533e+4 -4, S7538573454565e+3 0. 000000000
o 2.20216733788510=+5 2.451122851070232e+4 0. 00000000000000=+0 O . 0000000000
10 9.2157245112787 1e+4 0.000000000000002+0 0.000000000000002+0 0. 0000000000
11 1. 117150500 16202e+5 0. 000000000000002+0 0. 000000000000002+0 0. 0000000000
12| 9.06904700997060:+4 O.00000000000000:+0 -3 82623 147726650a+4 2 95526127
13| 1.13552103594593+5 0. 00000000000000:+0 O.00000000000000:+0 0. 000000000
14| 1.8267342505355 1e+5 —1.215 1854769602 1e+4 -2, 424052352777556e+4 -0, 515125
15| 2.33226507063200=+5 -0 21512543 167520=+3 -0, 27746105232 167+4 0. 0000000
16| 1.61720062507284e+5 1. 06303722240807e+4 -3 77505407227022a+4 -2, 7320432
17| 2.42344550655000e+5 -2 73804322307 104e+d -2 2500040253 1825e+4 0. 0000000
13 1.609462 15659232e+5 1.74112130243067e+4 -3 2083724 144404 7a+4 -2 5743710
19 2.37920432045365:+5 -2, 67437 191052693e+4 -2 . 01325450360 195e+4 0. 00000000
20| 1.61461845052170e+5 1.68211535187734e+4 —1.524 1610291142 1e+4 2 403664503
21| 2.2085507611078 1e+5 2. 40366450247268e+4 —1.272772473520002+2 0. 000000000
22| 1.755506027482823e+5 2. 4707442172002 1e+4 -5, 1000 1S0000623022+2 0. 000000000
23| 2. 21820758 103738e+5 2 4552400524885 5e+4 0. DO000000000000+0 0 DDDDDDDDES{}
- 1ol




File 13 - .NDisp

Items-

Nodal Displacement Magnitude values

Format-
di

dn

{n=dof}
ECJ=&== Nodal Displacements
Hode X ¥
1]5.526651997533019e-1  0.000000000000000e+0
2| 5.5740955345416513e~-1  0.000000000000000e+0
2| 5. 47532201 702459081 -1 AS10319395553668-2
4 | 5 6996437651 71555e—-1 -9 417061 4047554552 -5
3| 9.216759314459024e—1 O, 000000000000000:+0
B | 5.453447779513352e-1  0.000000000000000e+0
T 5.357722673914708e-1 -1 61295153 7565215e-2
8 | 5.055420659225293e-1 -3 395629553595752e-2
Q| 5.1295639443596 1621 -2 5756312407 16304e-2
10| & 35344351 77174091e-1 -2 252701355695 1652
11 ] 2.079545591 1953771 -7 . 9559953073432457a—3
12 | 9. 766555757851021e-1  0.0000000000000002+0
13 | 5.3593677523405242-1  0.0000000000000002+0
14 | &.290720007746954e-1 -2 5079435 12996555.-2
15 | 5.05627570931281 -1 -5 . 0497466360944622-2
16 | 7 .674490090155761e-1 -7 595657501 256556e-2
17| 7.555959642991371e—1 -5 . 42965967033 1952a-2
18 | 7 61643941 4455640e-1 -4 4604594415 1356522
19 | 7.7974649722646252-1 -4 1454617241090292-2
20 | 5. 693754547555495e~1 -2 .021235059034055e-2 |
21| 9.62081112475392208-1 -4 GO0S3063570991152-3




File 14 - .EStra

Items-

Element Strains in Coordinate Directions (x-strain, y-strain, x-y shear)

Format-
el

en

{n=#of elements }

Element Strains

EIl.

X direction

¥ direction

I-¥Y Shear

1= = IR N = ) R O T I L

- o o =] ] =t i et e et et o = = B B3I ORI = B} - -

2129508353567 26e-3
ASIEE1276503 1 41e-G
P4 2ZE007 7 2494e-G
LARE169395976201e-G
eG4 14061 147e-3G
12014591 0326 a3
JEEEE1347 3 44 5e-G
SAPE1EEETIS4E656 e
SAPOOSZESSESS070e-3
SE2P159561 593 44e-G
SABS 124554325 2e-0
CAEERI2 14522804083
LS24R05915 4352 M e
S18656535331550e-3
TG 125293 7555e-3
LASE4E4601995394e-G
SASe44305 7349507 e-4
SH9ES07 1S9 659 9e -4
SBOS009 4655 e-G
CS4P0450491 2601 2e-3
SHOEATE 14593854923

L0015 13542505e—-4
LE2EE0317252 M e—4
LEEYI2EE005 45—
L 2EE2PSE40061 305e—4
AF21EPS02695701e-3
R REE P - |
0425545506063
LBER1PSESS54558de—4
B34 156669515524
LrEEdEeEe2 1224506e—4
SA01A14o125a050e-4
L21957560221 405 e—4
L 143565955551651e—4
LAZE06E3 1765641 1e—4
LAQZFP2e95E007e—4
LAY 2S04 23e—4
SAEAE1 22560551 47e—4
15941991641 0900e-4
LBEE20562715559e—4
LEPAOPA4ESE04650e—4
LEEAPZEES5E T 39—

-1
-1
-z

CBAE2E9EE0606645e-3
L22235404 110266 7e-3
RS 14969726906 -3
LEEe 1467169397 5e—4
L2EREF16031 23 262e-0
LA E4EE 4595 1 e—4
LB01PSE 1287842 e—4
LOG44E2950792 {1 55e—4
L19PSEEES9EI S 1e—4
18647524275 5e—4
LAREE41856514575e—4
LAEEIMESI 1S 602e-4
CBRO2EE0PEE A A04e—4
PSP 265258 e
LEESS2E9E 15573195

2.97177953595190499e -6

=,
-4q.
-1.
-1.
-1.

AT 106525226164 7e—4
SOSE99233229455e—-4
BO4330516915621e-3
12280166 1995502e—3
SEM05749215205e-3




File 15 - .EStre

Items-
Element Stresses in Coordinate Directions (x-stress, y-stress, x-y shear)
Format-
el
en {n=#of elements }
= Element Stresses
EI. X direction Y direction I-% Shear
1] 5.574655042554972e+1 7 .0453010935344570e+0 -4 10050922163955 5+
2 | 7 E26153049535475a+1 -4 2065001407393208+0 -3 24156585597705343a+1
3 | 1.30833552190584426a+2 -2 7BE051971606962e+1 -4  203695062565455a+1
4 11 19451 793067 15345a+2 -2 S20712261605242e+1 -2 412451 794666557a+1
9] 1. 39160736E002608e+2 -3 63 14728330754%3 e+ -3 2PE535301107554a+1
B | 1.315505939618062e+2 -2 S33552214454688e+1  —1 . 7756542555524412a+1
T 13206795 140022e+2 -5 20S75E 13046526538+ -2 261 1200565365557a+1
B |1 302625076657 1680+2 -1 995502570601345e+1 -1 . 343056611535920a+1
O 1. 2206576431039 2a+2 -2 291455431951360e+1 -1 . 490316217162295a+1
10| 1. 2308024242535284e+2 -9 54506601 11944538e+0  —1 01 26759620792580e+1
11 ] 1. 114247023576055a+2  —1 275090740045 109a+1 —-& . §95108501053292e+0
12 | 1 .135769309294956e+2  —1 91589449541 7407e+0 -6 73421525 7956596e+0
13 | 1.035182306967261e+2  —4 321507241766 142e+0 -4 13761509399491 2e+0
14 | 1.08004393612995e+2 9 6975705334500002e-1 -2 SEOGBEISSEE696791e+0
19 | 1006100165553 15582e+2 -1 . 2414452309662553e—1 -7 080175 7683765755e—1
16 | 1. 0045461641458 11e+2 -2 S97022773608059e—1 7 .53&0972640765018e-2
17 | 4.896631552903244e+1 -1, 971345 186050504e+1 -2 . 3517085594053 152a+H1
18 | 5. 113425364355 194de+1  —1  35335928792997532e+H1 -2 S20635315659127e+H1
19 | 9. 9436776527341758e+1 -3 696914415103346e+1 -4 25456 1916397555e+H1
20 | 9. 70401 3336451959+ =5 2095409255555 16e+1 -2 97758 5655254252e+1
21 |1 .159931429220080e+2 -5 921295780121667e+1  —4 076286205009641a+1




File 16 - .EPStr

Items-
Element Principal Stresses and Directions (max prin., min prin., max shear, angle
for max angle for min, angle for shear)

Format-
el

en {n=#of elements }

£ =————=—== Element Principal 5tresses

EIl. Hax . Hin. Hax. shear

11 1.032280403556595e+2 -1 .043615553649524e+1 5 65321 1459609254 +1
-2 A0SA7ERE2430256e+1 T 6 Q102453475697 44e+17 2 1910243475697 44a+1 7
2| 5.9477752166275852e+1 -1 . 542305151366305e+1 5. 245041695992050e+1
1L A0E6 1 PA0ES05T05e+1 T 700152005696 205+ T 2 5015520056062 958 +]
3| 1. 4129577645534 15e+2 -3 . S0254P626296552e+1 & .966212735915529e+1
-1 . 5979425154201 15e+H1 " 7 602057456579565e+1 " 5. 1020574565 7055 7e+1 2
4 | 1.2329325360250500+2 -3, 2045553153753 11e+1 7 . 26709183762 77904e+1
0L 0475019974655 26e+0 7 & 095240500253417e+1 " 5 5952405002554 1 Pa+]
9| 1.450791 23475453 723e+2 -4 223516520594050e+1 9 3656 16934365906+
1L O2SE0S6 170055 7e+1 T P OATE 10 GE2E006E5e+H T 5 PR 101 3526096 642+1 7
B | 1.3350576515319427e+2 -3, 029099553 1465539e+1 &, 159637922553 1506e+1
L5 L 27 2E4GI60499 126e+0 " § G727E5153050057e+1 " 5. 672765 1559500552+1 7
7| 1.358889561022118e+2 -3 .5156157592586225e+1 & 552255699755 705+1
-7 PEAE045 4909946 6e+0 7 & 2265 1954509005 53e+1 7 5. 7265 19545000055a+1 7
B | 1.51453612729793600+2 -2 11761353835823270e+1 7 631457831508457e+1
LS OGS 1035047075 41e+07 & 4051506495292 16e+1 7 5. 0051596495292 16e+1 ”
O 1.235815712161099e+2 -2 4430661 2272525353e+1 7 400626622267 112e+1
LS S0ET4PE05449575e+0" § . 4191252191550453e+17 5.9191252191550432+1 7
10 | 1.238472991951477e+2  —1 . 0615117735515370e+1 6. 723120546653069:+1
4 EA31509535945422e4+07 & BRESA006E 10S655e+17 4. 06RS4006E 105655a+1 7
11 ] 1.120559252193568e+2 -1 . 341513073220235e+1 6. 273702522577955e+1




File 17 - .NStr

Items-
Nodal Stresses in Coordinate Directions
Format-
sl
sn {n =# of nodes }
.
EL] Node S5tresses
Hode X direction ¥ direction I-¥Y Shear
1] 4.745856572691250e+1 -4, 199161764256445e+0 -5, 994125542147221e+0
2| 2. 8E07209397953868e+1 -1 . 7250146051475 16e+1 -7 . 1050523551 7858e+0
3| 5.021095490055545e+1 -2 . 095145159451915e+1 -1 . 340155200266545:+1
4 15 A9911837317251496e+1 =3 67747 2427969757e+0 -1 4121103525841 0152+
5| 6. 53197 4R2 45050228+ E . 338549706627244e+0 -4 B51SE53903455 45440
B | 7. MAS22404700524e+0 -5 1034367020517 15e+1 =5 . 24601990301 9544240
T | 9. 756605746552980e+0 -5, S209495604355325e+1 —1 . 20042443657 1063a+1
B |z 6603125573776 14e+1 -3 .921469507259555e+1 -2 . 7106912058277 425e+H1
9| 4.630622497466027a+1 -2 . 210116159551957e+1 -5 . 055542651595 285+
10 | & B0SE041521619692+1 -1 . 00014942542 P655e+1 -2 G05577591771992e+1
11 ] 7. 0429696599797 62+1 E.S096900929121478e+0 -1 2053 ME67321579562+1
12 | 5.0582534531042510e+1 1.7000704537096535e+1 -4 1135307314729 15e+0
13 |6 .504422095799546e+0 -6 351216555575519e+1 -7, 5378334579555282e+0
14 |-2 654905161 03535365e+0 -1 . 03583395 14402086e+2 1 .5971 7305505355572
15 | 5. 469905 130105455e+0 -6 . 651997974157175e+1  —6 . &95461 20439272 1e+0
16 | 1. 72331811665 1111e+1 -5 . S20729191665725e+1 -1 427261666696 7062+
17 | 4. 6752222064074472+1 -4 05462944027509%e+1 -5 495795057 285895+
18 | & . 5427656326979250+1 -2 B33077177459525e+1 -5 RS7295 7765269622+
19 | 5.456291952674755e+1 -1 . 567140561092011e+1 -3, 5147345645565 9a+1
20| 5. 114455215155511e+1 4, 524165572785 0e-1 -2 431616299651 564a+1
216 473972873145 190a+1 1. §F103353858535386153e+1 -9 SE57FESR55705 14e+0




File 18 - .NPStr

Items-
Nodal Principal Stresses and Directions (max prin., min prin., max shear, angle for
max angle for min, angle for shear)

Format-
sl

sn {n=# of nodes}

|EL === Node Principal Stresses
Hode Hax . Hin. Hax. shear

1] 4.779539058556922e+1 -4 SOS9S36232128653e+0 2 61S065710454104a+1
4 FO2PAIEETA06E 1 de+0 T & BROTREPAA200555e+H T 4. 060726 7S42005 55+
2| 2.966594552716420e+1  —1.851135216070070e+1 2 .419041554595245e+1
-0 29545465 1006054e+0 " §  07065E554599592e+1 5. 5706565545909592a+1 7
3| 3.350695627155546e+1 -2 . 4277512965354 18e+1 2 559224961547 1532+
1L ES1PES215207 e+ 7 R 1S24EPEER7I226e+H1 T 5 1 1E246 7556792260+ 7
4 | 5. 536532129561801e+1 =7 05461 1409272754e+0 3. 1211466355945 40e+1
1544905175155 742e+1 7 7 AEE00452 45462592+ T 5 155004524546 255a+1
o | 6.565455369671 1682+ 5.9742556952560642e+0 2 98550559922 7509e+1
-4 4517165 757A5625e 0" § 5518251426204535e+17 4. 051525142620457a+1 7
B | 5.064707057365551e+0 =3 130434937345246e+1 1. 965452521542416e+1
d PASPISAS 145505 1e+0 " & 2542265 4554195e+1 7 4 0254226545541 95a+1 7
T 1.190375599352249e+1 -5 P35EE4055159276e+1 3 463019742245 765+1
104001 36859 04e+1 T 7 9SS A00056514007e+H1 T 5 46590005651 4007e+1
8| 5.653409152194409e+1 -4 5940656020761 49e+1 4 263737592135279e+1
-1 97aPe9 165 744705e 1 7 02620051 1255292e+17 2 52620051 1255292a+17
g | 5.52597958011965392e+1 -3 . 3554734932625322e+1 4 5072664722935+
-2 OES2EPI20563F06e+1 T 6 2317127794366 04e+1 7 2 431127794366 942+1 7
10 | 7.5303041 102595858e+1 -1 .924549356555577e+1 4 22757623542271%e+1
L EZ2FE5149940055:+1 7 7 17PES1E50059915e+H1 T 2 6PTES15500599 15+ "
11 ] 7.2630954550753190e+1 4 60S375965369525e+0 5. 401 130429615129+




File 19 - .NCoord

Items-
New Coordinates of Nodes
Format-
cl
cn {n=dof}
ECJ&== Wew Node Coordinates
Hode X Y
1] 2.75356266519975534e+2 1 4026RES16450157e-14
Z | 2 32E856E59554541 Pe+2 1 1619454555 14790e-14
F | 2. 31502756 1457455e+2 2 9665151599459 152+
4 | 2 . FEPEPE27456642e+2 5 590965028555 4052+1
9] 5.204529259314459e+2 1 63435613751 2650e-14
B | 1.9597053447779514e+2 9 . 6225265466655042-15
T 11.974225619612690e+2 2 4479267635360097a+1
B |1.9456245941256160+2 4. 5421767782 795692+1
Q| 2. 2861573573 11706e+2 5. 5557E607794295 72+
10 | 2 . 694799455555555e+2 7. 145591 3802 75395Ra+1
11]35.191405777959155%e+2 4, 32057 155853555924a+1
12 | 5. 741016556757551e+2 2 . 0010795206227 114
13 | 1. F16201667752541e+2 & .035165 1539654576815
14 | 1. 7022764759365 15e+2 2. 05341 253597554552+1
15 | 1 . 673145436425595e+2 4. 005795451 9355552+
16 | 1. 625797195447295e+2 5.915039967195761a+1
17 ] 1.903942159234528e+2 7. 1826773301255 86a+1
18 | 2 . 24535355603955275e+2 &, 765672002292551aH1
19 | 2 . 662077975176546e+2 1. 0664563579092 22a+2
20| 5 AM5746091393908+2 & 613961290451 1692+1
211 5.7310362958186672+2 5155885036 7112502+1




File 20 - .React

Items-

Resulting Reactions at Nodes
Format-

ri

rn {n=dof}

T
[]

Modal Reactions

X L
F1.09050546 57075 14e—-11 1. 4551430367527 et
FE 4517250407011 0e=-12 & . 581727264505709a+2
4 A03033357930196e—12 -1 536456497725856e-11
-7 GdE05ESEETI2ME9e—12 -5 295575275 15205 2812 |
1.37M9518721426235e—11 -3 . 9512596254 12729e+2
9244 160992255903e—12 1. 254991077561 226e+35
1. 4320700222625608—-11 1 56576902341 24572-12
2. B1E4RE3F e 1665211 -5.293543331412?46&-12;
g
1

=
=
EL
]

['=1- =L = B I E

JHEE0E210592580e—-13 -6 . PE43665 444361 54e—-12
10 |1 . 2553093629274951e-11 4 0B3SE0359557925e-12
11 |7 0832013565537397e—11 6. 2640795325553 47212 |
12 F1.1723955140041652-12 -1 073014555 1395652+3
13 |5 .0093262571057062-12 2 01143246:9091524a+3
14 2 520539093023 142e-11 4 493627692170321e-13
153 1. 1359301958796 460212 —1.D4D?23053283522E-12§
16 2 297425966477 12— 11 -4  6291859253477055a—-12
17 |5.374112100529052e—11 1 .6644907674390202—1 1
18 |2 S66135107026935e—-11 4 377531430701917e-12
19 |6 . 3560635999102552-11 -4.393592552?04309&—12;
20 |1 5565936500725 44e—11 1 6820156537652725e-12 [
21 5 . 9653542160092317e—12 2 .023915757209949-12

Manually Created Files

Use the library module as a word processor to enter the data. Use the Attributes option to change
or set the attributes of a manually created file.
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